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はじめに 

 

 

走査プローブ顕微鏡（SPM）は、無機結晶表面から半導体微細構造、有機分子、自己組

織化膜、タンパク質分子、DNA などの生体ナノ構造に至るまで、自然界あるいは人工的な

超微細構造と微細スケールにおける物性を計測し、それらの機能開発を導く強力な実験法

です。ところが、SPMの探針先端と試料間のナノ領域では、原子レベルの力学的・電子的・

化学的過程が複雑に絡み合っているため、実験結果の解析に理論的な支援がなければ難し

いのが現状です。 

本シミュレータは、このような必要性に応えるために開発いたしました。従来の研究レ

ベルの SPMシミュレーション技術をベースとした上で、問題に応じた計算規模の軽減が行

えるように複数のソフトウェアを用意し選択できるようにいたしました。また、容易な操

作を支援する GUI（グラフィカルユーザーインターフェース）を備えたものに仕上げてい

ます。 

今後 SPM計測技術は、物理化学、生命科学、電子情報工学、材料科学などの先端的基礎

研究分野のみならず、半導体デバイス、表面処理技術、高分子材料、バイオ科学、農学、

先端医療、環境触媒、燃料電池、洗剤・化粧品業界などの産業分野においても重要性を増

すものと考えられます。このような分野での研究ツールとして本シミュレータがお役に立

てば幸いです。 

 

 本書は弊社 SPMシミュレータの操作手順書となっており、ソフトウェアのインストール

から操作手順、注意事項などをご紹介いたします。本書では初心者の方にも簡単にお使い

いただけるよう、基本的な操作方法を中心に解説しております。詳細設定に関しましては

別紙リファレンスマニュアルをご覧ください。 
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SPMシミュレータの構成 

 

 

弊社 SPMシミュレータには、以下のように大きく５つの機能があります。 

 

       １．高速相互予測 AFMシミュレータ 

       ２．連続弾性体 AFMシミュレータ 

       ３．液中ソフトマテリアル AFMシミュレータ 

       ４．原子分子ナノ材料 AFM像シミュレータ 

       ５．量子論的 SPM像シミュレータ 

 

そして、補助機能として薄膜構造作成ツールを備えています。 

上記５つの機能は、以下の６つのシミュレータから構成されています。 

 

① GEO  ② FEM  ③ LIQ  ④ CG  ⑤ MD  ⑥ DFTB 

 

それぞれのシミュレータの分類、機能概要、および対象領域は以下の表のようになってい

ます。 

 

表１：各シミュレータの機能概要 

古典力学に基づき、探針－試料間でのファンデルワールス力を考慮し、その上で、探針
及び試料が弾性方程式に従うと仮定して、測定AFM像を予測するシミュレータ

（探針形状データおよび試料表面形状データを入力として、測定AFM像データを予測・
出力する）

FEM連続弾性体AFMシミュレータ

探針形状データ、試料表面形状データ、測定AFM像データ、の三種類のデータのうち、
二種類のデータから、残り一種類のデータを高速に予測するシミュレータ

（シミュレーション計算においては、探針－試料間の相互作用を考慮せず、また、探
針・試料の立体形状は変形しないと仮定して、純粋に幾何学的な計算により、データを
相互予測する）

GEO高速相互予測AFMシミュレータ

DFTB

MD

CG

LIQ

ｼﾐｭﾚｰﾀ
名称

接触電位差を計算し、KPFM像を予測する機能

トンネル電流計算を行い、STM像を予測する機能

化学的相互作用力を計算し、AFM像を予測する機能

量子力学に基づいて系の電子状態を求め、探針－試料間の相互作用を計算。その結果か
らAFM像/STM像/KPFM像を予測するシミュレータ。

分子動力学法に基づいて試料の変形を考慮し、AFM像を予測するシミュレータ

エネルギー緩和法に基づいて試料の変形を考慮し、AFM像を予測するシミュレータ

古典力学に基づき、力場ポテンシャルを用いることにより探針－試料間の相互作用を計
算し、AFM像を予測するシミュレータ

液中でのカンチレバーの運動を，流体及び試料から受ける抗力とレバー自身の弾性変形
を考慮して計算するシミュレータ

概要

構造最適化AFM像シミュレータ

分子動力学AFM像シミュレータ

AFM像シミュレーション

STM像シミュレーション

KPFM像シミュレーション

量子論的SPM像シミュレータ

原子分子ナノ材料AFM像シミュレータ

液中ソフトマテリアルAFMシミュレータ

古典力学に基づき、探針－試料間でのファンデルワールス力を考慮し、その上で、探針
及び試料が弾性方程式に従うと仮定して、測定AFM像を予測するシミュレータ

（探針形状データおよび試料表面形状データを入力として、測定AFM像データを予測・
出力する）

FEM連続弾性体AFMシミュレータ

探針形状データ、試料表面形状データ、測定AFM像データ、の三種類のデータのうち、
二種類のデータから、残り一種類のデータを高速に予測するシミュレータ

（シミュレーション計算においては、探針－試料間の相互作用を考慮せず、また、探
針・試料の立体形状は変形しないと仮定して、純粋に幾何学的な計算により、データを
相互予測する）

GEO高速相互予測AFMシミュレータ

DFTB

MD

CG

LIQ

ｼﾐｭﾚｰﾀ
名称

接触電位差を計算し、KPFM像を予測する機能

トンネル電流計算を行い、STM像を予測する機能

化学的相互作用力を計算し、AFM像を予測する機能

量子力学に基づいて系の電子状態を求め、探針－試料間の相互作用を計算。その結果か
らAFM像/STM像/KPFM像を予測するシミュレータ。

分子動力学法に基づいて試料の変形を考慮し、AFM像を予測するシミュレータ

エネルギー緩和法に基づいて試料の変形を考慮し、AFM像を予測するシミュレータ

古典力学に基づき、力場ポテンシャルを用いることにより探針－試料間の相互作用を計
算し、AFM像を予測するシミュレータ

液中でのカンチレバーの運動を，流体及び試料から受ける抗力とレバー自身の弾性変形
を考慮して計算するシミュレータ

概要

構造最適化AFM像シミュレータ

分子動力学AFM像シミュレータ

AFM像シミュレーション

STM像シミュレーション

KPFM像シミュレーション

量子論的SPM像シミュレータ

原子分子ナノ材料AFM像シミュレータ

液中ソフトマテリアルAFMシミュレータ
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表２：補助機能の機能概要 

外部フリーソフトウェア
で対応

外部フリーソフトウェア
で対応

無償版に添付して配布

開発中

備考

プロテインデータバンクの利用

分子構造の作成と編集

結晶構造のデータからの半導体薄膜モデルの作成と編集

初期構造の作成

測定像とシミュレーション像を比較し、類似物から試料の
構造を予測する機能

概要

半導体薄膜構造作成ツール

分子構造作成

たんぱく質

モデリング機能

試料表面構造予測機能

外部フリーソフトウェア
で対応

外部フリーソフトウェア
で対応

無償版に添付して配布

開発中

備考

プロテインデータバンクの利用

分子構造の作成と編集

結晶構造のデータからの半導体薄膜モデルの作成と編集

初期構造の作成

測定像とシミュレーション像を比較し、類似物から試料の
構造を予測する機能

概要

半導体薄膜構造作成ツール

分子構造作成

たんぱく質

モデリング機能

試料表面構造予測機能

 

 

 

表３：各シミュレータの対象領域 

試料、探針の変形を考慮可能－○－○FEM連続弾性体AFMシミュレータ

1秒以内で計算可能ナノスケール半
導体デバイス、
（生体）高分子
化合物

－○－○GEO高速相互予測AFMシミュレータ

DFTB

MD

CG

LIQ

ｼﾐｭﾚｰﾀ
名称

－○

－○

－○

●○

●○

液中
真空
中

○

環境

○

有機低分子、無
機物質等

高分子化合物、
生体分子等

対象

試料

試料の変形を考慮可能

温度を考慮可能

試料の変形を考慮可能

その他特徴

○－
構造最適化AFM像シミュ
レータ

原子分子
ナノ材料
AFM像シ
ミュレータ ○－

分子動力学AFM像シミュ
レータ

○－AFM像シミュレーション
量子論的
SPM像シ
ミュレータ

○－STM像シミュレーション

○●KPFM像シミュレーション

対象スケール

－○液中ソフトマテリアルAFMシミュレータ

ミクロマクロ

試料、探針の変形を考慮可能－○－○FEM連続弾性体AFMシミュレータ

1秒以内で計算可能ナノスケール半
導体デバイス、
（生体）高分子
化合物

－○－○GEO高速相互予測AFMシミュレータ

DFTB

MD

CG

LIQ

ｼﾐｭﾚｰﾀ
名称

－○

－○

－○

●○

●○

液中
真空
中

○

環境

○

有機低分子、無
機物質等

高分子化合物、
生体分子等

対象

試料

試料の変形を考慮可能

温度を考慮可能

試料の変形を考慮可能

その他特徴

○－
構造最適化AFM像シミュ
レータ

原子分子
ナノ材料
AFM像シ
ミュレータ ○－

分子動力学AFM像シミュ
レータ

○－AFM像シミュレーション
量子論的
SPM像シ
ミュレータ

○－STM像シミュレーション

○●KPFM像シミュレーション

対象スケール

－○液中ソフトマテリアルAFMシミュレータ

ミクロマクロ

 

○：無償版、製品版ともに対応 

●：製品版のみ対応      

－：未対応          

 

 高速相互予測シミュレータ                           

高速相互予測シミュレータでは、「探針形状

データ」、「試料表面形状データ」、「測定 AFM

像データ」の三種類のデータのうち、二種類

のデータから、残り一つのデータを高速数値

計算によって求めます。このシミュレータは、

探針が試料に常に接しているコンタクトモー

ド測定を仮定しており、純粋に幾何学的な計

算手法によって解を求める点に特徴が有りま

す。 
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 連続弾性体 AFM シミュレータ                            

連続弾性体 AFM シミュレー

タでは、探針－試料間のファン

デルワールス力を考慮し、その

上で、探針および試料が(古典的

な)弾性方程式に従うと仮定して

有限要素法計算を実行し、予測

される AFM画像を求めます。こ

のシミュレータでは、カンチレ

バーの先端の探針は、常に試料

表面から数Å程度離れており、

ノンコンタクトモード測定に対

応します。 

 

 

 液中ソフトマテリアル AFM シミュレータ                    

液中ソフトマテリアル AFM シミュレータでは、液中の動的 AFM に対応し、カンチレバ

ーの振動解析、粘弾性ソフトマテリアルの SPM計測をシミュレーションすることができま

す。液中でのカンチレバーの運動の様子を、周辺流

体から受ける抗力、試料との接触によって受ける力、

レバー自身の弾性変形の 3 つを練成して計算します。 

本シミュレータでは、振動モードでの粘弾性試料の

AFM 像を計算することができ（開発中）、試料の弾

性率などの物性値を推測することが可能です。また、

液中でのカンチレバーの共鳴振動周波数を特定する

ことができ振動特性が分かるので、カンチレバー形

状の設計、振動条件の検討に役立ちます。 

 

 

 原子分子ナノ材料 AFM 像シミュレータ                     

 原子分子ナノ材料 AFM像シミュレータは、

対象とする AFM測定試料の原子一つ一つに力

場パラメータを設定し、それらに基づいて、走

査される探針と試料との間の相互作用を計算

することにより、AFM 測定像を予測するシミ

ュレータです。また、探針との相互作用による
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試料分子の構造変化を原子スケールで予測することができることに特徴があります。この

シミュレータには分子構造を計算する手法として二種類用意されています。一つは、分子

がエネルギー的に安定になる原子配置を探索し、分子構造を決定する「構造最適化 AFM像

シミュレータ」です。もう一つは、すべての原子についてのニュートン方程式を解くこと

により分子構造の変化過程を予測する「分子動力学 AFM像シミュレータ」です。これらの

うちから目的に応じて選び、シミュレーションを行うことができます。 

 

 

 量子論的 SPM 像シミュレータ                         

量子論的 SPM 像シミュレータでは、量子力学的

な電子状態の計算を元に、真空中のミクロスケール

な表面構造に対する周波数シフト像、トンネル電流

像、および局所接触電位差像のシミュレーションを

行うことができます。また、トンネル電流の計算で

は、走査トンネル分光スペクトルとしても解析する

ことができます。本シミュレータでは、密度汎関数

理論に基づく強束縛計算法を採用しており、量子力学計算に通常付随する大きな計算コス

トを軽減させています。そのため、実験との比較を行う上で現実的な試料表面や、古典分

子動力学法によって評価した比較的大きな系に対して適応することが可能です。 

 

 

 モデリング機能                                

 薄膜構造作成ツールは、補助機能のひとつで、

SPM シミュレータに利用する初期構造を作成する

ことができます。このツールでは、ミクロスケール

（DFTB法、CG法、MD法）で使用される原子モデ

ルを作成しますが、一部マクロスケールでも使用す

ることができます。ミクロスケールで使用される原

子モデルとして、理想表面を持つ薄膜モデルが作成

されます。また、任意の原子・クラスタの追加・削

除・移動の編集を行う事ができます。 
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第１章 

ソフトウェアのインストールと準備 
 

 

 

1 ソフトウェアのインストール 

 

 

 SPMシミュレータをご利用頂くためには、以下の URLからお申込み下さい。 

https://www.aasri.jp/pub/spm/appform/spmlicapp.php 

 

申し込みフォーム（画面は 2014年 10月 24日現在のものです。） 

 

 

ご希望者基本情報を入力 

ご希望のソルバーを選択（複数可） 

１ ソフトウェアのインストール                     

 

https://www.aasri.jp/pub/spm/appform/spmlicapp.php
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申し込みの後、e-mailにてアカウント ID及びライセンスキーと入手先のURLが提供されます。 

 

 

インストールプログラムをダウンロードし、PCへ保存します。 

ファイル名は SPMInstaller.zipとなります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上記を入力の上、送信 

ご希望の原子間作用パラメータを 

選択（複数可） 
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SPMInstaller.zipを解凍します。 

 

 

 

解凍するとSPMInstallerというフォルダが作成されます。SPMInstallerフォルダを開きます。 
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Installer.exeをダブルクリックして実行します。 

以下の画面が表示されます。 

 

 

続いて以下の画面が表示されますので、Nextボタンをクリックします。 
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本ソフトウェアの使用条件が表示されますので、ご一読頂き、ご同意の上でインストール

を続けて頂きます。 

 

 

「同意する」のラジオボタンをチェックすると Nextボタンをクリックできる状態になりま

す。続けて Nextボタンをクリックします。 
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アカウント IDとラインセンスキーの入力画面に変わります。 

e-mail にて送付されたアカウント ID とライセンスキーを入力し、OK ボタンをクリックし

ます。 

 

 

以下の画面が表示されます。 

 

ネットワークについての設定です。お使いのネットワーク環境に従ってプロキシ等の設定

を選択してください。 

OKボタンをクリックすると、以下の画面が表示されます。 
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インストール先のフォルダを選択し、OKボタンをクリックします。 

 

 

SPM Simulatorモジュールのインストールが開始されます。 
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SPM Simulatorモジュールのインストールが終了すると Nextボタンをクリックできる状態

になります。Nextボタンをクリックします。 

 

 

サーバへの登録画面が表示されます。 
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サーバへの登録が完了すると以下が表示され、Next ボタンをクリックできる状態になりま

す。Nextボタンをクリックします。 

 

 

終了の画面が表示されます。デスクトップショートカットならびにスタートメニューへの

登録ができます。チェックボックスの必要箇所にチェックし Finish ボタンをクリックしま

す。インストールは以上で終了です。 
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第２章 

ソフトウェアの操作 
 

 

 

1 GUI概要 

 

本ソフトウェアでは、探針、試料、画像などのコンポーネントデータやそれらの初期配置、

各シミュレータで用いられるパラメータ、計算結果出力ファイルパスなど、シミュレーシ

ョンに必要な全ての情報を『プロジェクト』と呼ばれる XML形式のファイルで一括管理し

ています。各シミュレータは、このプロジェクトファイルを入力とし、計算途中あるいは

終了後、結果を指定されたパスに出力します。統合 GUI を用いることで、プロジェクトフ

ァイルの作成・編集を簡単に行うことができ、また結果ファイルを様々な形態で可視化・

表示することができます（図）。 

 

 

プロジェクトファイル 

作成、編集 

表示 

      
計算結果ファイル 

  

統合GUI 

参照 

コンポーネントデータ 

(探針、試料、画像) 

シミュレータ 

MD 

FEM 

DFTB 

CG 

LIQ 

GEO 

１ GUI概要                     
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2 画面説明 

 

 

以下では画面ごとの主な機能について説明します。 

Project Editor 

Main View 

Log View 

Result View 

Menu Bar & Tool Bar 

DB View 

Project View 

Data View 

２ 画面説明 
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【Menu Bar & Tool Bar】 

プロジェクトの新規作成や読み込み、保存などのファイル操作、シミュレータの選択

や実行、再生、一時停止、停止などのシミュレーション制御操作、各画面の表示／非

表示の切り替えなどを行います。 

 

【Project Editor】 

プロジェクトファイルの内容をツリービューとして表示します。表示された値は直接

編集することができます。変更内容は即座に Main View上の描画に反映されます。 

 

【Main View】 

プロジェクトファイルに書かれているコンポーネントやそれらの初期配置、スキャン

エリアなどのセットアップ情報を可視化します。マウスやキーボード、スライダーバ

ーの操作によってコンポーネントのレイアウトを変更でき、その内容は即座に Project 

Editorに反映されます。またシミュレーション実行中には、探針の移動や試料の変形の

様子を可視化します。 

 

【Result View】 

シミュレーション途中や終了後の計算結果を可視化し、２D、３Dなど様々な形態で表

示します。 

 

【Log View】 

シミュレータや GUIからのメッセージを表示します。 

 

【DB View】 

予めデータベースに登録されたコンポーネント（探針や試料の分子データ）の一覧表

を表示します。一覧表の中からコンポーネントを選択・ダブルクリックするだけでプ

ロジェクトに取り込むことができます。 

 

【Project View】 

プロジェクトファイルの内容をテキスト表示します。直接編集することはできません。 

 

【Data View】 

コンポーネントのデータを表示します。分子データの場合、原子ごとに電荷情報と移

動可／不可の情報を設定・編集することができます。ただし原子種と原子座標は編集

できません。 
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3 GUIの起動 

 

 

 

1. a. デスクトップ  “SPM Simulators”アイコン ダブルクリック 

1. b. インストールディレクトリ¥SPMSimulator.exe ダブルクリック 

 

正常に起動しない場合は、第 6章 

トラブルシューティングをご覧ください。 

 

３ GUIの起動 
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4 プロジェクトのファイル操作 

  

GUI を起動後、全ての操作はプロジェクトを読み込むことから始まります。プロジェク

ト読み込み後、GUI を用いてそのプロジェクトを編集・保存し、最後にシミュレーション

を実行するという手順になります。ここでは、プロジェクトの新規作成や読み込み、保存

などのファイル操作について説明します。 

 

新規プロジェクト作成 

 

 

1. “Menu Bar” → [File] → [New]
1
 → ”Create new project”ダイアログ 

2. “Project name”入力 → “Directory”入力 → [OK] 

  

”Create new project”ダイアログでは、プロジェクト名(Project name)およびプロジェクト作

成ディレクトリ(Directory)を指定します。[Ref]ボタンを押すとダイアログを用いてディレク

トリを指定できます。[OK]ボタンを押すと “Directory”で指定されたディレクトリの中に、

プロジェクトと同名のディレクトリが作成され、その中にプロジェクトファイルが作成さ

れます。例えば testというプロジェクト名を指定した場合、 

指定したディレクトリ¥test¥test.pro 

 

                                                   
1 この操作は、“Tool Bar” → Newアイコンをクリックすることでも行えます。 

Simulator Tab 

４ プロジェクトのファイル操作 

す 
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というプロジェクトが作成されます。プロジェクトが作成されると、 ”Project Editor”

の”Setup”タブ内には”Component”項目が追加され、”Simulator Tab”（図では”DFTB”）内に

はデフォルトのパラメータ値が自動設定されます。 

 

既存プロジェクト読み込み 

【ファイルダイアログを使用した読み込み】 
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1. “Menu Bar” → [File] → [Open]
2
 → ”Open Project”ダイアログ 

2. プロジェクトファイル(～.pro)指定 → [開く] 

 

指定されたプロジェクトが読み込まれると、”Project Editor”の各タブ内にセットアップ情報

やシミュレータのパラメータ情報などが表示されます。同時に Main View 上に探針や試料

などのコンポーネントが描画されます。また既に計算結果がある場合は、”Result View”に結

果情報がセットされます。 

 

【最近使用したプロジェクトの読み込み】 

 

1. “Menu Bar” → [File] → [Recent Files] → プロジェクト一覧3→ファイル指定 

 

【再読み込み】 

 

 

1. “Menu Bar” → [File] → [Reload]
4
 

                                                   
2 この操作は、”Tool Bar” → Openアイコンをクリックすることでも行えます。 
3 最近使ったプロジェクトファイルは最大 10個まで表示されます。 
4 この操作は、”Tool Bar” → Reloadアイコンクリックでも行えます。 



 26 

セットアップ情報やパラメータ値を変更した時、保存前であれば、再読み込みすることで

前回保存した時点のプロジェクトに戻すことができます。 

 

 

プロジェクトの表示 

 

1. “Menu Bar” → [Display] → [Current Project File:ファイル名] 

 

Current Project File:の後には、現在のプロジェクトファイル名が表示されます。このメニュ

ーをクリックすることで、”Project View”が立ち上がり、プロジェクトファイルの内容を閲

覧することができます。なお、”Project View”上でファイルを直接編集することはできませ

ん。編集は”Project Editor”から行います。 

 

プロジェクトの保存 

 

GUI 上でプロジェクトを編集した場合、その内容が直ちにプロジェクトファイルに反映さ

れるわけではありません。保存をしてはじめてプロジェクトファイルが更新されます。各

シミュレータはプロジェクトファイルを参照して計算を行うため、プロジェクトの変更内
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容をシミュレーション結果に反映させるためには、実行前にファイルを保存しておく必要

があります。以下では保存方法について説明します。 

 

【保存】 

1. “Manu Bar” → [File] → [Save]
5
  

 

 

【名前を付けて保存】 

 

 

1.“Manu Bar”→ [File] → [Save As] → “Save Project ”ダイアログ 

2. “Project name”入力 → “Directory”入力 → [OK] 

 

” Save Project”ダイアログでは、プロジェクト名(Project name)およびプロジェクトファイ

ル作成ディレクトリ(Directory)を指定します。[Ref]ボタンを押すとダイアログを用いてディ

レクトリを指定できます。[OK]ボタンを押すと “Directory”で指定されたディレクトリの中

に、プロジェクトと同名のディレクトリ（プロジェクトディレクトリ）を作成し、その中

                                                   
5 この操作は”Tool Bar”の Saveアイコンをクリックすることでも行えます。 
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にプロジェクトファイルを作成・保存します。その際、データファイルなどプロジェクト

に必要な全てのファイルがプロジェクトディレクトリにコピーされます。 

 

GUI 上部のタイトルバーに現在のプロジェクトファイル名が表示されていますが、編集し

てファイルを書き換えた場合には、このファイル名の後に”*”という記号が表示されます。

保存が完了するとこの記号が消えます。 

 

 

プロジェクトの終了 

 

 

 

1.“Manu Bar”→ [File] → [Close]
6
  

 

プロジェクトを終了すると、”Project Editor”から全項目が削除されます。また”Main View”

上の描画も全て消去されます。 

 

 

 

                                                   
6 この操作は”Tool Bar”の Closeアイコンをクリックすることでも行えます。 



 29 

5 プロジェクトの編集 

 

コンポーネント 

 

（１） 追加・置換・削除 

コンポーネントは、探針・試料・画像の３種類ありますが、以下では探針の場合を例にと

って説明します。 

 

【追加】 

 

1. “Project Editor” → “Setup”タブ 

５ プロジェクトの編集 

す 
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2. “Component”右クリック → コンテキストメニュー7
 

3. a. [Add Tip] → [Database] → “DB View” → コンポーネントダブルクリック 

b. [Add Tip] → [File] → “Import File”ダイアログ → ファイル指定 → [開く] 

c. [Add Tip] → [Sphere/Cone/Pyramid/Pillar] → パラメータ入力ダイアログ → 半

径・角度入力 → [OK] 

 

 

探針の場合、追加データは[Database]（データベース）、[File]（ファイル）および 4種類の

形状モデル[Sphere][Cone][Pyramid][Pillar]から選択可能ですが、各々入力ダイアログが異な

ります8。データベースからの入力の場合、一覧からコンポーネントを選択し、ダブルクリ

ックするだけで追加できます。ファイルからの入力の場合は、ファイルダイアログを使い

ます。形状モデルの場合は、形状に応じて角度や半径などの入力ダイアログが立ち上がり

ます。 

 

以上の操作で、指定されたデータが読み込まれると、”Component”の下に”Tip”という項目が

追加され、探針の情報が表示されます。同時に Main View上に探針が描画されます。試料、

画像についても同様の手順で追加していくことができます9。 

 

【画像ファイルの追加】 

bmp や jpg などの画像ファイルは、明るさの情報はもちますが、高さ情報はもっていませ

ん。したがって、明度をコンポーネントの高さ情報に変換する処理が必要となります10。ま

た、画像の大きさ（幅、高さ）が現実に何Åに相当するかを指定する必要があります。以

下では試料の場合を例にとって画像ファイルの読み込みについて説明します。 

 

                                                   
7このメニューは、 “Menu Bar” → [Edit] を選択すること、あるいは “Main View” 上で右クリックすることでも

表示できます。 
8試料は[Database]および[File]から、画像は[File]からのみ入力可能です。  
9試料は複数個追加することができますが、探針および画像はひとつだけしか追加できません。 
10 画像の明度と試料の高さが比例関係にない場合には、画像ファイルを追加しても正しい計算は行えません。 
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1. “Project Editor” → “Setup”タブ 

2. “Component”右クリック → コンテキストメニュー11
 

3. [Add Sample] → [File] → “Import File”ダイアログ → 画像ファイル指定 → [開く] 

4.”Set Image Width”ダイアログ → “width”入力 → [OK] 

5.”Set Image Height”ダイアログ → “height”入力 → [OK] 

6.”Set Value Range”ダイアログ → “value range”入力 → [OK] 

 

“Set Image Width”および“Set Image Height”ダイアログで、画像ファイルの幅と高さが実際

に何Åに相当するのかを指定します。さらに“Set Value Range”ダイアログで、画像の明度

[0.0,1.0](黒=0.0、白=1.0で表現)がどれくらいの試料の高低差（Å）に相当するのかを指定

します。 

 

 

 

 

 

 

                                                   
11このメニューは、 “Menu Bar” → [Edit] を選択すること、あるいは “Main View” 上で右クリックすることでも

表示できます。 
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【置換】 

 

1. “Project Editor” → “Setup”タブ 

2. “Tip”右クリック → コンテキストメニュー 

3. a. [Replace] → [Database] → “DB View” → コンポーネントダブルクリック 

b. [Replace] → [File] → “Import File”ダイアログ → ファイル指定 → [開く] 

c. [Replace] → 形状モデル → パラメータ入力ダイアログ → 半径・角度入力 → 

[OK] 

 

置換と追加の違いは、2.の操作において”Component”ではなく、置換したいコンポーネント

（探針の場合は”Tip”）を右クリックすることと、3.の操作においてコンテキストメニューの

内容が、[Add Tip]ではなく[Replace]に変わることです。 

 

【削除】 

 

1. “Project Editor” → “Setup”タブ 
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2. “Tip”右クリック → コンテキストメニュー 

3. [Remove] 

 

指定されたデータが削除されると、”Component”の下から”Tip”という項目が削除されます。

同時にMain View上からも探針の可視化画像が削除されます。 

 

 

（２） 初期配置設定（移動・回転・リセット） 

コンポーネントは、探針・試料・画像の３種類ありますが、以下では探針の場合を例にと

って説明します。 

 

【移動】 

 

ここでは、z座標の移動を例にとって説明します。 

1. “Project Editor” → “Setup”タブ 

2. a. “Tip” → “Position”
12

 → “z”の”value”ダブルクリック → スピンボックス 

  b. “Tip” → “DistanceFromSamples”
13の”value”ダブルクリック → スピンボックス14

 

3. 数値入力15
 → リターン 

                                                   
12 ”Position”以下には、コンポーネントの座標（単位はÅ）が格納されています。探針に関し

て、”x”、”y”、 ”z”の”value”値は、探針最下端位置の座標を表します。一方、試料と画像に関しては、”x”

と”y”の”value”値は、各々コンポーネント中心の x座標(xmin+xmax)/2 , y座標(ymin+ymax)/2を表します。”z”

の”value”値はコンポーネント最下端の z座標（zmin）を表します。 
13 ”DistanceFromSamples”の”value”値（単位はÅ）は、（探針最下端の z座標－試料最上端の z座標）を表します。

試料が存在しない場合、この値は 0となります。 
14 この操作は z座標移動の場合のみ有効となります。 
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以上の操作で、Main View上に表示されている探針が、指定された座標に移動します。 

 

【回転】 

 

ここでは、x方向軸に関する回転を例にとって説明します16。 

1. “Project Editor” → “Setup”タブ 

2. “Tip” → “Rotation”
17

 → “alpha”の”value”ダブルクリック → スピンボックス 

3. 数値入力18
 → リターン 

 

以上の操作で、Main View上に表示されている探針が、x方向の軸を中心に、指定された角

度だけ回転します。yおよび z方向軸の回転に関しても同様です。なお、画像に関しては回

転操作を行うことができません。 

 

 

 

                                                                                                                                                     
15 数値変更は、”Main View”内のスライダーバーつまみを移動させること、あるいは”Main View”上で”Shift”キ

ーを押しながらマウスを移動させることによっても行えます。ただし”Main View”上のマウス操作でコンポーネント

を移動・回転（後述）させる場合、”Project Editor”の”Setup”タブ内で、そのコンポーネントを選択（９節）して

おく必要があります。何も選択されていない場合は、視点が変更されます。 
16 現在回転操作を行えるのは、”～.pdb”、”～.xyz”、”～.txyz”形式のデータをもつコンポーネン

トのみとなっています。 
17 ”Rotation”以下には、軸に対する回転角度（単位は degree）が格納されていま

す。”alpha”、”beta”、”gamma”の”value”値は、各々回転中心を原点とした場合の x、y、z方向の軸に対する

回転角度を表します。回転中心は、探針の場合、探針最下端位置となります。一方試料の場合、コンポーネントの中心

座標が回転中心となります。回転は“alpha”→“beta”→“gamma”の順序で行います。 
18 入力できる数値の範囲は[-180degree , 180degree]となっています。数値変更は、”Main View”上でマウスを移動

させることによっても行えます。 
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【リセット】 

 

1.“Tool Bar” → [Reset Layout] 

 

以上の操作で各コンポーネントの位置座標および回転角度は、その時点で保存されている

プロジェクトファイルの値にリセットされます。同時に、Main View上に描画されているコ

ンポーネントの配置もリセットされます。 

 

 

（３） データ表示・属性変更 

以下では試料のデータを表示する場合について説明します。 

 

1.“Project Editor” → “Setup”タブ 

2.“Sample”右クリック → コンテキストメニュー → [Show] → “Data View” 

3.“Relax”
19および”Charge”列の数値入力20→ [OK] 

 

以上の操作で、各原子の属性が書き換えられ、変更内容はプロジェクトファイルに保存さ

れます。”Relax”の値を 1 にした場合、シミュレーション途中で働く力に応じて原子が動く

ことがあります。この場合、原子の配置が変更されることにより分子（コンポーネント）

が変形します。 

                                                   
19 “Relax”=0は原子座標の「移動不可」、“Relax”=1は「移動可」を表します。 
20 現在属性変更を行えるのは、”～.pdb”、”～.xyz”、”～.txyz”形式のデータをもつコンポーネントのみとな

っています。なお、原子種および原子座標は編集することができません。 

Reset Layout 
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スキャンエリア設定・表示 

 

ここでは、スキャンエリアの高さ（z軸方向の走査範囲）の変更を例にとって説明します。 

 

 

1.“Project Editor” → “Setup”タブ 

2.“Tip” → “ScanArea”
21

 → “h”の”value”ダブルクリック → スピンボックス 

3.数値入力→ リターン 

4.“Main View”右クリック → コンテキストメニュー → [Show Scan Area]
22

 

 

以上の操作で、プロジェクトの走査範囲が変更され、その範囲が”Main View”上に青色の直

方体で表示されます。同様にして、走査範囲の幅（x軸方向）や深さ（y軸方向）について

も、“ScanArea”の“w”や“d”を用いて変更できます。 

 

シミュレータ選択とパラメータ設定 

 

以下では量子論的 SPM像シミュレータ(DFTB)を選択する場合について説明します。 

                                                   
21 ”ScanArea”以下には、走査範囲の幅 w、奥行き d、高さ h（単位はÅ）が格納されています。w、d、h各々の値は、

探針の最下端を始点とし、x方向、y方向、-z方向へどれだけ走査するかを表します。 
22 [Show Scan Area]はトグルボタンであり、繰り返しクリックすることで走査範囲の表示／非表示を交互に切り替えら

れます。 
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1.“Tool Bar” → “Simulator Combo Box” → [MD/CG/DFTB/FEM/LIQ]
23

 

2.“Project Editor” → “Simulator Tab” 

3.各パラメータの”value”ダブルクリック → 各種入力コントロール24
 

4.データ入力→ リターン 

 

パラメータ設定を行うためには、まず設定したいシミュレータを選択する必要がありま

す。”Simulator Combo Box”から MD/CG/DFTB/FEM/LIQの内、いずれかを選択します25。

選択されたシミュレータに応じて“Simulator Tab”の文字は自動的に変更されます（図では

DFTB）。次に“Simulator Tab”内で各パラメータ値を入力します。各パラメータの意味につい

ては、別紙「リファレンスマニュアル」を参照してください。なお新規プロジェクトを作

成した場合でも、各パラメータには予めデフォルト値が設定されています。 

 

どのシミュレータを選択しても、”Simulator Tab”内に”Output”という項目が存在し、その直

下に”Directory”という項目があります。”Directory”以下は計算結果ファイル名のリストです。

シミュレーション実行時に、このディレクトリにファイルが出力されますが、既に同名フ

ァイルが存在する場合、それらのファイルは上書きされますので注意してください26。 

                                                   
23 シミュレータ選択は、”Menu Bar” → [Simulation] → [Solver]からでも行えます。 
24 入力コントロールは、数値の場合はスピンボックス、文字の場合はテキストボックスといったように、要求される

データ形式に応じて自動的に変化します。 
25 GEOに関しては使用法が異なります。３章１節『高速相互予測 AFMシミュレータ』の説明をご覧ください。 

26 ただし、以前のファイルに対しては、“ファイル名~”というバックアップファイルが自動作成されます。 

 

Simulator Combo Box 

Simulator Tab 
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6 シミュレーション 

 

実行・再生・停止・一時停止 

【実行・再生】 

 

1. “Tool Bar” → “Calculation/Replay Combo Box” → [Calculation/Replay] 

2. “Tool Bar” → [Start] 

Calculation/Replay Combo Box Start 

６ シミュレーション 

す 
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まず“Calculation/Replay Combo Box”で、計算を行う27（Calculation）か、予め行われた計

算結果を再生（Replay）するかを決定します。次に、[Start]ボタンを押すと、計算／再生が

開始されます。実行中”Main View”上で、時々刻々変化する探針移動や試料の変形の様子を

見ることができます。また計算結果は可視化され”Result View”上に表示されます。シミュレ

ータからのメッセージは、”Log View”上に表示されます。 

 

【停止・一時停止】 

 

1.“Tool Bar” → [Stop] or [Pause] 

 

計算／再生開始後、[Start]ボタンが使用不可となり、[Stop]ボタンが使用可能となります。

[Stop]ボタンを押せば実行を停止します。[Pause]ボタンは再生の場合のみ使用可能です。こ

のボタンを押すことで、再生を一時停止できます。再開するには、再び[Start]ボタンを押し

ます。なおシミュレーションの進捗状況は、”Progress Bar”で見ることができます。 

 

 

結果表示 

 

【表示データ選択】 

                                                   
27 “Simulator Combo Box”で選択されたシミュレータが実行されます。 

Progress Bar Stop Pause 
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1.“Result View” → [Result Data Combo Box] → 結果出力ファイル選択 

 

”Result Data Combo Box”内には、”Project Editor” → “Simulator Tab” → ”Output” → 

“Directory”以下に書かれている出力結果ファイルのリストが表示されます28。リストからデ

ータを選択すると、データ形式に応じて、グラフや濃淡図などが”Result View”上に描画され

ます。 

 

【数値表示】 

1.“Result View”右クリック → コンテキストメニュー → [Show Data]  

 

                                                   
28 表示されるリストは、”Simulator Combo Box”で選択されるシミュレータに応じて変化します。 

Result Data Combo Box 
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【名前を付けて保存】 

 

1.“Result View”右クリック → コンテキストメニュー → [Save As…] → “Save As”ダイア

ログ 

2. ファイル名入力 → [保存] 

  

この操作によって、結果出力ファイルを別名、および別の形式で保存できます。 

 

【濃淡図 3D表示】 

 

 

1.“Result View”右クリック → コンテキストメニュー → [3D-View] 
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【視点の変更】 

 

1.”Result View”右クリック → コンテキストメニュー → [Top/Front/Side] 

この操作を行うことで、真上（Top）、正面（Front）、真横（Side）に視点が変更されます。

また、Result View 上をドラッグすることにより視角を自由に変更することもできます。

[Shift]+ドラッグすることにより、視点を平行移動させることができます。 

 

【Zoom All】 
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1.”Result View”右クリック → コンテキストメニュー → [Zoom All]
29

 

この操作によって、描画が”Result View”画面全体に収まるように、自動的に拡大縮小および

平行移動が行われます。 

 

【拡大縮小】 

1. マウスホイール→回転 

マウスホイールを回転させることで、任意の倍率にスケーリングすることができます。 

 

【遠近法表示】 

 

1. ”Result View”右クリック → コンテキストメニュー → [Perspective] 

 

[Perspective]はトグルボタンであり、この操作によって遠近法表示のオンオフを切り替える

ことができます。 

 

                                                   
29 この操作は、“Tool Bar” → “Zoom All”ボタンをクリックすることによっても行えます。 
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【濃淡図断面図】 

 

 

1.“Result View”上ダブルクリック → 始点決定 

2.“Result View”上ダブルクリック → 終点決定 

3.“Result View”右クリック → コンテキストメニュー → [3D-View] 

4.“Result View”右クリック → コンテキストメニュー → [Cross-Section] → [Clipping] 
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7 可視化設定 

 

 

コンポーネントの表示／非表示 

 

以下では探針の場合を例にとって説明します。 

 

1.”Main View”右クリック → コンテキストメニュー → [Show Tip]
30

 

 

試料、画像の表示／非表示も同様の操作で切り替えることができます。 

 

 

視点の変更・Zoom All・拡大縮小・遠近法表示  

 

【視点の変更】 

                                                   
30  [Show Tip] [Show Sample] [Show Image]は各々トグルボタンであり、繰り返しクリックすることでコンポーネン

トの表示／非表示を交互に切り替えられます。 

７ 可視化設定 

す 
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1.”Main View”右クリック → コンテキストメニュー → [Top/Front/Side] 

 

この操作を行うことで視角が変更され、真上（Top）、正面（Front）、真横（Side）から見た

コンポーネントが描画されます。また、どのコンポーネントも選択していない状態で Main 

View上をドラッグすることにより視角を自由に変更することもできます。[Shift]+ドラッグ

すること、あるいは x と z スライダーバーを動かすことにより、視点を平行移動させるこ

とができます。 

 

Front Top Side 
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【Zoom All】 

 

1.”Main View”右クリック → コンテキストメニュー → [Zoom All]
31

 

この操作によって、コンポーネントが”Main View”画面全体に収まるように、自動的に拡大

縮小および平行移動が行われます。 

                                                   
31 この操作は、“Tool Bar” → “Zoom All”ボタンをクリックすることによっても行えます。 
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【拡大縮小】 

 

1. マウスホイール→回転 

マウスホイールを回転させることで、任意の倍率にスケーリングすることができます。 

 

【遠近法表示】 

 

1. ”Main View”右クリック → コンテキストメニュー → [Perspective] 

[Perspective]はトグルボタンであり、この操作によって遠近法表示のオンオフを切り替えることができます。 
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View Option 設定 

 

【分子描画法切り替え】32
 

 

1.”Main View”右クリック → コンテキストメニュー 

2.[View Option] → [Auto/Dot/Ball/Ball&Stick/Cartoon] 

 

この操作によって、分子の描画法を変更できます。[Auto]はコンポーネントデータから適切

な描画法を自動判定します。なお、これらの表示はファイル形式によって表示できないも

のがあります。Ball&Stick は原子間結合情報が必要で、Cartoon は PDB ファイルのみに対

応しています。 

 

【半透明／不透明切り替え】 

                                                   
32現在この操作を行えるのは、”～.pdb”、”～.xyz”、”～.txyz”の拡張子をもつコンポーネントデー

タのみとなっています。  

Dot Cartoon Ball Ball & Stick 
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1.”Main View”右クリック → コンテキストメニュー 

2.[View Option] → [transparent]
33, 34

 

 

                                                   
33 [transparent]はトグルボタンであり、繰り返しクリックすることで不透明／半透明の表示を交互に切り替えられま

す。 
34 この操作は、”～.cube”、”～.csv”、”～.bmp”、”～.jpg”の拡張子をもつ Grid形式のファイルに対して有

効です。 
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【等高線表示／非表示切り替え】 

 

1.”Main View”右クリック → コンテキストメニュー 

2.[View Option] → [with wire]
35

 
36

 

                                                   
35  [with wire]はトグルボタンであり、繰り返しクリックすることで等高線の表示／非表示を交互に切り替えられま

す。 
36 この操作は、”～.cube”、”～.csv”、”～.bmp”、”～.jpg”の拡張子をもつ形式のファイルに対して有効で

す。 
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8 GUIの終了  

 

 

 

 

 

 

 

1.”Menu Bar” → [File] → [Quit] 

 

 

 

 

 

 

 

８ GUIの終了 

す 
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9 その他 

 

 

画面の表示／非表示 

 

 

 

1.”Menu Bar” → [Display] → [Project Editor/Result View/Log View]
37

 

                                                   
37 [Project Editor] [Result View] [Log View]はトグルボタンであり、繰り返しクリックすることで画面の表示／非

表示を交互に切り替えられます。 

９ その他 

す 
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以上の操作で画面の表示／非表示38の切り替えを行うことができます。また各画面上部の名

称（”Project Editor”など）が書かれているバーをダブルクリックすることで、GUIとの切り

離し／ドッキングが行えます。なお、”Main View”を非表示にすることや、GUIと切り離す

ことはできません。 

 

 

コンポーネントの選択 

【選択】 

 

 

1. a. ”Tool Bar” →”Component Combo” → コンポーネント名選択39
 

b. ”Project Editor”  → コンポーネント項目クリック 

c. ”Main View”  → コンポーネント周辺ダブルクリック40
 

 

1a、1b、1cいずれの方法でもコンポーネントを選択できます。コンポーネントが選択され

ると、”Main View”上で選択コンポーネントを囲む外枠の色が緑から赤に変化します。ある

コンポーネントが選択されている場合、マウスやスライダーバー、キーボードなどの操作

                                                   
38非表示は、各画面上部の”×”印をクリックすることでも行えます。 
39 “Project Editor”に表示されているコンポーネントのリストがここに表示されます。 
40 この方法で選択できるのは、”～.pdb”、”～.xyz”、”～.txyz”の拡張子をもつコンポーネントデータのみとな

っています。 

Component Combo Box 
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によって、そのコンポーネントの移動、回転を行えます。一方何も選択されていない場合、

同様の操作を行うと視点が変更されます。 

 

【選択解除】 

 

 

1. a.”Tool Bar” →”Component Combo” →[No Selected] 

b.”Project Editor”  → “Component”クリック 

c.”Main View”  → 背景ダブルクリック 

 

1a、1b、1cいずれの方法でもコンポーネントの選択を解除できます。 

 

 

コンポーネントのデータベース登録 

 

探針データは 

 “インストールディレクトリ¥data¥Tip¥” 

 

試料データは 

 “インストールディレクトリ¥data¥Sample¥” 
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以下にデータを直接コピーしてください。ここに登録されたデータは、探針用と試料用

の”DB View”に各々表示されます。なお登録は、”～.pdb”、 ”～.xyz”、 ”～.txyz”の拡張子を

もつコンポーネントデータのみ可能です。また、データと同名の画像ファイル（"データフ

ァイル名.gif”）を同じディレクトリに置いておくと、”DB View”にアイコンが表示されます。 

 

 

イメージの保存 

 

【Main View画面の保存】 

 

1.“Manu Bar”→ [File] → [Export Image] → “Save Capture”ダイアログ 

2. 画像ファイル名入力 → [保存] 
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【Result View画面の保存】 

 

1.“Result View”右クリック → コンテキストメニュー 

2. [Export Image] → “Save Capture”ダイアログ 

3. 画像ファイル名入力 → [保存] 
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第３章 

計算事例 
 

 

この章では、SPM シミュレータに同梱されているサンプルデータファイルを使って、各シ

ミュレータに代表的な事例と、その計算方法をご紹介いたします。 

なお、ここで紹介されている図は実際のものと異なる場合がございます。 

 

 

1 探針・試料・測定 AFM像予測シミュレータ 

 

はじめに 

 

「探針・試料・測定 AFM 像高速相互予測シミュレータ」は、探針の立体的な形状データ、

試料表面の凹凸を表現した形状データ、測定 AFM像データ、の三種類のデータのうち、二

種類のデータから、残り一種類のデータを高速に予測するシミュレーションを実行します。

実際のシミュレーション計算においては、探針－試料間の相互作用(ファンデルワールス力)

は考慮されず、また、探針・試料の 3 次元立体形状は変形しないと仮定して、純粋に幾何

学的な計算により、データを相互予測します。本シミュレーション計算では、カンチレバ

ーは常に試料に接していると仮定しており、いわゆる AFMのコンタクトモードの測定に対

応しています。 

 

本シミュレータは、古典論あるいは量子論の物理学的な方程式を一切考慮せず、探針、試

料、AFM測定像を、単なる幾何学的な構造物としてとらえ、「測定中、探針は常に試料と接

触している」という仮定だけで、計算を行います。従って、量子論的な性質が支配的なミ

クロの領域での現象を調べるには、本シミュレータは、適していません。一方、ナノスケ

ールオーダーの半導体デバイスの AFM像をシミュレートする、あるいは、高分子有機化合

物からなる生体試料の AFMによる観察画像をシミュレートする、といった、マクロとミク

ロの中間的な領域のスケールでの用途に、本シミュレータは非常に適しています。 

 

以下に、本シミュレータの使用方法を、具体例を交えて説明します。探針・試料・測定 AFM

像高速相互予測シミュレータ(以下、GeoAFMと略する)の使い方として、以下の三種類を紹

介します。 

１ 探針・試料・測定 AFM 像高速相互予測シミュレータ

ータ 
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 探針形状データ、試料表面形状データを元にして、測定 AFM像データを求める。 

 探針形状データ、測定 AFM像データを元にして、試料表面形状データを求める。 

 試料表面形状データ、測定 AFM像データを元にして、探針形状データを求める。 

 

これらのシミュレーション方法を、順を追って見て行きます。 

 

探針形状データおよび試料表面形状データから測定 AFM像データを求める 

 

ここでは、探針がピラミッド型のカンチレバーを使って、HOPG（Highly Oriented Pyrolytic 

Graphite：高配向熱分解黒鉛）上に配置された一個のラクトン系高分子量ポリマー(CLG：

εカプロラクトン・(L)ラクチド・グリコリド共重合体)の AFM像を求めることにします。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]をクリックすることにより、

[Create new project]というタイトルのボックスが現れます。[Project name]の欄は空欄にな

っています。ここでは、”test-geoafm001”という文字列を直接タイプ入力して、この名前の

プロジェクトファイルを作成することにします。 

 

なお、[Create new project]のボックスの、上から二つ目の項目[Directory]の欄には、本シミ

ュレータの実行ファイルが収められているディレクトリの絶対パスが、予め自動的に書き

込まれています。これは、[Directory]欄内に書き込まれている絶対パスの指定するディレク

トリの直下に、プロジェクト名と同じ名前のディレクトリが作られ、そのディレクトリ内

に、プロジェクトファイルを始めとする様々なデータファイルが自動的に収められること

を意味します。今の場合、このような設定の方が、シミュレーションに関係するデータフ

ァイルが、一か所にまとめられて便利なので、このまま[OK]をクリックします。 

 

次に、[Project Editor]の、[Setup]タブをクリックして選択します。ページの先頭の、項目

[Component]から、探針形状データ、試料表面形状データを、読み込むことにします。まず、

項目[Component]を右クリックして、[Add Tip]の[Pyramid]を選択します。すると、ピラミッ

ド形状の探針先端部分の角度 angle (deg)を要求するボックスが現れます。デフォルト値で

32.0 度が与えられていますので、ここでは、そのまま [OK]とします。次に、再び項目

[Component]を右クリックして、[Add Sample]の[Database]を選択します。すると、予め用

意された試料データの一覧が現れます。ここでは、データベースの先頭に置かれている

[1clg-HOPG]を選択します。 

 

この時点で、ウィンドウは、以下のような画像を表示します。図の中央の水色の正方形が、

ピラミッド型探針を下から見上げた様子を表しています。縦に連なる鎖上の高分子構造、
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基盤となるグラファイトの分子も、図に表示されていることが分かります。 

 

 
 

念のため、この段階で、プロジェクトファイルを保存することにします。[File]→[Save]で、

test-geoafm001.pro ファイルが保存されます。ある程度まとまった作業が完了するたびに、

このようにしてプロジェクトファイルの保存を行うことが可能です。 

 

これより、GeoAFM の計算実行に移ります。マウスを操作して、探針及び試料が表示され

ているウィンドウの適当な場所に、カーソルを配置し、そこで右クリックします。すると、

下の図のように、縦長のコンテキストメニューが現れます。 
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まず、シミュレータの画像解像度を設定します。コンテキストメニューの最も下の項目で

ある[GeoAFM]を選択し、さらに、[Set GeoAFM Resolution]をクリックします。これにより

解像度の数値を直接入力することが出来ます。解像度は、シミュレーション計算を行う際

の、長さの最小単位を表します。解像度は、Å単位で 0.1以上の実数値を設定することが可

能です。値は、0.1 刻みで変化させることが可能です。また、解像度の最大値は 10 となっ

ています。なお、解像度のデフォルト値は 5[Å]に設定されています。 

 

ここでは、解像度を 1[Å]に設定してみましょう。なお、シミュレータの実際の運用では、

解像度の値は、実験で用いる AFMの解像度を参考にした値を、ユーザーが各自で設定する

のが良いでしょう。また、本シミュレータを使用する際、サンプル全体の大きさに比べて、

非常に小さな値の解像度を取った場合、プログラムの演算処理量が急激に増大してしまい、

事実上、プログラムが止まってしまう(freezeしてしまう)場合が有ります。従って、解像度

の決定は、十分な配慮の上で行って下さい。 

 

次に、再び、コンテキストメニューの最も下の項目である[GeoAFM]を選択し、さらに、[Show 

Simulated Image]をクリックします。すると、下図のように、ウィンドウ内に、オレンジ色

の等高線を表現した図が現れます。これが、予測される AFM画像です。 
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予測 AFM画像を表示する範囲を変えることができます。[Setup]タブから、探針の始点(x, y)

座標(Å) を[Tip]>[Position]の x, y に入力し、スキャンエリアのサイズを[Tip]>[ScanArea]の

w, dに入力しますと、指定した矩形範囲で AFM画像を出力できます。一方、[Tip]>[ScanArea]

の w または d のいずれかをゼロにしますと、スキャンエリアは試料サイズを網羅するよう

に自動的に決められます。ここではスキャンエリアを自動的に決める方法を採用します。 

 

出来上がった予測 AFM画像を見やすくするために、ウィンドウ内から、探針および試料の

画像を取り除くことにします。画像が表示されているウィンドウ内の適当な場所にカーソ

ルを配置し、そこで右クリックします。縦長のコンテキストメニューが現れますので、メ

ニュー内の項目[Show Tip]および[Show Sample]を左クリックして、チェックを外します。 

 

これにより、ウィンドウ内には、予測される AFM 画像のみが表示された状態となります。

ウィンドウ画面内でカーソルをドラッグすると、画像は自由に立体的に回転しますので、

AFM 画像の凹凸が良く見える角度に視点を定めることが可能です。また、ウィンドウ上部

の虫眼鏡マークをクリックすると、画像がウィンドウ内に適切に収まるよう、自動的に画

像表示の拡大・縮小が行われます。例えば、以下の図のように、試料である高分子鎖の高

さの変化が良く見える角度に設定することが可能です。 
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上で求められた予測 AFM画像を、再利用可能なデータとして保存することにします。画像

が表示されているウィンドウ内の適当な場所にカーソルを配置し、そこで右クリックしま

す。縦長のコンテキストメニューが現れますので、メニュー内の項目[GeoAFM]→[Export 

Simulated Data]を選択します。保存ファイル名を要求されますので、ここでは、

"test-geoafm001-image"と入力します。この結果、予測 AFM 画像は、test-geoafm001- 

image.cubeというファイルに保存されます。 

 

以上の作業が終わったら、ひとまず、[File]→[Save]および[Close]として、プロジェクトを

終了させましょう。 

 

 

探針形状データおよび測定 AFM像データから試料表面形状データを求める 

 

ここでは、ピラミッド型の探針形状データと、1clg-HOPGの測定 AFM像データを元にして、

試料表面形状データを求める方法を説明します。測定AFM像データは、前の小節において、

HOPG（Highly Oriented Pyrolytic Graphite：高配向熱分解黒鉛）上に配置された一個のラ

クトン系高分子量ポリマー(CLG：εカプロラクトン・(L)ラクチド・グリコリド共重合体)

について計算して得られた、test-geoafm001-image.cubeファイルを用いることとします。 

まず、新しいプロジェクトファイルを作成します。[File]→[New]により、[Create new project]
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ボックスを呼び出します。ここでは、[Project name]の空欄に、”test-geoafm002”という文

字列を直接タイプ入力して、この名前のプロジェクトファイルを作成することにします。 

 

[Project Editor]の、[Setup]タブをクリックして選択します。まず、探針形状データを読み込

むことにします。ここでは、前と同じく、ピラミッド形状の探針を選択し、angle (deg)も

デフォルト値の 32.0度とします。 

 

次に、測定 AFM 像データを読み込むことにします。前と同じく、Component という項目

を右クリックして、[Add Image]、さらに、[File]を選択します。ここで、前の小節で作成し

た、ディレクトリ test-geoafm001 内の test-geoafm001-image.cube という名前のファイル

を選択します。 

 

この時点で、ウィンドウは、以下のような画像を表示します。ただし、ここでは、ウィン

ドウ上部の虫眼鏡マークをクリックして、画像がウィンドウ内に適切に収まるよう、自動

的に拡大・縮小しています。 

 

 
 

ここで、前に説明したのと同様の手順で、シミュレータの画像解像度を、1[Å]に設定しま

す。さらに、前で説明したときと同様に、 [GeoAFM]→[Show Simulated Sample]をクリッ

クします。すると、下図のように、ウィンドウ内に、緑色の等高線を表現した図が現れま
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す。これが、シミュレーションによって得られた、試料表面形状データです。(図では、緑

色の試料表面形状データの等高線と、オレンジ色の AFM像データの等高線が、同時に表示

されているため、黄色っぽい画像になっています。) 

 

 
 

出来上がった試料表面形状の画像を見やすくするために、項目 [Show Tip]および[Show 

Image]を左クリックしてチェックを外し、ウィンドウ内から、探針および AFM像の画像を

取り除くことにします。これにより、ウィンドウ内には、試料表面形状データ画像のみが

表示された状態となります。試料画像を適切に立体回転、拡大・縮小して、以下の図のよ

うに、試料である高分子鎖の高さの変化が良く見える角度に設定することが可能です。 
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上で求められた試料表面形状データ画像を、再利用可能なデータとして保存することにし

ます。画像が表示されているウィンドウ内の適当な場所にカーソルを配置し、そこで右ク

リックします。縦長のコンテキストメニューが現れますので、メニュー内の項目[GeoAFM]

→[Export Simulated Data]を選択します。保存ファイル名を要求されますので、ここでは、”

test-geoafm002-sample”と入力します。この結果、試料表面形状データは、

test-geoafm002-sample.cubeというファイルに保存されます。 

 

 

試料表面形状データおよび測定 AFM像データから探針形状データを求める 

 

ここでは、1clg-HOPGの試料表面形状データ、および、測定 AFM像データを元にして、探

針形状データを求める方法を説明します。測定 AFM像データは、前の小節において、HOPG

（Highly Oriented Pyrolytic Graphite：高配向熱分解黒鉛）上に配置された一個のラクトン

系高分子量ポリマー(CLG：εカプロラクトン・(L)ラクチド・グリコリド共重合体)について

計算して得られた、test-geoafm001-image.cubeファイルを用いることとします。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]により、[Create new project]

ボックスを呼び出します。ここでは、[Project name]の空欄に、”test-geoafm003”という文

字列を直接タイプ入力して、この名前のプロジェクトファイルを作成することにします。 

さらに、試料表面形状データを読み込みます。まず、[Setup]タブ上の項目[Component]を右
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クリックして、[Add Sample]の[Database]を選択します。すると、予め用意された試料デー

タの一覧が現れます。ここでは、データベースの先頭に置かれている、[1clg-HOPG]を選択

します。 

 

次に、測定 AFM 像データを読み込むことにします。前と同じく、[Component]という項目

を右クリックして、[Add Image]、さらに、[File]を選択します。ここで、前の小節で作成し

た、ディレクトリ test-geoafm001 内の test-geoafm001-image.cube という名前のファイル

を選択します。 

 

この時点で、ウィンドウは、以下のような画像を表示します。 

 

 

 

ここで、前の小節で説明したように、シミュレータの画像解像度を、1[Å]に設定します。

さらに、[GeoAFM]→[Show Simulated Tip]をクリックします。出来上がった探針の画像を見

やすくするために、ウィンドウ内から、試料および AFM像の画像を取り除きます。これに

より、以下の図のように、ウィンドウ内には、探針形状データ画像のみが表示された状態

となります。 
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上で求められた探針形状データ画像を、再利用可能なデータとして保存することにします。

画像が表示されているウィンドウ内の適当な場所にカーソルを配置し、そこで右クリック

します。縦長のコンテキストメニューが現れますので、メニュー内の項目[GeoAFM]→

[Export Simulated Data]を選択します。保存ファイル名を要求されますので、ここでは、”

test-geoafm003-tip”と入力します。この結果、試料表面形状データは、test-geoafm003- 

tip.cubeというファイルに保存されます。 
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2 連続弾性体 AFMシミュレータ 

 

はじめに 

 

「連続弾性体 AFMシミュレータ」は、古典力学に基づき、非接触時では探針－試料間での

ファンデルワールス力を考慮し、接触時では探針-試料間で JKR(Johnson, Kendall, Roberts)

理論によって引き起こされる凝着力を考慮します。その上で、探針及び試料が弾性方程式

に従うと仮定して、測定 AFM像を予測するシミュレーションを実行します。弾性方程式の

解法としては、探針・試料を格子分割した、有限要素法が用いられています。従って、実

際のシミュレーション計算においては、探針形状データおよび試料表面形状データを入力

として、測定 AFM像データを予測・出力することになります。 

 

本シミュレータでは、以下の三つのモードが用意されています。 

 [ノンコンタクトモード]：カンチレバー先端の探針が、試料表面から数Å離れた状態で

原子間に働く相互作用を測定しつつ、試料表面を走査する状況に対応しています。 

 [周波数シフト像モード]：カンチレバーを外力によって一定の周波数で振動させながら、

非接触で試料表面に近付け、探針-試料間の相互作用により生じる周波数シフトの分布

画像を求める状況に対応しています。 

 [粘弾性接触解析モード]：試料表面の一点上において、外力によってカンチレバーを一

定の周波数で振動させ、探針が試料に接触し、試料内部に押し込まれてから、引き戻

されて離脱する直前までの様子を再現します。 

 

本シミュレータは、あくまで、電荷を帯びていない分子・原子間で働くファンデルワール

ス力および JKR 理論を基本とした、古典力学で説明可能な現象を再現する、原子間力顕微

鏡(AFM: Atomic Force Microscope)のシミュレータです。従って、原子・分子を直接観察す

る極微なスケールの現象のシミュレーションには、本シミュレータは不向きと言えます。

しかし、一方、メソスコピックスケールオーダーの半導体デバイスの AFM像をシミュレー

トする、あるいは、高分子有機化合物からなる生体試料の AFMによる観察画像をシミュレ

ートする、といった、マクロとミクロの中間的な領域での現象を調べる用途には、本シミ

ュレータは非常に適しています。 

 

前にも述べましたように、本シミュレータでは、純粋な量子力学的な効果は考慮されませ

ん。電子のトンネル現象を画像データに取り込む、いわゆる走査型トンネル顕微鏡(STM)

や、その他、様々な量子現象から物質の画像をとらえる走査型プローブ顕微鏡(SPM)のシミ

ュレーションは、本シミュレータの適用範囲外となります。これら、量子力学的効果を取

り入れた SPM シミュレーションは、同梱されている「量子論的 SPM像シミュレータ」が

２ 連続弾性体 AFMシミュレータ 

AFM 像高速相互予測シミュレータ 
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適しています。また、量子力学的な取り扱いは行わずに、原子・分子の極微なスケールで

の振る舞いを調べるには、同梱されている「原子分子ナノ材料 AFM像シミュレータ」が適

しています。 

 

さらに、注意すべき事項としては、本シミュレータは、常に真空(もしくは室温大気中の)

環境下で、AFM実験が行われていると仮定しています。液体中での AFM像の再現機能は、

本シミュレータには含まれていません。このような事例の解析には、「液中ソフトマテリア

ル AFMシミュレータ」が適しています。 

 

高分子量ポリマーの測定 AFM像データ予測(ノンコンタクトモード)  

 

以下に、連続弾性体 AFMシミュレータ(以下、FemAFMと略する)の[ノンコンタクトモード]

での使用方法を、具体例を元にして説明します。探針の受けるファンデルワールス力の試

料表面での分布像が出力されます。 

 

ここでは、探針がピラミッド型のカンチレバーを使って、HOPG（Highly Oriented Pyrolytic 

Graphite：高配向熱分解黒鉛）上に配置された一個のラクトン系高分子量ポリマー(CLG：

εカプロラクトン・(L)ラクチド・グリコリド共重合体)の AFM 像を求めることにします。

ただし、カンチレバーの先端の探針は、試料から一定の距離だけ離れていて、ノンコンタ

クトモードで原子間力を検出するものと仮定します。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]をクリックすることにより、

[Create new project]というタイトルのボックスが現れます。[Project name]の欄は空欄にな

っています。ここでは、”test-femafm100”という文字列を直接タイプ入力して、この名前

のプロジェクトファイルを作成することにします。 

 

次に、 [Project Editor]の、 [Setup]タブをクリックして選択します。ページの先頭の

[Component]という項目から、探針形状データ、試料表面形状データを、読み込むことにし

ます。まず、項目[Component]を右クリックして、[Add Tip]の[Pyramid]を選択します。する

と、ピラミッド形状の探針先端部分の角度 angle (deg)を要求するボックスが現れます。デ

フォルト値で 32.0 度が与えられていますので、ここでは、そのまま[OK]とします。次に、

再び項目[Component]を右クリックして、[Add Sample]の[Database]を選択します。すると、

予め用意された試料データの一覧が現れます。ここでは、データベースの先頭に配置され

ている[1clg-HOPG]を選択します。 

 

さらに、有限要素法の解像度を設定します。それには、ウィンドウの左側に表示されてい
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る[Project Editor]の[FEM]タブを選択します。そのページに設定されている項目のうち、

[simulation]下の[resolution]の右隣の数値にカーソルを合わせて、左ダブルクリックして下さ

い。これにより解像度の数値を直接入力することが出来ます。ここでは、2 [Å]と設定しま

す。 

 

解像度は、シミュレーション計算を行う際の、長さの最小単位を表します。もっと具体的

に述べると、試料および探針に対して有限要素法を行う際の、格子間隔を表しています。

解像度は、Å単位で 0.1以上の実数値を設定することが可能です。値は、0.1刻みで変化さ

せることが可能です。また、解像度の最大値は 10となっています。なお、解像度のデフォ

ルト値は 2 [Å]に設定されています。シミュレータの実際の運用では、解像度の値は、実験

で用いる AFMの解像度を参考にした値を、ユーザーが各自で設定するのが良いでしょう。 

 

この時点で、ウィンドウは、以下のような画像を表示します。 

 

 

 

これより、探針先端部の走査(スキャン)する領域を指定します。まず、[Setup]タブを開いて、

[Sample]の[Size]の項目に注目します。試料の大きさが、幅 w：66.861 [Å]、奥行き d：156.464 

[Å]、高さ h：23.152 [Å]であると、表示されています。 

 

そこで、探針が走査(スキャン)する領域を、幅 w：72 [Å]、奥行き d：160 [Å]と定めます。

これにより、試料全体が走査領域内に完全に含まれることになります。また、走査領域の
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縦 w = 72 [Å]、横 d = 160 [Å]の長さが、先ほど指定したシミュレーション解像度 2 [Å]で

割り切れる値であることにも注意します。これにより、探針の走査範囲が、有限要素法の

格子に丁度の大きさで分割されることが保証されます。 

 

なお、この例では、走査範囲は、36×80の格子に分割されています。通常、格子サイズが

150×150を超えると、一般的なパソコンの計算能力を超えることになり、計算時間が目立

って長くなり始めます。例えば、格子数が 200×200のシミュレーションを行おうとすると、

たいていのパソコンは freeze してしまい、事実上、シミュレーションが不可能となってし

まいます。これらの点に注意して、resolutionを設定することをお勧めします。 

 

試料の中央付近に、三次元空間の座標系の原点が設定されています。そこで、[Setup]のタ

ブの[Tip]の項目の下の、[Position]、[ScanArea]の値を、以下のように直接入力します。 

[Position] x = ”-36”, y = ”-80”, z = ”30” 

[ScanArea] w = ”72”, d = ”160”, h = ”0” 

 

ここで、以下の点に注意します。すなわち、[Tip]>[Position]の z の値は、[Sample]>[Size]

の h の値より、十分大きな値を取った方が、有限要素法のシミュレーション計算の実行が

容易になります。試料の最大高さより、探針の高さを十分大きく取らないと、原子間力相

互作用の影響が大きくなり過ぎて、計算が不安定になってしまう可能性があるからです。

（探針と試料の間で働く原子間相互作用の力は、距離の 7 乗に反比例するため、あまり、

探針先端部分と試料とが接近し過ぎると、事実上計算が不可能になる場合が有ります。） 

 

以上の設定の後、マウスを操作して、探針及び試料の画像が表示されているウィンドウの

適当な場所に、カーソルを配置し、そこで右クリックします。すると、縦長のコンテキス

トメニューが現れます。コンテキストメニューの [Show Scan Area]の項目にチェックを入

れると、ウィンドウは、以下のような画像を表示します。紫色の領域が、走査範囲となり

ます。 
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さらに、探針および試料に与えるべき物性値として、ヤング率[GPa]、ポアソン比(無次元量)、

ハマカー定数[zJ]が用意されています。これらは、[Setup]タブ以下の、[Tip]>[Property]およ

び[Sample]>[Property]で入力することが出来ます。これらはデフォルトで、[young] 76.5 

[GPa]、[poisson] 0.22、[hamaker] 50 [zJ]に設定されていますが、適宜変更可能です。ここ

では、デフォルトの値をそのまま使うこととします。 

 

最後に、シミュレーション計算を適切に実行するために、以下の設定を行います。[FEM]

タブ以下の、[OpenMP_threads]の値を入力します。これは、並列化計算を行う際の、CPU

のコア数を表しています。並列化計算を行わない場合は 1 を、例えば四つのコアで並列化

計算する場合は 4を入力します。デフォルトでは 1に設定されています。また、[FEM]タブ

の最初の[simulation_mode]から、”femafm_Van_der_Waals_force”を選択します。デフォル

トでこれが設定されていますので、今の場合、そのままにしておきます。 

 

上記の準備の後、ウィンドウの上部のツールバーに配置されている項目を、 [FEM], 

[Calculation]として、三角形のボタンをクリックすると、シミュレーション計算が開始され

ます。最終的に得られる AFM画像は、メニューバーの[Display]→[Result]で、以下のように

表示されます。 
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さらに、上記 AFM画像を表示しているウィンドウ内にカーソルを配置して右クリックする

と、コンテキストメニューが現れ、そこで、[3D-View]を選択することが可能です。これに

より、以下の立体的な画像を得ることが出来ます。 

 

 

 

 

シミュレーションによって得られた AFM 画像について、以下の注意が必要です。それは、

試料表面上に与えられた数値が、高さを固定された探針先端の受ける力を表しており、試

料表面の立体形状としての高さ(長さの次元を持つ物理量)を表現した値ではないというこ

とです。具体的には、AFM画像の試料表面上の各点に与えられた値の単位は[N](ニュートン)

となります。 
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シリコン結晶表面の AFM 周波数シフト像データ予測(周波数シフト像モード)  

 

以下に、FemAFMシミュレータの[周波数シフト像モード]での使用方法を、具体例を元にし

て説明します。外力によってカンチレバーを一定の周波数で振動させた際の、探針の試料

から受ける相互作用によって引き起こされる周波数シフトの分布像が出力されます。 

 

ここでは、探針がピラミッド型のカンチレバーを使って、シリコン結晶 Si(001)表面の AFM

周波数シフト像を求めることにします。ただし、カンチレバーの先端の探針は、試料から

離れていて、接触することは無いものと仮定します。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]をクリックすることにより、

[Create new project]というタイトルのボックスが現れます。[Project name]の欄は空欄にな

っています。ここでは、”test-femafm200”という文字列を直接タイプ入力して、この名前

のプロジェクトファイルを作成することにします。 

 

次に、 [Project Editor]の、 [Setup]タブをクリックして選択します。ページの先頭の

[Component]という項目から、探針形状データ、試料表面形状データを、読み込むことにし

ます。まず、項目[Component]を右クリックして、[Add Tip]の[Pyramid]を選択します。する

と、ピラミッド形状の探針先端部分の角度 angle (deg)を要求するボックスが現れます。デ

フォルト値で 32.0 度が与えられていますので、ここでは、そのまま[OK]とします。次に、

再び項目[Component]を右クリックして、[Add Sample]の[Database]を選択します。すると、

予め用意された試料データの一覧が現れます。ここでは、 [si001]を選択します。 

 

さらに、有限要素法の解像度を設定します。それには、ウィンドウの左側に表示されてい

る[Project Editor]の[FEM]タブを選択します。そのページに設定されている項目のうち、

[simulation]下の[resolution]の右隣の数値にカーソルを合わせて、左ダブルクリックして下さ

い。これにより解像度の数値を直接入力することが出来ます。ここでは、2[Å]と設定しま

す。 

 

この時点で、ウィンドウは、以下のような画像を表示します。 
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これより、探針先端部の走査(スキャン)する領域を指定します。まず、[Setup]タブを開いて、

[Sample]の[Size]の項目に注目します。試料の大きさが、幅 w：14.28665 [Å]、奥行き d：

13.52978 [Å]、高さ h：8.16468 [Å]であると、表示されています。 

 

そこで、探針が走査(スキャン)する領域を、幅 w：16 [Å]、奥行き d：16 [Å]と定めます。

これにより、試料全体が走査領域内に完全に含まれることになります。また、走査領域の

縦 w = 16 [Å]、横 d = 16 [Å]の長さが、先ほど指定したシミュレーション解像度 2 [Å]で割

り切れる値であることにも注意します。これにより、探針の走査範囲が、有限要素法の格

子に丁度の大きさで分割されることが保証されます。 

 

試料の中央付近に、三次元空間の座標系の原点が設定されています。そこで、[Setup]のタ

ブの[Tip]の項目の下の、[Position]、[ScanArea]の値を、以下のように直接入力します。 

[Position] x = ”-8”, y = ”-8”, z = ”26” 

[ScanArea] w = ”16”, d = ”16”, h = ”0” 

 

以上の設定の後、マウスを操作して、探針及び試料の画像が表示されているウィンドウの

適当な場所に、カーソルを配置し、そこで右クリックします。すると、縦長のコンテキス

トメニューが現れます。コンテキストメニューの [Show Scan Area]の項目にチェックを入

れると、ウィンドウは、以下のような画像を表示します。紫色の領域が、走査範囲となり

ます。 
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さらに、探針および試料に与えるべき物性値として、ヤング率[GPa]、ポアソン比(無次元量)、

ハマカー定数[zJ]が用意されています。これらは、[Setup]タブ以下の、[Tip]>[Property]およ

び[Sample]>[Property]で入力することが出来ます。これらはデフォルトで、[young] 76.5 

[GPa]、[poisson] 0.22、[hamaker] 50 [zJ]に設定されていますが、適宜変更可能です。ここ

では、デフォルトの値をそのまま使うこととします。 

 

これら以外のシミュレーションに必要な物性値は、[FEM]タブ以下で設定します。探針の密

度、および、カンチレバーのばね定数を、[Tip]>[Property]以下の、[density]と[spring_constant]

に入力します。これらの値は、デフォルトでは、 [density] 2329.0 [kg/m
3
]および

[spring_constant] 0.05 [N/m]と設定されています。試料の表面張力は、[Sample]>[Property]

以下の[surface_tension]に入力します。デフォルトでは、[surface_tension] 0.108 [N/m]と設

定されています。ここでは、これらの値をそのまま使うこととします。 

 

また、カンチレバーの外力による振動を定めるために、振幅と周波数を指定します。これ

には、[FEM]タブの、[simulation]以下の[amplitude]と[frequency]で定義します。ここでは、

[amplitude] 150 [angstrom]、[frequency] 0.5 [GHz]と入力します。 

 

最後に、シミュレーション計算を適切に実行するために、以下の設定を行います。[FEM]

タブ以下の、[OpenMP_threads]の値を入力します。これは、並列化計算を行う際の、CPU

のコア数を表しています。並列化計算を行わない場合は 1 を、例えば四つのコアで並列化

計算する場合は 4を入力します。デフォルトでは 1に設定されています。また、[FEM]タブ

の最初の[simulation_mode]の項目を “femafm_frequency_shift” に切り替えます。Value に

対応する入力部をダブルクリックすることで切り替えることができます。 
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上記の準備の後、ウィンドウの上部のツールバーに配置されている項目を、 [FEM], 

[Calculation]として、三角形のボタンをクリックすると、シミュレーション計算が開始され

ます。最終的に得られる AFM 周波数シフト画像は、メニューバーの[Display]→[Result]で、

以下のように表示されます。なお、このグラフで表示される 2 次元分布画像の高さ方向の

物理量の単位は[Hz]となります。 

 

 

 

さらに、上記 AFM周波数シフト画像を表示しているウィンドウ内にカーソルを配置して右

クリックすると、コンテキストメニューが現れ、そこで、[3D-View]を選択することが可能

です。これにより、以下の立体的な画像を得ることが出来ます。 
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シリコン結晶表面の AFM 粘弾性接触解析データ予測(粘弾性接触解析モード)  

 

以下に、FemAFMシミュレータの[粘弾性接触解析モード]での使用方法を、具体例を元にし

て説明します。外力によってカンチレバーを一定の周波数で振動させ、探針を試料表面上

のある一点に近付けた際の、探針が試料に接触した後、次に試料内部に押し込まれ、最後

は引き戻されて試料表面から離脱する直前までの、探針の振る舞いをシミュレートします。 

 

ここでは、探針がピラミッド型のカンチレバーを使って、シリコン結晶 Si(001)表面の粘弾

性接触力学を調べることにします。ただし、カンチレバーの先端の探針は、外力によって

一定の周波数で振動しているものとします。 

 

まず、新しいプロジェクトファイルを作成します。[File]→[New]をクリックすることにより、

[Create new project]というタイトルのボックスが現れます。[Project name]の欄は空欄にな

っています。ここでは、”test-femafm300”という文字列を直接タイプ入力して、この名前

のプロジェクトファイルを作成することにします。 

 

次に、 [Project Editor]の、 [Setup]タブをクリックして選択します。ページの先頭の

[Component]という項目から、探針形状データ、試料表面形状データを、読み込むことにし

ます。まず、項目[Component]を右クリックして、[Add Tip]の[Pyramid]を選択します。する

と、ピラミッド形状の探針先端部分の角度 angle (deg)を要求するボックスが現れます。デ

フォルト値で 32.0 度が与えられていますので、ここでは、そのまま[OK]とします。次に、

再び項目[Component]を右クリックして、[Add Sample]の[Database]を選択します。すると、

予め用意された試料データの一覧が現れます。ここでは、 [si001]を選択します。 
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さらに、有限要素法の解像度を設定します。それには、ウィンドウの左側に表示されてい

る[Project Editor]の[FEM]タブを選択します。そのページに設定されている項目のうち、

[simulation]下の[resolution]の右隣の数値にカーソルを合わせて、左ダブルクリックして下さ

い。これにより解像度の数値を直接入力することが出来ます。ここでは、2[Å]と設定しま

す。 

 

この時点で、ウィンドウは、以下のような画像を表示します。 

 

 

 

これより、探針先端部の走査(スキャン)する領域を指定します。[粘弾性接触解析モード]に

おいては、探針を試料表面のある一点に接触させるので、走査領域を指定する必要はない

のですが、形式的に設定します。ただし、調べたい試料上の一点は、走査領域内に含まれ

ている必要が有ります。まず、[Setup]タブを開いて、[Sample]の[Size]の項目に注目します。

試料の大きさが、幅 w：14.28665 [Å]、奥行き d：13.52978 [Å]、高さ h：8.16468 [Å]で

あると、表示されています。 

 

そこで、探針が走査(スキャン)する領域を、幅 w：16 [Å]、奥行き d：16 [Å]と定めます。

これにより、試料全体が走査領域内に完全に含まれることになります。また、走査領域の

縦 w = 16 [Å]、横 d = 16 [Å]の長さが、先ほど指定したシミュレーション解像度 2 [Å]で割

り切れる値であることにも注意します。これにより、探針の走査範囲が、有限要素法の格

子に丁度の大きさで分割されることが保証されます。 

 

試料の中央付近に、三次元空間の座標系の原点が設定されています。そこで、[Setup]のタ

ブの[Tip]の項目の下の、[Position]、[ScanArea]の値を、以下のように直接入力します。 

[Position] x = ”-8”, y = ”-8”, z = ”6” 
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[ScanArea] w = ”16”, d = ”16”, h = ”0” 

 

以上の設定の後、マウスを操作して、探針及び試料の画像が表示されているウィンドウの

適当な場所に、カーソルを配置し、そこで右クリックします。すると、縦長のコンテキス

トメニューが現れます。コンテキストメニューの [Show Scan Area]の項目にチェックを入

れると、ウィンドウは、以下のような画像を表示します。紫色の領域が、走査範囲となり

ます。 

 

 

 

さらに、探針および試料に与えるべき物性値として、ヤング率[GPa]、ポアソン比(無次元量)、

ハマカー定数[zJ]が用意されています。これらは、[Setup]タブ以下の、[Tip]>[Property]およ

び[Sample]>[Property]で入力することが出来ます。これらはデフォルトで、[young] 76.5 

[GPa]、[poisson] 0.22、[hamaker] 50 [zJ]に設定されていますが、適宜変更可能です。ここ

では、デフォルトの値をそのまま使うこととします。 

 

これら以外のシミュレーションに必要な物性値は、[FEM]タブ以下で設定します。探針の密

度、および、カンチレバーのばね定数を、[Tip]>[Property]以下の、[density]と[spring_constant]

に入力します。これらの値は、デフォルトでは、 [density] 2329.0 [kg/m
3
]および

[spring_constant] 0.05 [N/m]と設定されています。試料の表面張力は、[Sample]>[Property]

以下の[surface_tension]に入力します。デフォルトでは、[surface_tension] 0.108 [N/m]と設

定されています。ここでは、これらの値をそのまま使うこととします。 

 

また、カンチレバーの外力による振動を定めるために、振幅と周波数を指定します。これ

には、[FEM]タブの、[simulation]以下の[amplitude]と[frequency]で定義します。ここでは、

[amplitude] 150 [angstrom]、[frequency] 0.5 [GHz]と入力します。さらに、探針を接触させ
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る試料表面上の一点を指定します。これには、[FEM]タブの、[JKR_position]以下の[ix]と[iy]

で指定します。この[ix]、[iy]は、前で指定したスキャン(走査)エリアを、resolutionで分割し

た際の格子点を意味します。左下隅から数えて x 方向に[ix]番目、y 方向に[iy]番目というよ

うに指定します。ここでは、[ix]として 5、[iy]として 1を入力します。 

 

最後に、シミュレーション計算を適切に実行するために、以下の設定を行います。[FEM]

タブ以下の、[OpenMP_threads]の値を入力します。これは、並列化計算を行う際の、CPU

のコア数を表しています。並列化計算を行わない場合は 1 を、例えば四つのコアで並列化

計算する場合は 4を入力します。デフォルトでは 1に設定されています。また、[FEM]タブ

の最初の[simulation_mode]の項目を “femafm_JKR” に切り替えます。Value に対応する入

力部をダブルクリックすることで切り替えることができます。 

 

上記の準備の後、ウィンドウの上部のツールバーに配置されている項目を、 [FEM], 

[Calculation]として、三角形のボタンをクリックすると、シミュレーション計算が開始され

ます。計算結果は、フォルダ test-femafm300内の、femafm_simulation_tip_delta_force.csv

という名前のファイルに収められます。 

 

ファイル femafm_simulation_tip_delta_force.csvは、Excelで開くことが出来ます。数値デ

ータは、四つの列にまとめられており、左から順番に、計算時間ステップ数(整数値)、時刻

[sec]、探針の変位[m]、探針が試料から受ける外力[N]となっています。 

 

探針の変位及び外力は、以下の図に示すように定義されています。変位δは、変形前の試

料表面を高さゼロの原点として、探針先端部の深さを表すとします。探針にかかる外力 F

は、上向きを正として、探針-試料間の相互作用を表すとします。従って、外力 Fには、カ

ンチレバーを振動させる励振のための外部から印加される力は含まれないとしています。 

 

このとき、探針の変位-外力のグラフは以下のようになります。 

 

δ 

0 
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分かりやすくするため、グラフの右上部分 ( 1.01.0   [nm], 2.02.1  F [nN]) を拡

大すると、以下のグラフが得られます。 

 

 

 

上のグラフの見方は、以下の通りとなります。探針は、赤い矢印に沿って動くものとしま

す。すなわち、探針は、まず、試料表面から上部に突き出た部分で接触し、そのまま試料

の内部に押し込まれます。凝着力がゼロになる位置まで押し込まれると、探針は、今度は、

試料から離れる方向に引き戻されることになります。シミュレーションでは、探針が試料

から離脱する直前まで計算がなされています。 
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今の場合、カンチレバーのばね定数が小さいため、ファンデルワールス力の領域から JKR

理論の領域へ slip-in する際の、グラフの直線の傾きは小さく、ほとんど水平に近くなって

います。また、探針が試料から離脱する過程はシミュレーションでは再現されない設定と

なっています。これは、探針が JKR 理論からファンデルワールス分子間力に slip-out する

過程では、カンチレバーのばね定数が小さい場合、無限遠に近い距離に飛ばされてしまう

ケースが多いからです。 
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3 液中ソフトマテリアル AFMシミュレータ 

 

はじめに 

 

ここでは、液中ソフトマテリアル AFMシミュレータで計算することのできる事例を紹介

いたします。現在まだ開発段階ですが、本シミュレータとしては以下のような計算を行う

ことができます。 

 

   ✎流体抗力、試料との接触応力を受けて稼動するカンチレバーの振動・変形 

✎探針が試料に接触した際に働く力 

   ✎カンチレバーの共鳴振動スペクトルの特性（開発中） 

 

 カンチレバーの根元を強制振動させると、カンチレバー全体が振動し周辺の流体が攪拌

され流れの場が生じます。そのため、レバーは流体の圧力や粘性力を受けることになりま

す。 

 

また、レバーの先端に取り付けられた探針が粘弾性試料に接触した際には、その接触力も

受けます。これらの力とレバー自身の弾性変形による応力のため、レバーの振動は複雑な

動きになります。本シミュレータではゴム表面や細胞表面など比較的マクロスケールの粘

弾性ソフトマテリアル試料の AFM像計測をシミュレーションするのに適しております。 

 

計算を実行するための初期条件として、大きく分けて、カンチレバー、液体、試料の３種

類の条件設定があります。各分類には下記のようなパラメータがあります。 

 

  ➢カンチレバーの設定 

    ・形状（長さ、幅、厚さ、傾き） 

・密度、縦弾性係数(ヤング率)、横弾性係数(ポアソン比) 

    ・振動モード(振幅，周波数，多重波，捩れ角度) 

        

➢流体の設定 

  ・物性（密度、動粘性率） 

３ 液中ソフトマテリアル AFMシミュレータ 
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➢ソフトマテリアル試料の設定 

・形状（高さ） 

・物性（ヤング率、ダンパー定数、メニスカスの張力） 

 

これらの条件設定を元に計算を実行すると、以下の値が結果として出力されます）。 

 

➢カンチレバーの各点での物理量の時間変化 

  ・上下振動：高さ、速度、傾き、流体抗力 

  ・捩れ振動：捩角、捩角速度、流体抗力モーメント 

➢探針に働く力、探針に働くモーメント 

➢カンチレバーの共鳴曲線 

 

※現在は、カンチレバー先端の高さの時間変化、振幅の時間変化、捩れ角度、探針が受け

る力の時間変化のみの出力に対応しております。 

 

今後は、ソフトマテリアル、及びバイオ系材料の SPM計測での高速スキャンにも対応した

シミュレーションを可能にする予定です。 

 

 

水中でのカンチレバーの動作 

 

※ご注意※ 

SPM Simulatorのインストール先に[SampleProject/LIQ]フォルダが存在する場合は、フ

ォルダごと削除してください。今回のバージョンでは、前回のプロジェクトファイルを読

むことはできませんのでご注意ください。 

 

ここでは、水中でカンチレバーを振動させたときのシミュレーション事例をご紹介いたし

ます。カンチレバーが振動する様子を視覚的に表示することができます。 

 

同梱されております、ソフトウェア LiqGUI.exeを起動してください。そして、プロジェク

トを新規作成してください。プロジェクトの作成方法に関しましては、他のソフトウェア

と同様ですので、p 23 を御覧になり手順に沿っておこなって下さい。すると以下の画面が
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立ち上がります。 

 

 

基本的な画面構成は、SPMSimulator.exeと同じです。ただし、右側のメイン画面にはカン

チレバーが表示され、画面左側の[Project Editor]には、本ソフトウェア専用の設定画面

になっています。 

 

画面左側の[Project Editor]を見てください。 

 [LIQ]ー[Mode setting]タブが左図の

ようになっています。 

ここでは、赤枠で囲った部分の設定を行

ないます。 

 

① シミュレーションモードの選択 

② 測定環境の設定 

③ 並列計算の設定 

 

まず、① Simulation Modeでは計算モ

ードを選択します。ここでは、[Point 

oscillation]になっていることを確認

してください。これはカンチレバーを１

点のみ、指定した回数振動させるモード

です。 

 

① 

② 

③ 
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これに対して、試料の表面を平面走査する計算モードもあります（開発中）。 

 

次に、② environmentを設定します。 

 

ここではカンチレバーを真空中か液体中のどちらで振動させるかを設定します。今回は水

中で振動させるので[Fluid]を選択してください。 

 

 

最後に、③ Number of CPUsで並列計算の設定を行ないます。 

 

計算に使用するスレッドの数を入力してください。▲▼ボタンで数値を上下させることも

できます。 

この項目は液中計算のみに設定可能となります。従って、①で[vacuum]を選択した場合は

設定できません。流体計算には非常に時間がかかるので、並列処理によって時間短縮を図

ることができます。お使いのコンピュータに搭載されている CPU コア数（HT テクノロジ

ー搭載であれば、スレッド数＝コア数×２など）を上限として、任意の数値を入力するこ

とが可能です。 

 

次に、[input data]タブを選んでください。すると以下のような画面になります。 
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ここでは、具体的な初期パラメータの数値入力を行ないます。 

重要なものは赤枠で囲った箇所④～⑩で、大まかな意味は以下のとおりです。詳しくは別

冊「リファレンスマニュアル」を御覧下さい。 

④ 

⑤

 

  
⑥ 

⑦ 

⑧ 

⑨ 

⑩ 
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           ④ 流体の設定 

           ⑤ カンチレバーの物性に関する設定 

           ⑥ カンチレバーの形状に関する設定 

           ⑦ カンチレバーの振動に関する設定 

           ⑧ 探針―試料間の距離の設定 

           ⑨ 試料の物性に関する設定 

           ⑩ 時間ステップ、計算の収束判定に関する設定 

            

このサンプルプロジェクトファイルには、④に水の物性値と、⑤にシリコンカンチレバー

の物性値を予め入力してあります。液体の物性値とカンチレバーの材料物性値を変更した

い場合は、この項目を修正してください。 

 

⑥では、基本となるカンチレバーの形状を入力します。カンチレバーの分割を多くして詳

細に計算したい場合は[sections]欄を大きい数にしてください。ただし、計算時間がかか

るのでご注意ください。 

 

⑧では、探針の最下端と試料の上端との距離を設定しますが、カンチレバーの振幅（⑦の 

[amplitude] の値）と試料の高さ（⑨の[touch]）を考慮して、探針を試料に近づけすぎ

ないように注意してください。 

 

また、液中の計算は時間がかかるので、この⑩の数値を調節することで計算時間の短縮を

図ることができます。真空中のシミュレーションでは比較的短時間で終了するので値を大

きく設定しても支障ありません。例えば水中計算の場合は [simulation] > [time] > 

[max_cycles]を 30 程度に、真空中計算の場合は 300 程度にするといいでしょう。

[convergence] > [criterion]には “0.0” を入力します。 

 

 

 

その他のパラメータについての詳細はリファレンスマニュアルを参照して下さい。 

 

 

各パラメータについて、単位を変更したい場合は、[unit]
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欄の単位をダブルクリックしてください。すると、単位の一覧が表示されるので、その中

から選んで変更してください。 

[um]：μm、[ang]：Å です。 

 

 

最後にカンチレバーの形状を設定します。[Cantilever]タブをクリックして下さい。 

以下のような画面が表示されます。 

 

 

⑪ 探針位置 

⑫ カンチレバー形状 

⑬ 穴の形状 

 

まず、⑫でカンチレバーの形状を設定します。図中の灰色の長方形がカンチレバーを表し

ており、右側が先端となります。緑のひし形が探針を表します。 

⑪ 

⑫ 

⑬ 

Ⓒ 

Ⓑ 

Ⓐ 
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上図のように、Ⓐ、Ⓑのスライダーバーでカンチレバーを削っていき、形状を設定してく

ださい。同時にメイン画面を見ながらカンチレバーの形状を確認してください。 

 

次に、⑪Tip Position で探針位置を設定します。スライダーバーⒸを動かして探針位置

を決めてください。カンチレバーの先端に探針が付いている場合は、特に動かす必要はあ

りません。 

 

穴の空いたカンチレバーの場合は、⑬Slitを設定します。 

 

 

[Slit]にチェックを入れると、スリットの長さと幅を入力できるようになります。[Basic 

Structure]の項目を見ながら、穴の大きさがカンチレバー全体より大きくならないように

注意してください。そして、スライダーバーⒹで穴の位置を移動してください。 

メイン画面にも形状を修正したカンチレバーが表示されます。 

 

Ⓓ 
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以上で液中シミュレーションをする場合の基本的な設定は終了です。 

初期設定が終了したら、シミュレーションを開始する前にメニューバーから[Display]―

[Result View]を選択してグラフウィンドウを表示して下さい。 

 

スタートボタンを押して計算を開始すると下図のようにカンチレバーの運動の様子を動画

で見ることができます。 
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液体中のシミュレーションの場合、カンチレバーの周りの流体の速度が表示されます。 

 

 

カンチレバーの動きや流体の速度をもっと誇張したい場合は、メイン画面でマウスを右ク

リックしてください。右クリックをすると以下のようなメニューが表示されます。 

 

      show bar ・・・・・・・カンチレバーの表示／非表示。 

      enlarge motion  ・・・・カンチレバーの動きが大きくなります。 

      shrink motion ・・・・・カンチレバーの動きが小さくなります。 
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      show fluid velocity ・・・流体の速度の表示／非表示。 

      enlarge velocity  ・・・・流体の速度が大きくなります。 

      shrink velocity ・・・・・流体の速度が小さくなります。 

 

計算が開始されると、結果がファイルに次々と出力され、グラフに表示されます。 

 

この計算で出力されるものは以下のものです。 

  

出力内容 ファイル名 ファイル形式 

カンチレバーの動画 barmotion.bar バイナリ 

流体の速度 （液中計算の場合のみ） fluidmotion バイナリ 

探針の高さの時間変化 height.csv テキスト（CSV） 

カンチレバー各点の振幅の時間変化 height_amplitude.csv テキスト（CSV） 

探針に働く力 tipforce.csv テキスト（CSV） 

 

[Result View]ウィンドウの上部に表示されているフォルダに、計算結果ファイルが出力され

ています。動画以外のファイルは CSV形式ですので、お使いのテキストエディタ、もしく

は Microsoft Office Excel などを使用して開くこともできます。 

 

 

次のグラフは、計算条件の違いによるカンチレバーの振動の時間変化をまとめた例です。

横軸：時間、縦軸：カンチレバー先端（探針位置）高さです。それぞれの線については、

赤線：真空中（試料なし）、緑線：真空中（弾性体試料あり）、青線：水中（弾性体試料あ

り）です。 
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真空中で試料が無い場合は、きれいな正弦波を描いています（赤線）。試料は簡単な弾性体

を模擬していますが、探針が試料に接触すると力を受け、カンチレバーの挙動が大きく変

化する様子が分かります。 

また、次のグラフは、真空中と水中におけるカンチレバーの振幅の違いをまとめました。 

 

計算が進むにしたがって、カンチレバーの振動の振幅が一定値に収束していく様子が分か

ります。初期条件設定によっては振幅が収束せず、発散する場合がございますのでご注意

ください。 

 

その他、下図のようなトライアングル型のカンチレバーを作成してシミュレーションする

vacuum-free 

vacuum-sample 

liquid-sample 
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こともできます。カンチレバーの種類については、今後増やしていく予定です。 

 

 

ここで、出力ファイルの height.dat と height_amplitude.dat の違いについて説明します。

例として、SampleProject 以下の、フォルダ LIQ/non_viscoelastic/test_nv_001 について考

えます。このフォルダ内の projectファイルに従ってシミュレーションを行った場合、出力

ファイルとして、次のグラフに示される height.datと height_amplitude.datが得られます。 

 

 

出力ファイル height.dat をグラフ化したもの。縦軸

は、カンチレバーの先端の高さ、横軸は時間を表し

ている。 

 

出力ファイル height_amplitude.dat をグラフ化した

もの。縦軸は、外力による励振周波数の振幅、横軸

は時間を表している。 

 

height.dat は、カンチレバー先端部の高さの時間変化を、そのまま出力しています。一方、

height_amplitude.datは、各時刻での、カンチレバー先端の振動のうち、外力による励振の
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周波数成分の振幅を抽出して出力したものとなっています。 

 

今の例では、周波数 4.0[kHz]、振幅 5.0[nm]で外力により、カンチレバーの根元を振動させ

ています。グラフ height.datを見ると、時刻 t=0より、カンチレバー先端部は順調に振動し

ているように見えます。 

 

しかし、実際は、時刻 t=0付近でのカンチレバーの振動は、主たる振動周波数 4.0[kHz]だけ

でなく、様々な周波数成分の振動の重ね合わせとなっています。このような、周波数成分

の広がりが生じる理由は、カンチレバー自体の固有周波数や、流体の抵抗力から生じる揺

らぎが原因と考えられます。(グラフ height.datでは、32時間ステップ毎にグラフの点をプ

ロットしているので、細かな揺らぎは見えなくなってしまっています。) 

 

時間が経過するにつれて、カンチレバーの振動の主たる周波数成分は、外力による励振周

波数 4.0[kHz]に収束します。系が定常状態に近付くにつれて、雑音となる周波数成分は消え

て行くことになります。グラフ height_amplitude.datは、その様子を再現しています。 

 

 

カンチレバーの周波数特性 ―共鳴曲線― 

 

次に、真空中におけるカンチレバーの周波数特性を計算する事例をご紹介いたします。 

カンチレバーの周波数特性を得るためには、さまざまな周波数で振動させてその振動振幅

がどう変化するのかを調べます。 

まず、前の小節と同じようにプロジェクトの新規作成を行なってください。そして、下図

の よ う に [Project Editor] の [LIQ] ― [Simulation Mode] か ら [Parameter 

Scan(Resonance Curve)]を選択してください。 

 

すると、[Parameter Scan]の項目が入力できる状態になります。 

なお、今回は真空中での計算を行ないますので、[environment]の項目は[Vacuum]にチェ

ックが入った状態にしてください。 



 99 

 

次に、カンチレバーの周波数特性を調べるために、どの周波数範囲で振動させるかを設定

します。 [Parameter Scan]の Frequency―[start]、[end]、[step]をそれぞれ入力し

てください。 

 

上図のように入力した例だと、20.0kHz～50.0kHz までの範囲を 11 分割して計算すること

になります。 

              ３kHzおきに合計１１ステップ 

 

                ・ ・・･･･・ ・  ・ 

[kHz]  20.0   23.0    26.0                                 44.0   47.0   50.0 

次に、[Input data]タブの設定を行ないます。 

前の小節と同様に設定を行なうのですが、ここで注意点は以下の３点です。 

１つめは、⑦[motion]―[frequency]の項目です。前の小節の[Point Oscillation]モー

ドでは、数値の入力が可能でしたが、今回の[Parameter Scan]モードでは先ほどの[mode 

setting]タブー[Parameter Scan]で入力した内容が反映されており、この項目を直接編集

することはできません。 

 

 

 

２つめは、探針と試料間の距離です。前の小節の計算では探針と試料が接触してカンチレ

バーの振動に及ぼす影響を計算しましたが、今回の計算では探針と試料は接触させません。

従って、探針と試料の距離を遠ざけてください。⑧DistanceFromSamplesの値を大きくし

て試料と接触しないように調整してください。 

 

 

３つめは、⑩simulation の項目です。今回の計算ではカンチレバーの振幅がある程度一

定値に収束するまで振動させる必要があるので、[max_cycles]の値は比較的大きくして振

動回数を増やしてください。現在のところ、最大値は 100サイクルまでとなっております。
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水中での計算を行なう場合は、非常に計算時間を要しますのでご注意ください。 

 

また、[convergence]―[criterion]には「0.0」の値を入力してください。 

 

以上の項目に注意して、その他のパラメータやカンチレバーの形状設定に関しては前の小

節と同様に行なってください。 

 

全ての設定が終わりましたら、プロジェクトを保存してシミュレーションをスタートして

ください。 シミュレーションをスタートしてしばらくすると[Result View]には下図のよ

うな共鳴曲線が表示されます。 

 

 

横軸は周波数[Hz]で、縦軸は振幅[m]です。 

 

さらに詳しく共振周波数付近を調べたい場合は、計算したい周波数範囲とステップ数を変

更して、再度同じ流れで計算を実行してください。 
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この部分を再計算 

 

以下に、パラメータスキャンモードを利用して、作成した共鳴曲線を作成した例をご紹介

いたします。 

計算するための測定環境は水中／空気中／真空中で、それぞれカンチレバーの根元の振動

周波数を変更しながら、レバー先端（探針取付け位置）の振動の時間変化を計算しました。

計算結果について、周波数と振動振幅の関係をグラフにまとめることでカンチレバーの動

作特性が得られます。その様子を下図に示します。横軸：周波数、縦軸：振幅で、赤線：

真空中、緑線：空気中、青線：水中での共鳴曲線を表しています。 

水中でシミュレーションした場合の共振周波数が、真空中及び空気中で計算した値より小

さくなっている様子が分かります。 
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このように、カンチレバーの物性値、測定環境等の条件を入力して計算し、周波数特性を

導き出すことができ、実際のカンチレバーの設計を検討する際にも役立ちます。 

 

より複雑な形状のカンチレバーを使ったシミュレーション  

この小節では、より複雑な形状のカンチレバーを使ったシミュレーション方法について説

明します。具体的な例として、プログラムに同梱されているプロジェクトファイル 

¥non_viscoelastic¥test_nv_002¥test_nv_002.proを使用することとします。 

 

このプロジェクトファイルで指定されているカンチレバーの形状は以下の図のようになり

ます。 

 

 

このカンチレバー形状は、プロジェクトファイル test_nv_002.pro 内の、<bar><structure>

というタグの下にある、以下の記述により指定されます。 

<body display="false"> 

<section display="false">0.0 1.0 1.0</section> 

    <section display="false">0.75 1.0 1.0</section> 

<section display="false">1.0 0.4 1.0</section> 

</body> 

<split display="false"> 

<section display="false">0.125 0.0 0.1</section> 

<section display="false">0.25 0.0 0.1</section> 

</split> 

<split display="false"> 

<section display="false">0.125 0.25 0.35</section> 

<section display="false">0.25 0.25 0.35</section> 

</split> 

<split display="false"> 
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<section display="false">0.375 0.0 0.1</section> 

<section display="false">0.5 0.0 0.1</section> 

</split> 

<split display="false"> 

<section display="false">0.375 0.25 0.35</section> 

<section display="false">0.5 0.25 0.35</section> 

</split> 

<split display="false"> 

<section display="false">0.625 0.0 0.1</section> 

<section display="false">0.75 0.0 0.1</section> 

</split> 

<split display="false"> 

<section display="false">0.625 0.25 0.35</section> 

<section display="false">0.75 0.25 0.35</section> 

</split> 

 

複雑な形状のカンチレバーを指定する場合、以下の点に注意します。上で示したカンチレ

バーの図を見ると分かるように、レバーは長さ方向に 0.125の割合で 8個に分割されたブ

ロックを単位として構成されています。そこで、カンチレバーの動きを差分方程式で表現

する場合、レバーは長さ方向に 8の倍数で領域分割されると、数値計算に都合が良いと考

えられます。実は、ソルバーの都合上、差分のための要素分割数は、見掛け上のブロック

数の 2倍以上という制限が有ります。そこで、この場合は、カンチレバーの長さ方向の差

分分割数は 16以上の 8の倍数にしなくてはなりません。このような事情から、ここでは、

32分割を指定することとします。 

 

このカンチレバーの長さ方向の差分計算用分割数が 32という指定は、プロジェクトファイ

ル test_nv_002.pro 内の、<bar><structure>というタグの下にある、<sections>により指定

されます。ここでさらに、以下の注意が必要となります。すなわち、タグ<sections>に与え

る数字は、差分計算用分割数に 1を加えたものでなくてはならないという規則が有ります。

そこで、最終的には、 

<sections>33</sections> 

と記入します。 

 

最後に、流体の速度ベクトルの表示と、差分計算用分割数との関係について説明します。

下図に示されるように、シミュレーション実行時(Caluculation)および Replay時に、カンチ

レバーの動きと流体の速度ベクトル場が、メイン・ウィンドウ上に表示されます。流体の
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速度場は、カンチレバーを切断する面について表示されます。この流体速度場を表示する

断面は、4個の差分用分割領域毎に表示されるように設定されています。従って、カンチレ

バーの分割数は、4の倍数だと、メイン・ウィンドウ上に表示される画像が見やすくなりま

す。従って、<bar><structure><sections>で指定する分割数は、4の倍数に 1を加えた値を

入れると良いでしょう。 

 

 

 

粘弾性接触力学を考慮したシミュレーション 

この小節では、カンチレバー先端探針と試料間の粘弾性接触力学を考慮したシミュレーシ

ョンを行う方法について説明します。液中ソフトマテリアルAFMシミュレータには、粘弾

性接触力学をシミュレーション計算に含めるオプションが用意されています。このオプシ

ョンを使用すると、探針先端探針と粘弾性の有る試料が接触した際の動力学が、

Johnson-Kendall-Roberts (JKR)理論によって記述されると仮定され、表面張力に由来する

凝着現象がシミュレーション計算に取り入れられます。この機能を使えば、例えば、探針

が試料表面との相互作用で受ける外力の変化の様子を、手軽にシミュレーション計算する

ことが可能となります。 

粘弾性接触力学を考慮したシミュレーション用のサンプル・プロジェクトは、フォルダ

¥viscoelasticの下にまとめられています。下の表に示される三種類のサンプル・プロジェク

トが用意されています。用途に合わせて参考にして下さい。 
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testp_v_001 真空中での測定を仮定。カンチレバーの弾性率は小さめに設定。 

testp_v_002 真空中での測定を仮定。カンチレバーの弾性率は大きめに設定。 

testp_v_003 液体中での測定を仮定。カンチレバーの弾性率は大きめに設定。 

 

粘弾性接触力学を考慮したシミュレーションを実行する場合、projectファイルに書き込む

べき重要な項目がいくつかあります。それらは以下の表にまとめられます。 

<LIQ><fluid><material><kviscosity> 流体の動粘性係数(unit="m^2/s") 

<LIQ><fluid><material><density> 流体の密度(unit="kg/m^3") 

<LIQ><fluid><material><impulse> 流体が受ける分子のランダムな撃力

(unit="N/ms") 

<LIQ><bar><material><density> カンチレバー材質の密度(unit="kg/m^3") 

<LIQ><bar><material><young> カンチレバー材質のヤング率(unit="GPa") 

<LIQ><bar><material><poisson> カンチレバー材質のポアソン比(無次元量) 

<LIQ><bar><material><friction> カンチレバー材質の摩擦係数(無次元量) 

<LIQ><bar><material><hamaker> カンチレバー材質のハーマーカー定数

(unit="J") 

<LIQ><bar><structure><tip><radius> カンチレバー先端探針半径(unit="nm") 

<LIQ><bar><motion><frequency> 

 

カンチレバーを外力で振動させる際の周波

数(unit="kHz") 

<LIQ><bar><motion><amplitude> カンチレバーを外力で振動させる際の振幅

(unit="nm") 

<LIQ><bar><motion><baseheight> 試料表面から静止時のカンチレバー中心ま
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での高さ(unit="nm")[探針を試料に接触さ

せたいので、この値はカンチレバーの振動の

振幅と、ほぼ等しい値が望ましい] 

<LIQ><bar><DistanceFromSamples> baseheightと等しい値を入れる

(unit="nm") 

<LIQ><sample><material><point> 

<young> 

試料のヤング率(unit="GPa") 

<LIQ><sample><material><point> 

<poisson> 

試料のポアソン比(無次元量) 

<LIQ><sample><material><point> 

<damper> 

ダンパー定数(unit="Ns/m")[探針の速度に

比例した抵抗力を生成させたい場合に使用

する] 

<LIQ><sample><material><point> 

<tension> 

探針-試料接触時の張力(unit="uN") 

<LIQ><sample><material><point> 

<touch> 

静止時の探針から試料表面に接触するまで

の距離(負の値となる)[baseheightの反対符

号の値を入れる](unit="nm") 

<LIQ><sample><material><point> 

<detach> 

静止時の探針と、探針が試料表面から離脱す

る点までの距離(負の値となる)[touchと等

しい値を入れる](unit="nm") 

<LIQ><sample><material><point> 

<hamaker> 

試料のハーマーカー定数(unit="J") 

<LIQ><sample><material><point> 試料の表面張力(unit="N/m") 
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<adhesive> 

<LIQ><simulation><time> 

<max_cycles step="smooth">1.6 

カンチレバーが外力によって振動する際の、

シミュレーションの開始から終了までの周

期(無次元量)[1.6程度とすると良い] 

<LIQ><Output><Directory> 

<delta_tipforce where="head" 

interval="1" displaytype="1D" 

ctrl="label">delta_tipforce.csv 

出力ファイルとしてdelta_tipforceを指定す

ると、探針-試料間の距離および引力・斥力

の時間変化を得る事が出来る 

 

粘弾性接触力学を考慮したシミュレーションは、以下の手順で実行できます。まず、GUI

画面左側のProject Editorウィンドウ内に配置されているLIQ→Mode settingタブの、

viscoelasticityボタンをonにします。(このボタンは、デフォルトではoffとなっています。)

次に、通常のシミュレーション計算と同じく、Calculationをスタートさせます。 

 

 

例えば、サンプル・プロジェクト・フォルダ/viscoelastic/testp_v_002内の、testp_v_002.pro

について、シミュレーション計算を実行した場合、出力ファイルdelta_tipforce.csvより以下

のフォースカーブが得られます。(このグラフは、サンプル・プロジェクト・フォルダ

/viscoelastic/testp_v_002/output内に収められている、delta_tipforce_ref.xlsxという名前のフ

ァイルに保存されています。) 
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上の図は、真空中において、ばね定数の大きなカンチレバーで探針を試料に接触させたと

きの、探針先端部の変位と探針先端部にかかる外力との関係をプロットしたグラフです。

ただし、上のグラフでは、横軸を探針先端部の変位、縦軸を探針先端部にかかる外力とし

ています。横軸の変位は、試料表面をゼロとして、下向きを正としています。縦軸の外力

は、上向きを正としています。 
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4 原子分子ナノ材料 AFM像シミュレータ 

 

 

はじめに 

 

この節では「原子分子ナノ材料 AFM 像シミュレータ」で計算することのできる事例を、

ソフトウェアに同梱しているプロジェクトファイルから選んで、紹介いたします。このシ

ミュレータでは探針を試料に近づけることによる試料分子の変形を考慮したシミュレーシ

ョンが可能です。試料分子の変形は、計算手法の違いによって、次の二種の計算モードを

選択することができます。 

 

1. 構造最適化 AFM像シミュレータ・・・分子内部のエネルギーが最小になるような

原子配置を探索することにより、安定な分子構造を求める方法 

2. 分子動力学 AFM像シミュレータ・・・原子一つ一つについてニュートンの運動方

程式を解くことにより、分子構造の時間変化を求める方法 

 

このシミュレータでの計算手順は大まかには以下のような流れになっています。 

 

i. 探針モデルと試料モデルを配置する(Setupタブでの設定) 

ii. その他の入力パラメータを設定する(各シミュレータのタブでの設定) 

iii. 計算を実行する 

iv. 計算終了後、結果を見る 

 

なお、計算に必要な入力パラメータの詳細な説明につきましては、「リファレンスマニュア

ル」を参照してください。 

 

 

真空中にあるペンタセンの周波数シフト像計算の例 

 

構造最適化 AFM 像シミュレータによる、有機分子試料を対象とした真空中の原子分解能

AFM 計算の例を紹介します。 (ここで紹介している例はプロジェクトファイル

SampleProject¥CG¥NC_pentacene¥NC_pentacene.proに対応しています。) 

探針には、先を COで修飾したものを想定し CO分子を用い、試料はペンタセン分子です。

ここでは、ペンタセン分子は構造が変化しないとして、各原子の座標は固定するように設

定します。 

 

４ 原子分子ナノ材料 AFM像シミュレータ 

 原子分子ナノ材料 AFM 像シミュレータ 
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入力パラメータの設定は画面左の”Project Editor”で行います。主なパラメータ設定項目は次

の通りです。(詳細は「リファレンスマニュアル」を参照ください) 

 

探針の走査開始位置 

探針の走査範囲(Setup → Tip → ScanArea) 

系の環境(CG → AFMMode) 

スキャンモード(CG → Tip_Control → scanmode) 

解像度(CG → Tip_Control → delta_xy) 

探針の鉛直方向移動数(CG → Tip_Control → NC_Mode_Setting → ThetaStepNumber) 

探針の振幅(CG → Tip_Control → NC_Mode_Setting → TipZamplitude) 

カンチレバーのバネ定数(CG → Tip_Control → NC_Mode_Setting → SpringConst) 

共鳴周波数(CG → Tip_Control → NC_Mode_Setting → ResoFreq) 
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この計算設定条件による周波数シフト像のシミュレーション結果は、Result ビューで参照

することができます。(メニュー → Display → Result を選択し、表示された Result ビュ

ー画面上部のボックスから”test_frq.csv”を選択) 

 

 

 

水中フォースカーブ計算の例 
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同じく、構造最適化 AFM 像シミュレータを用いた例として、ここでは水中 AFM 計算の例

を 紹 介 し ま す 。 ( こ こ で 紹 介 し て い る 例 は プ ロ ジ ェ ク ト フ ァ イ ル

SampleProject¥CG¥HOPG_RISM¥HOPG_RISM.proに対応しています。) 探針にはカーボ

ンナノチューブを想定し、試料はグラフェンシート(HOPG)です。ここでは、構造が変化し

ないとして、各原子の座標は固定するように設定します。 

 

 

 

入力パラメータの設定は画面左の”Project Editor”で行います。水中計算を行うためには 

系の環境(CG → AFMMode) 

の値を CG_RISM に設定する必要があります。水中計算ではほぼ全てのパラメータが計算

に影響しますので、「リファレンスマニュアル」を参照の上、ご設定ください。ここではサ

ンプルプロジェクトにあるように、探針を鉛直方向に下げていったときのフォースカーブ

計算の結果を掲載します。下左図が探針に働く力の鉛直方向成分、下右図が系の全自由エ

ネルギーの値です。水中測定の特徴である振動的な振舞いが再現されています。 

なお、参考データとして水分子に対する相関関数の計算結果が結果の出力されるディレ

クトリに CG_RISM_Corr_VV.csvという名前で出力されます。（ただし、このファイルのデ

ータは GUIで表示できません。） 
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アルカン分子のフォースカーブ計算の例 

 

分子動力学 AFM像シミュレータによる、有機分子試料を対象とした試料分子の変形とフ

ォースカーブを予測する計算例を紹介します。(ここで紹介する例はプロジェクトファイル

SampleProject¥MD¥FCurve_octane4¥FCurve_octane4.proに対応しています。) 

探針にはカーボンナノチューブを想定し、試料にはオクタン４分子を用います。ここで

は、オクタン分子の一方の端が基盤に固定されていると考え、端の原子を固定するように

設定し、４つの分子を並べて配置します。固定した原子とは反対の方向からカーボンナノ

チューブ探針を近づけ、探針に作用する力を計算します。 
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入力パラメータの設定は画面左の”Project Editor”で行います。主なパラメータ設定項目は

次の通りです。(詳細は「リファレンスマニュアル」を参照ください) 

 

① 探針の移動開始位置(Setup → Tip → Position ) 

② 探針の移動範囲(Setup → Tip → ScanArea -> h) 

③ 各試料の位置(Setup → Sample → Position ) 

④ スキャンモード(MD → Tip_Control → scanmode) 

⑤ 解像度(MD → Tip_Control → delta_z) 

⑥ 時間刻み幅(MD → MD_Setting → TimeStep) 

⑦ 探針位置あたりの計算ステップ数(MD → MD_Setting → StepNumber) 

⑧ 温度(MD → MD_Setting → Temperature) 

 

この計算設定条件によるフォースカーブのシミュレーション結果は、Resultビューで参照

することができます。(メニュー → Display → Result を選択し、表示された Result ビュ

ー画面上部のボックスから”test_fz.csv”を選択)) 
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フォースカーブ計算中の探針と試料の動きは、Replay を選択し再生することにより見るこ

とができます。 
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5 量子論的 SPM像シミュレータ 

 

 

はじめに 

 

この節では「量子論的 SPM像シミュレータ」で計算することのできる事例を、ソフトウ

ェアに同梱しているプロジェクトファイルから選んで、紹介いたします。「量子論的 SPM

像シミュレータ」での計算手順は大まかには以下のような流れになっています。 

 

i. 探針モデルと試料モデルを配置する(Setupタブでの設定) 

ii. その他の入力パラメータを設定する(DFTBタブでの設定) 

iii. 実行を開始する 

iv. 計算終了後、結果を見る 

 

グラフィカルユーザーインターフェースの具体的な操作方法は前節で紹介しています。な

お、計算に必要な入力パラメータの詳細な説明につきましては、「リファレンスマニュアル」

を参照してください。 

 

AFM（周波数シフト像）計算の例 

 

はじめに、本ソフトウェアの他のシミュレータにも備わっている AFM計算(周波数シフト

像の予測 )の例を紹介します。 (この例は同梱されているプロジェクトファイル

H 

Si 

５ 量子論的 SPM像シミュレータ 

 

シミュレータ 

 量子論的 SPM 像シミュレータ 
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SampleProject¥DFTB¥afm_hsi¥afm_hsi.proによるものです。) 他のシミュレータでは行う

ことのできない精密な AFMシミュレーションを必要とする場合にご利用ください。 

探針は、水素が吸着したシリコン探針の先端をモデル化したものであり、試料は水素終

端されたシリコン(001)表面です。 

この計算例で注意すべきパラメータは以下の図の通りです。特に重要なものは赤枠で囲

った箇所で、大まかな意味は以下のとおりです。(別の系の計算を行う場合、囲っていない

箇所のパラメータも注意する必要があります。詳しくは「リファレンスマニュアル」を参

照してください。) 

① 探針走査範囲の始点 

② 探針走査範囲のサイズ。周波数シフト像を計算する際にはタグ h の値を 0 よ

り大きくしてください。 

③ 計算モード。DFTB_AFMを選択してください。 

④ カンチレバーの物理パラメータ 

⑤ 探針のマクロ形状に関するパラメータ 

(注) 現時点では構造緩和計算を取り入れることはできません。 

 

 

 ① 

③ 

④ 

⑤ 

② 
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この設定による周波数シフト像のシミュレーション結果は Result ビューでみることがで

き、以下のようになります。(カラーバーを逆転させています)。設定した探針試料間距離の

場合、水素が置かれている位置では引力が強くなり周波数シフトの絶対量が大きくなるこ

とが分かります。 

 

 

 

 

STM計算の例 

 

（１）トンネル電流像の計算 

 

次に、本ソフトウェアの他のシミュレータには備わっていない STM計算の例を二つ紹介

します。一つ目はトンネル電流像の予測例を紹介します。(この例は同梱されているプロジ

ェクトファイル SampleProject¥DFTB¥stm_hsi¥stm_hsi.proによるものです。) 

探針はシリコン探針の先端をモデル化したものであり、試料は水素終端されたシリコン

(001)表面から水素を一つ取り除いたものです。 
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この計算例で注意すべきパラメータは以下の図の通りです。特に重要なものは赤枠で囲

った箇所で、大まかな意味は以下のとおりです。(別の系の計算を行う場合、囲っていない

箇所のパラメータも注意する必要があります。詳しくは「リファレンスマニュアル」を参

照してください。) 

 

① 探針走査範囲の始点 

② 探針走査範囲のサイズ。タグ hの値は 0として扱われます。 

③ 計算モード。DFTB_STMを選択してください。 

④ 探針の電位(STMモードではminimumに指定した値のみで計算されます。) 

⑤ 試料の電子状態を計算する際の k点の分割数。 

 

H 

Si 

この列の Hが一つ少ない 
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この設定によるトンネル電流像のシミュレーション結果は Result ビューでみることがで

き、以下のようになります。(カラーバーを逆転させています)。水素が抜けている位置にダ

ングリングボンドがあることにより、電流値が大きくなることが分かります。 

 

① 

② 

③ 

④ 

⑤ 
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この他に 4通りのトンネル電流像の計算事例を同梱しております。 

シリコン探針先端とシリコン(111) DAS 7x7表面： 

SampleProject¥DFTB¥stm_das7¥stm_das7.pro 

フラーレン探針とシリコン(111) DAS 7x7表面： 

SampleProject¥DFTB¥stm_das7_c60¥stm_das7_c60.pro 

シリコン(001)-2x1:H表面とシリコン探針： 

SampleProject¥DFTB¥stm_si001_2x1h¥stm_si001_2x1h.pro 

シリコン(001)-3x1:H表面とシリコン探針： 

SampleProject¥DFTB¥stm_si001_3x1h¥stm_si001_3x1h.pro 

 

 

（２）STS の計算 

STM計算の例の二つ目としてトンネル電流分光の計算例を紹介します。(この例は同梱さ

れ て い る プ ロ ジ ェ ク ト フ ァ イ ル

SampleProject¥DFTB¥sts_si001_3x1h¥sts_si001_3x1h.proによるものです。) 探針は

シリコン探針先端をモデル化したものであり、試料はシリコン(001)-3x1:H表面です。 

 

 

この計算例で注意すべきパラメータは以下の図の通りです。特に重要なものは赤枠で囲

った箇所で、大まかな意味は以下のとおりです。(別の系の計算を行う場合、囲っていない

箇所のパラメータも注意する必要があります。詳しくは「リファレンスマニュアル」を参

照してください。) 
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① 探針の位置(STSモードではこの位置でのみ計算が行われます。) 

② 計算モード。DFTB_STSを選択してください。 

③ 探針の電位(最小値、最大値、分割数) 

④ 試料の電子状態を計算する際の k点の分割数。 

 

 

この設定によるトンネル電流スペクトルの計算結果は Result ビューでみることができ、

以下のようになります。左図が電流電圧カーブ、右図がスペクトル[(dI/dV)/(I/V)の値]です。

横軸の電圧は試料に対する探針での値です。 

 

① 

② 

③ 

④ 
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KPFM計算の例 

 

最後に KPFM 計算(接触電位差像の予測)の例を紹介します。(この例は同梱されているプ

ロジェクトファイル SampleProject¥DFTB¥kpfm_c6¥kpfm_c6.proによるものです。) 

探針は、水素が吸着したシリコン探針の先端をモデル化したものであり、試料はシリコ

ン(001)-c(4x2)表面です。 
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この計算例で注意すべきパラメータは以下の図の通りです。特に重要なものは赤枠で囲

った箇所で、大まかな意味は以下のとおりです。(別の系の計算を行う場合、囲っていない

箇所のパラメータも注意する必要があります。詳しくはリファレンスマニュアルを参照し

てください。) 

 

① 探針走査範囲の始点 

② 探針走査範囲のサイズ。タグ hの値は 0として扱われます。 

③ 計算モード。DFTB_KPFMを選択してください。 

④ 探針の電荷中性度の探索範囲(最小値、最大値、分割数) 

注) 採用している計算モデルの都合上、電位差での指定は行えません。 

 

 

 

この設定による接触電位差像のシミュレーション結果は Result ビューでみることができ、

以下のようになります。表面のアップダイマーを繋ぐようにした電位差の大きい領域が見

られます。 

① 

③ 

④ 

② 
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この他に 3通りの接触電位差像の計算事例を同梱しております。 

Si探針および Si(001)-c(4x2)試料表面、ただし探針試料間距離を短くしたもの： 

SampleProject¥DFTB¥kpfm_c4¥kpfm_c4.pro 

Si探針および不純物を含む Si(001)-c(4x2)試料表面： 

SampleProject¥DFTB¥kpfm_n6¥kpfm_n6.pro 

SampleProject¥DFTB¥kpfm_n4¥kpfm_n4.pro 
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第４章 

実測画像－シミュレーション画像比較機能 
 

 

 

1 概要 

 

 

実測画像－シミュレーション画像比較機能 GUI（以下 Analyzer）では、SPMの測定画像や

各種解析ソフトの出力データ、本シミュレータの計算結果、論文からのキャプチャ画像な

ど、様々な形式のデータを読み込み、２次元、３次元画像として可視化することができま

す。これらの画像を並列表示することで、各画像を容易に比較することができます。また

読み込んだデータを様々な形式で保存できるため、データ形式変換ソフトとしてもご使用

いただけます。また測定の際に生じる傾斜を自動補正する機能や画像からの探針推定機能、

測定画像から探針の影響を取り除く機能なども備えています。さらに、画像のフーリエ解

析や高解像度化機能、ニューラルネットを用いた探針影響除去機能なども備えています。

その他、デジタル画像処理ツールとして、閾値による画像の二値化機能、コントラスト調

整(ガンマ補正)機能、エッジ抽出(Sobel フィルタ処理)機能、ノイズ除去(メディアンフィル

タ処理)機能が用意されています。 

 

シミュレーション画像 

シミュレータ 

MD 

FEM 

DFTB 

CG 

LIQ 

GEO 

Analyzer 

解析ソフト 

実測画像 

SPM装置 

解析画像 

論文等 

キャプチャ画像 

並列表示 

１ 概要                     
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2 画面説明 

 

 

Image View 

Menu Bar & Tool Bar 

Cross Section View 

Data View 

Image View 

Image View 

Analyzer 

２ 画面説明 
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以下では画面ごとの主な機能について説明します。 

 

【Analyzer】 

ウィンドウ画面全体を表します。 

 

【Menu Bar & Tool Bar】 

データファイル読み込みや保存などのファイル操作、Image Viewの整列やクローズな

どのウィンドウ操作を行います。 

 

【Image View】 

読み込まれたデータファイルの内容を２次元および３次元画像として可視化します。

マウスやキーボードの操作によって、視点の変更や拡大縮小を自由に行うことができ

ます。またマウス操作によって、対象を任意の位置で切断することができ、その断面

図は Cross Section Viewで見ることができます。なお、このウィンドウは同時に複数

表示することが可能であり、並列表示などが行えます。 

 

【Cross Section View】 

Image Viewで切り取られた断面をグラフ表示します。 

 

【Data View】 

読み込んだデータファイルの内容を表形式でテキスト表示します。 

 

 

3 Analyzerの起動と終了 

 

 

【起動】 

 

 

３ Analyzerの起動と終了 
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1. シミュレータ本体 GUI “Menu Bar” → [Tool] → [Analyzer] 

 

以上の操作によって、実測画像－シミュレーション画像比較機能用の GUIである Analyzer

が起動します。 

 

【終了】 

 

 

 

1. Analyzer“Manu Bar”→ [File] → [Exit]  

 

以上の操作で Analyzerは終了しますが、シミュレータ本体の GUIは終了しません。 

 

 

4 ファイル操作 

  

 

Analyzerでは、様々なメーカーの SPM測定画像の他、本シミュレータの計算結果や論文

からのキャプチャ画像などのデータファイルを読み込むことができます。また読み込んだ

４ ファイル操作 

す 
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データは別の形式に変換して保存できます。さらに Image Viewの描画を、そのまま画像と

して保存するキャプチャ機能も備えています。ここでは、データファイルの読み込みと保

存、描画のキャプチャ方法について説明します。 

 

データファイルの読み込み 

【ファイルダイアログを使用した読み込み】 

 

Image View 
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1. “Menu Bar” → [File] → [Open]
41

 → ”Open File”ダイアログ 

2. データファイル指定 → [開く] 

 

Analyzerでは、一般の画像形式（jpeg,bmp,png,tif）、Cube（本シミュレータ出力形式）、各

種装置メーカー・解析ソフト出力形式（Unisoku、Omicron、Gwyddion、WSxM、SPIP、

Asylum、Surf）に対応しています。指定されたデータファイルが読み込まれると、Image View

が表示され、その中に２次元画像42が描画されます。 

 

【最近使用したデータファイルの読み込み】 

 

1. “Menu Bar” → [File] → [Recent Files] → データファイル一覧43→データファイル指定 

 

【一般の画像形式のデータファイルの読み込み】 

bmp や jpg などの画像ファイルは、明るさの情報はもちますが、例えば高さ情報はもって

いません。したがって、データを読み込む際には、明度を実際の高さ情報に変換する処理

が必要となります。また、画像の大きさ（縦横サイズ）が現実に何Åかということを指定

する必要があります。以下では画像ファイルの読み込みについて説明します。 

                                                   
41 この操作は、”Tool Bar” → Openアイコンをクリックすることでも行えます。 
42 ３次元表示など、描画法の変更については後述します。 
43 最近使ったプロジェクトファイルは最大 10個まで表示されます。 
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1. “Menu Bar” → [File] → [Open]
44

 → ”Open File”ダイアログ 

2. データファイル指定 → [開く] 

3. ”Set scale”ダイアログ → “Distance between pixels”入力 → [OK] 

4. ”Set Value Range”ダイアログ → “value range”入力 → [OK] 

 

“Set scale”ダイアログで、画像ファイルのピクセル間の距離が実際には何Åに対応するのか

を指定します。さらに“Set Value Range”ダイアログで、画像の明度[0.0,1.0](黒=0.0、白=1.0

で表現)がどれくらいの高低差（Å）に相当するのかを指定します。 

 

データファイルの保存 

 

読み込んだ様々な形式のデータファイルを別名および別形式で保存することができます。 

 

                                                   
44 この操作は、”Tool Bar” → Openアイコンをクリックすることでも行えます。 
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1a. “Manu Bar”→ [File]  

1b. “Image View”右クリック45
 → コンテクストメニュー 

2. [Save As]
46

 → “Save As ”ダイアログ → ファイル名指定 → [保存] 

 

 

イメージの保存 

 

数値データそのものだけではなく、Image Viewに表示されている画面自体を画像として保

存することができます。 

                                                   
45 複数の Image View が立ち上がっている場合は、保存したいデータが表示されている Image View上で右クリックして

ください。 
46 この操作は、”Tool Bar” → Saveアイコンをクリックすることでも行えます。 
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1a. “Manu Bar”→ [File]  

1b. “Image View”右クリック → コンテクストメニュー 

2. [Export Image]
47

 → “Export Image ”ダイアログ → ファイル名指定 → [保存] 

 

 

5 画像のフーリエ解析・高解像度化 

 

 

本機能を用いることで、FFT 解析を用いた画像処理、Lanczos 補間を用いた画像の高解像

度化処理を行うことができます。 

 

画像のフーリエ解析 

 

【データ描画】 

 

 

                                                   
47 この操作は、”Tool Bar” → Export Imageアイコンをクリックすることでも行えます。 

５ 画像のフーリエ解析・高解像度化 

す 
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1. “Image View”右クリック → コンテキストメニュー → [Image Processing] →”Image 

Processing View” 

2. “Tool Bar” → “Mode Combo Box” → [Cartesian/Fourier/Power Spectrum] 

 

“Mode Combo Box”において、Cartesian（通常画像）、Fourier（フーリエ画像）48、Power 

Spectrum（パワースペクトルグラフ）49の表示を切り替えることができます。 

 

【画像処理】 

                                                   
48 Fourier画像の値は Log Scaleで表示しています。 
49 Power Spectrumは両対数グラフとして表示しています。 

Image Processing View 

Mode Combo Box 

Cartesian Fourier Power Spectrum 
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1. “Tool Bar” → “Slider Bar” 移動 

2. “Tool Bar” → [Reset] クリック 

 

Slider Bar 

Cartesian Fourier Power Spectrum 

Reset 

高周波強調 

低周波強調 
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“Slider Bar”のつまみを移動させることで、パワースペクトルグラフの傾きを連続的に変化

させることができます50。それに伴って、Cartesian（通常画像）、Fourier（フーリエ画像）

も変化します。つまみを左（右）に移動させると低周波（高周波）を強調した画像になり

ます。また[Reset ]ボタンをクリックすることで、スライダーバーのつまみの位置を、ゼロ

位置に戻すことができます。 

 

【階調補正】 

 

 

1. ”Image Processing View”右クリック → コンテキストメニュー → [Tone Correction]  

 

[Tone Correction]はトグルボタンであり、この操作によって階調補正のオンオフを切り替え

ることができます。 

 

【Analyzerへのエクスポート】 

                                                   
50 グラフを、べき分布、つまり両対数グラフで直線として近似し、その傾きを連続的に変化させていきます。 
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1. ”Image Processing View”右クリック → コンテキストメニュー → [Export to Analyzer]  

 

この操作によって、”Image Processing View”上の画像を、Analyzer上の”Image View”にエ

クスポートすることができます。その際、データは、”ファイル名[1].cube”という Cube 形

式のファイルに自動保存されます。 

 

画像高解像度化 

 

 

 

Up Resolution /Down Resolution Button 

 

画像サイズ 
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1.  “Tool Bar” → [Up Resolution / Down Resolution]  

 

[Up Resolution / Down Resolution]ボタンを押すことによって、画像の解像度を上げたり下

げたり51することができます。画像サイズは”Tool Bar”右端のテキストボックスに表示され

ます。 

 

                                                   
51 解像度を変える際、Lanczosフィルターを用いた補間処理を行っています。 

 

高解像度画像 

 

画像サイズ 
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6 ニューラルネットシミュレータ 

 

 

ニューラルネットシミュレータは、「原画像と観測画像」、「低解像度画像と高解像度画像」

といった何らかの関係のある２種類の画像間の関係を学習することができます。例えば形

状が既知の標準試料をトレーナー画像（正解画像）とし、その SPM画像を入力画像として

両者の関係を学習させるとします。この場合ネットワークは、探針が SPM画像に及ぼす影

響を学習していると考えられます。学習終了後、このネットワークに、同じ探針で走査し

たある試料の SPM画像を入力すると、探針の影響を取り除いた画像が出力されると期待で

きます。 

 

 

 

 

 

試料 SPM画像 探針 観測過程 

既知試料 既知試料SPM画像 ニューラルネット 学習過程 

推定試料 任意のSPM画像 ニューラルネット 推定過程 

Neuralnet Simulator 

画像１ 画像２ 

画像１と画像２の関係を学習 

６ ニューラルネットシミュレータ 

す 
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ニューラルネットシミュレータの起動 

 

 

1. Analyser“Menu Bar” → [Tool] → [Neuralnet Simulator] 
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学習データの設定 

 

 

入力画像 

 

トレーナー画像 

 

Select original images ダイアログ 

 

Select observed images ダイアログ 

 

Training Data Set ウィンドウ 
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1. Neuralnet Simulator “Menu Bar” → [File] → [Open]
52

 → ”Select observed images ”ダ

イアログ → 入力画像指定 → [開く] 

2. ”Select original images ”ダイアログ → トレーナー画像指定 → [開く] 

 

以上の操作でニューラルネットシミュレータに学習データ設定されます。学習データは入

力画像、トレーナー画像ともに複数枚指定することができますが、両者は同じ枚数でなけ

ればなりません。設定された画像は、シミュレータの右側（右上：入力画像、右下：トレ

ーナー画像）に表示されます。ただし複数枚指定した場合は、それらの内１セット分だけ

表示されます。 

 

 

学習の実行・停止・一時停止 

 

【実行】 

 

1.  “Tool Bar” → [Start] 

 

 [Start]ボタンを押すと、学習が開始されます。ニューラルネットからのメッセージは、Log 

View上に表示されます。 

 

                                                   
52 この操作は、”Tool Bar” → Openアイコンをクリックすることでも行えます。 

Start 

Log View 
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【停止・一時停止】 

 

1. “Tool Bar” → [Stop/ Pause] 

2. “Menu Bar” → [Display] → [Error View] 

 

学習開始後、[Start]ボタンが使用不可となり、[Stop]ボタンと[Pause]ボタンが使用可能とな

ります。[Stop]ボタンを押せば実行を停止し、ネットワークの状態は初期化されます。[Pause]

ボタンを押すことで、学習を一時停止できます。再開するには、再び[Start]ボタンを押しま

す。学習を一時停止し、Error Viewを立ち上げることで、各時点でのネットワークの出力画

像とトレーナー画像（正解画像）との平均二乗誤差（Mean Square Error:MSE）の時間発展

を見ることができます。なお、各時点での MSEは、”Log View”上にも表示されます。 

 

学習結果の保存と読み込み 

 

【保存】 

一時停止、あるいは学習が完了し、ニューラルネットが停止状態にある時には、その時点

での学習状態（ユニット間の重み）を保存することができます53。以下では保存方法につい

て説明します。 

                                                   
53 [Stop]ボタンを押すと、ネットワークの状態が初期化されてしまいます。保存は[Stop]ボタンを押す前に行ってく

ださい。 

Stop Pause 

Error View 
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1. “Menu Bar” → [File] → [Save Weight File] → ”Save Weight File”ダイアログ 

2. 保存ファイル名指定 → [保存] 

 

【読み込み】 

保存された学習結果ファイルは、ニューラルネットワークに読み込むことができます。こ

れによって、ファイルが保存された時点の学習状態を再現することができます。 

 

 

 

1. “Menu Bar” → [File] → [Load Weight File] → ”Load Weight File”ダイアログ 

2. 読み込みファイル名指定 → [開く] 

Load Weight File ダイアログ 

Save Weight File ダイアログ 



 146 

 

学習結果のチェックと新規入力画像に対する試行 

 

【学習結果のチェック】 

 

 

1. “Tool Bar” → [Check] → ”Input Image/Reconstructed Image/Difference Image” 

 

一時停止、あるいは学習が完了し、ニューラルネットが停止状態にある時には、その時点

での学習状態を視覚的にチェックすることができます。ツールバーの[Check]ボタンを押す

と、その時点のネットワークに学習データセット時に指定した入力画像(Input Image)が入力

され、出力結果画像(Reconstructed Image)が表示されます。またこの結果画像と、はじめ

に学習データとしてセットされたトレーナー画像との差分画像(Difference Image)も表示さ

れます。 

 

【新規入力画像に対する試行】 

 

Input Image Reconstructed Image Difference Image 
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1. “Tool Bar” → [Trial] → “Open File”ダイアログ 

2. 画像ファイル指定 →  [開く] → ”Input Image/Reconstructed Image/Difference Image” 

 

学習終了後、学習データセット時に用いられた入力画像とは別の画像を使って、そのニュ

ーラルネットワークをテストすることができます。ツールバーの[Trial]ボタンをクリック

し、”Open File”ダイアログで入力画像を指定すると、その時点のネットワークに指定画像

(Input Image)が入力され、計算結果画像(Reconstructed Image)が表示されます。 

Open File ダイアログ 

Input Image Reconstructed Image 
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ウィンドウの表示／非表示・LogViewのクリア 

 

 

【ウィンドウの表示／非表示】 

1. “Menu Bar” → [Display] → [Training Data Set / Input Image / Reconstructed Image / 

Difference Image / Error View] 

 

[Display]メニューから表示／非表示したいWindowをクリックします。 [Training Data Set 

/ Input Image / Reconstructed Image / Difference Image / Error View]は各々トグルボタンで

あり、クリックを繰り返すことによって、対応するウィンドウの表示／非表示を切り替え

られます。 

 

【Log Viewのクリア】 

Input Image 
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1. “Tool Bar” → [Clear]  

 

ツールバーの[Clear]ボタンを押すことで、”Log View”に表示されている文字列が全て消去さ

れます。 

 

 

7 探針形状推定・探針影響除去 

 

 

本機能を用いることで、測定データのみから、探針形状を自動推定することができます。

また、測定データからその推定探針の影響を取り除いた画像を作成することができます。 

 

Clear 

Log View 

７ 探針形状推定・探針影響除去 

す 
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探針形状推定 

 

 

1.  “Image View”右クリック → コンテキストメニュー → [Tip Estimation] 

2.  ”Tip Nx”ダイアログ → 数値入力 → [OK] 

3.  ”Tip Ny”ダイアログ → 数値入力 → [OK] 

4.  ”Parameter”ダイアログ → 数値入力 → [OK] 

 

はじめに Image Viewに測定データを読み込み、コンテキストメニューから[Tip Estimation]

を選択します。次に Tip Nxと Tip Nyダイアログで、各々推定する探針の横と縦のサイズ（ピ

クセル単位）を指定します。最後に Parameter（[0.0,1.0]区間の実数）を指定します。この

指定によって、無数にある探針の解候補のうち、最大探針（Parameter=0.0）から、最小探

針（Parameter=1.0）まで推定することができます。推定された探針は、データファイルと

Image View 
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同じフォルダに tip_result.cubeというファイル名で自動保存されると同時に、新たな Image 

Viewが立ち上がり、その形状が描画されます。 

探針影響除去 
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1. “Image View”右クリック → コンテキストメニュー → [Eliminate Tip Effect] 

2. ”Select Tip”ダイアログ → ファイル名指定 → [OK] 

 

測定データが表示されている Image View 上のコンテキストメニューから[Eliminate Tip 

Effect]を選択します。次に探針を指定し、測定データから探針の影響を取り除いた画像デー

タを出力します。探針影響除去画像は、データファイルと同じフォルダに

image_eliminated_tip_effect.cube というファイル名で保存されると同時に、新たな Image 

Viewが立ち上がり、形状が描画されます。 

 

 

8 可視化設定 

 

 

描画法の変更 

 

【2D／3D表示切り替え】 

 

以下では２次元表示から３次元表示への切り替えについて説明します。 

８ 可視化設定 

す 
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1.“Image View”右クリック → コンテキストメニュー → [3D-View] 

 

 

【断面図の表示】 
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1. “Image View”上ダブルクリック → 始点決定 

2. “Image View”上ダブルクリック → 終点決定 

3. “Image View”右クリック → コンテキストメニュー → [3D-View] 

4. “Image View”右クリック → コンテキストメニュー → [Cross-Section] → [Clipping] 

 

 

 

始点と終点の指定は、２D表示にして行います。終点の指定が終了すると、自動的に Cross 

Section Viewが立ち上がり、断面図がグラフ表示されます。３D表示に切り替えてコンテキ

ストメニューから[Clipping]を選択することで、３D 画像を切り取ることができます。元に

戻すには、再度[Clipping]を選択します。また[Clear]を選択すると、始点終点位置などの切

断情報がクリアされます。 

 

【Z軸の反転】 
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1. “Image View”右クリック → コンテキストメニュー → [z-range Reverse]
 54

 

 

【Z軸の正規化】 

 

 

1. “Image View”右クリック → コンテキストメニュー → [z-range Normalize]
 55

 

 

                                                   
54  [z-range Reverse]はトグルボタンであり、繰り返しクリックすることで Z軸反転の有無を交互に切り替えられま

す。 
55  [z-range Normalize]はトグルボタンであり、繰り返しクリックすることで正規化の有無を交互に切り替えられま

す。 
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縦横サイズに比して高低差が非常に小さい場合、３D表示しても見た目は平面とほとんど変

わりません。そのような場合、Z軸を正規化することで、高低差を強調して表示することが

できます。 

 

【描画色の設定】 

 

1. “Image View”右クリック → コンテキストメニュー 

2. [Color] → [Monocrome / Gradation / Rainbow] 

 

以上の操作で、描画色の設定を変更することができます。 

 

【ライティング】 

Rainbow 

Monocrome 

Gradation 



 157 

 
 

1. “Image View”右クリック → コンテキストメニュー → [Lighting]
 56

 

 

この処理は、３D表示の場合のみ有効です。 

 

【等高線表示／非表示切り替え】 

 

                                                   
56  [Lighting]はトグルボタンであり、繰り返しクリックすることでライティングの有無を交互に切り替えられます。 
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1. ”Image View”右クリック → コンテキストメニュー → [Isoline]
57

 

 

【表示タイプの切り替え】 

 

1. “Image View”右クリック → コンテキストメニュー 

                                                   
57  [Isoline]はトグルボタンであり、繰り返しクリックすることで等高線の表示／非表示を交互に切り替えられま

す。 

Fill 

Wire Frame 
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2. [Display-Type] → [Fill / Wire Frame] 

 

この処理は、３D表示の場合のみ有効です。 

 

 

視点の変更・Zoom All・拡大縮小・遠近法表示 

 

以下の処理は、３D表示の場合のみ有効です。 

 

【視点の変更】 

 

1. ”Image View”右クリック → コンテキストメニュー 

2. [Top/Front/Side] 

 

この操作を行うことで、真上（Top）、正面（Front）、真横（Side）に視点が変更されます。

また、Image View 上をドラッグすることにより視角を自由に変更することもできます。

[Shift]+ドラッグすることにより、視点を平行移動させることができます。 

Front 

Top 

Side 
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【Zoom All】 

 

1. ”Image View”右クリック → コンテキストメニュー → [Zoom All] 

 

この操作によって、描画が”Image View”画面全体に収まるように、自動的に拡大縮小および

平行移動が行われます。 

 

【拡大縮小】 

1. マウスホイール→回転 

マウスホイールを回転させることで、任意の倍率にスケーリングすることができます。 

 

【遠近法表示】 
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1. ”Image View”右クリック → コンテキストメニュー → [Perspective]
58

 

                                                   
58

 [Perspective]はトグルボタンであり、この操作によって遠近法表示のオンオフを切り替えることができます。 
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9 デジタル画像処理機能 

 

Analyzerには、デジタル画像処理ツールとして、以下の四つの機能が用意されています。 

 閾値による画像の二値化機能 

 コントラスト調整(ガンマ補正)機能 

 エッジ抽出(Sobelフィルタ処理)機能 

 ノイズ除去(メディアンフィルタ処理)機能 

これら四つの機能は、一つの画像データに対して、複数の機能で処理できない仕組みにな

っています。これは、例えば、ある一つの Cube形式ファイルで与えられる画像データに対

して、エッジ抽出を行った後、コントラスト調整を行うことは出来ないことを意味します。

もし、ある一つの Cube形式画像データに対して、エッジ抽出、コントラスト調整といった

複数の処理を続けて行う場合は、いったんエッジ抽出を行った後で、その結果を Cube形式

ファイルとして保存し、そのファイルを開き直して、コントラスト調整を行う、という手

順を踏む必要が有ります。 

 

このように、上記の四つのデジタル処理機能が、単一の Cube形式ファイルに対して連続し

て行えないようになっているのは、以下の理由からです。一般に、上記 4 種類のデジタル

処理機能は、処理を行う順番によって、結果が異なります。例えば、ある Cube形式画像デ

ータに対して、エッジ抽出を行ってからコントラスト調整した場合と、逆にコントラスト

調整してからエッジ抽出を行った場合とでは、得られる画像は異なったものになります。

従って、ユーザーは、上記 4 種類の画像処理を行う場合、処理の順序や、処理で使用した

パラメータを、ノートなどに記録して残しておく必要が有ります。 

 

閾値による画像の二値化機能 

 

9 デジタル画像処理機能 

す 
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Cube 形式の画像データに対して、以下のよ

うにして、データの二値化、すなわち、白黒

画像への変換が行えます。 

画像が表示されているウィンドウ上を、マウ

スで右クリックすると、コンテキストメニュ

ーが現れます。メニューから、[Black and 

white]を選択すると、[Threshold]というウィ

ンドウが現れます。ここで、白黒二値化の閾

値を入力します。 

 

 

ここで、白黒二値化の閾値を 0.0から 1.0までの範囲

で入力します。なお、閾値はデフォルトで 0.5が設定

されています。[OK]ボタンを押すと二値化画像が得ら

れます。 

 

Cube形式の画像データには(x, y, z)の値が含まれ、そ

のうち zは高さ方向の値を意味します。オリジナル画

像全体に対する z 値の最小値を 0.0、平均値を 0.5、

最大値を1.0として、それらを繋ぐ折れ線を考えます。

それに基づいて全体の z 値を 0.0～1.0 に変換したと

き、指定した閾値より大きければ白、小さければ黒に、

それぞれ色を定めます。これが二値化という名前の由

来になります。 

 

 

hmin hmax have 

0.0 

0.5 

1.0 

Height 

Threshold 
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この図は、白黒画像変換前のオリジナル画像

データを表しています。(左図の画像データ

は、東京工業大学・大学院総合理工学研究科、

材料物理科学専攻、量子表面講座、平山博之

教授から提供して頂いたものです。) 

 

 

 

  

オリジナル画像に対して、閾値を 0.4として

白黒画像変換を施した結果です。 

オリジナル画像に対して、閾値を 0.6として

白黒画像変換を施した結果です。 
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コントラスト調整(ガンマ補正)機能 

 

Cube形式の画像データに対して、以下のようにしてコントラスト調整が行えます。画像が

表示されているウィンドウ上を、マウスで右クリックすると、コンテキストメニューが現

れます。メニューから、[Contrast adjustment (Gamma correction)]を選択すると、[Gamma]

というウィンドウが現れます。 

ここで、コントラスト調整パラメータγを 0.25から 4.0まで

の範囲で入力します。γはデフォルトで 1.0 が設定されてい

ます。[OK]ボタンを押すとコントラスト調整した画像が得ら

れます。 

 

 

  

この図は、コントラスト調整前のオリジナル

データを表しています。画像が全体的に明る

く、そのため、細かな高低差が分かりにくく

なっています。 (左図の画像データは、大阪

大学大学院基礎工学研究科、物質創成専攻、

機能物質化学領域、表面・界面機能化学講座、

福井賢一教授から提供して頂いたもので

す。) 

この図は、左のオリジナル画像に対して、γ

=0.33 でコントラスト変換を施したもので

す。対象物の細かな高低差の構造が良く分か

るように、画像が改善されています。 
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エッジ抽出(Sobelフィルタ処理)機能 

 

Cube形式の画像データに対して、以下のようにしてエッジ抽出が行えます。画像が表示さ

れているウィンドウ上を、マウスで右クリックすると、コンテキストメニューが現れます。

メニューから、[Edge detection (Sobel filter)]を選択します。すると、エッジ抽出が行われま

す。 

この図は、エッジ抽出前のオリジナル画像デ

ータを表しています。(左図の画像データは、

東京工業大学・大学院総合理工学研究科、材

料物理科学専攻、量子表面講座、平山博之教

授から提供して頂いたものです。) 

 

 

 

  

この図は、上のオリジナルデータ画像に対し

てエッジ抽出を行ったものです。画像が全体

的に暗くなってしまったので、コントラスト

調整することにします。それには、左の図の

画像データを、一度、Cube 形式で保存して

先ほど保存した Cube 形式ファイルを開い

て、γ=2.0 でコントラスト調整を施した図

です。エッジがより見易くなっています。 
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閉じます。 

 

 

ノイズ除去(メディアンフィルタ処理)機能  

 

Cube形式の画像データに対して、以下のようにしてノイズ除去を行うことができます。画

像が表示されているウィンドウ上を、マウスで右クリックすると、コンテキストメニュー

が現れます。メニューから、[Noise reduction (median filter)]を選択します。すると、ノイズ

除去が行われます。 

  

この図は、ノイズ除去前のオリジナルデー

タを表しています。緑の丸印で示した個所

に、小さなノイズが有ることが分かります。

(この画像データは、東北大学大学院理学研

究科物理学専攻、量子物性物理学講座、量

子伝導物性分野、橋本克之助教から提供し

て頂いたものです。) 

オリジナル画像データに対してノイズ除去

を行ったものです。緑の丸印で表された箇

所のノイズが取り除かれていることが分か

ります。 

 

 

10 3点で指定される角度の計測 

 

“Image View”上で表示されたデータ画像に対して、3つの点A, B, Cを指定して、線分AB, BC

の長さ、および、∠ABCの角度を測定することが出来ます。 

10 3点で指定される角度の計測 

す 
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(1) この図の、緑の楕円の枠で囲まれた菱形格

子の、辺の長さと角度を調べたいとします。 (左

図の画像データは、東京工業大学・大学院総合

理工学研究科、材料物理科学専攻、量子表面講

座、平山博之教授から提供して頂いたもので

す。) 

(2) まず、”View Image”上のデータ画像

の緑の楕円の枠で囲まれた部分を拡大

します。画像の上にカーソルを置いて、

マウスのホイールを使えば、画像を拡

大・縮小することができます。また、マ

ウスを左クリックして画像上でドラッ

グすれば、画像は移動します。これらの

操作により、データ画像の測定したい部

分を、ウィンドウ内で拡大表示します。 

 

 

 

(3) 次に、画像が表示されているウィンドウ上

を、マウスで右クリックすると、コンテキスト

(4) すると、左の図に示されるウィンド

ウが現れ、線分 AB, BCの長さ、および、
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メニューが現れます。メニューから、

[Measurement of lines and their angle]を選択し

ます。そして、マウスをダブルクリックするこ

とにより、データ画像上に三点 A, B, Cを指定

します。 

∠ABCの角度が表示されます。 

 

 

 

11 その他 

 

 

データ表示 

 

 

 

1. “Image View”右クリック → コンテキストメニュー → [Show Data]  

 

Data Viewを用いて、数値データを表形式で閲覧することができます。 

 

11 その他 

す 
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傾き自動補正 

 

 

1. “Image View”右クリック → コンテキストメニュー → [Correct tilt]  

 

Image Viewの整列・クローズ 

【タイル表示】 

 

1. “Menu Bar” → [Window] → [Tile] 

 

【カスケード表示】 
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1. “Menu Bar” → [Window] → [Cascade] 

 

【Imege Viewのクローズ】 

 

 

1. “Menu Bar” → [Window] → [Close All] 

 

この操作によって、全ての Image Viewが閉じられます。 
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第５章 

試料モデリング機能 
 

 

この章では、SPM シミュレータで用いる試料構造を作成するための補助ツールの使い方

をご紹介いたします。現在この補助ツールは、「１．薄膜モデリング」、「２．分子モデリン

グ」の大きく２つの機能に分かれております。 

両者ともにグラフィカル・ユーザー・インターフェイス（GUI）を備えており、ユーザー

が視覚的に試料構造データを作成することが可能となっております。 

 

 

1 薄膜モデリング 

 

 

はじめに 

SPM シミュレータには補助機能としてモデリングツールが同梱されます。このツールは

理想表面を持つ薄膜モデルを作成でき、そのデータをシミュレータに利用できる形式で出

力します。主にミクロスケール（DFTB・CG・MD）で使用される原子モデルを作成します

が、一部マクロスケールでも使用することができます。また、任意の原子の追加・削除・

移動の編集を行う事ができます。その他、モデルに別の分子モデルをインポートする機能

や、カーボンナノチューブやフラーレン構造をモデリングする機能も備えています。本節

はこのモデリングツールの使い方を紹介します。 

 

 

1 薄膜モデリング 
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画面説明 

 

 

 

画面ごとの主な機能を説明します。 

【Menu Bar】 

モデルの新規作成、読み込み、保存などのファイル操作、各画面の表示／非表示の切

り替えなどを行います。 

 

【Structure Controller】 

Menu Bar 

Tool Bar 

Structure Controller 

Main View 

Log View 

“Structure” Tab “Make CNT” Tab “New Slab” Tab 
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モデルの作成・編集を行います。次の 4つのタブから成ります。 “Welcome” タブは初

期画面です。 “New Slab” タブは薄膜モデルを作成します。 “Structure” タブは原子の

座標を表示し、また原子の編集も行います。 “Make CNT” タブはカーボンナノチュー

ブやその誘導体のモデルを作成します。 

 

【Main View】 

作成したモデルを 3Dで可視化します。マウスやキーボード操作によって視点を変更で

き、また原子の選択・移動などを行えます。 

 

【Log View】 

GUIからのメッセージを表示します。 

 

 

モデリングツールの起動 

 SPM シミュレータが正常にインストールされますと、デスクトップとスタートメニュー

にモデリングツールを起動するリンクが作られます。いずれかをダブルクリックするとモ

デリングツールが起動します。59
 

 

 

画面の基本操作 

本ツールでは “Main View” をマウスで操作することによってさまざまな動作が実行でき

ます。モデルを見る視点を変更したり、分子の表示の描画方法を変えたりもできます。こ

こではこのような “Main View” における操作方法を紹介します。 

 

【操作の前準備】 

以下の作業の前に、あらかじめモデルを開きます。例えば、 “Make CNT” タブをクリッ

クし、そのまま [Make CNT] ボタンをクリックして下さい。カーボンナノチューブモデル

が “Main View” に表示されます。 

 

【操作モード】 

“Main View”の操作方法として 5つのモードがあります； “View Mode”, “Edit Mode”, “Link 

Mode”, “Distance Mode”, “Angle Mode”。通常は主に視点の変更を扱う “View Mode” を利用

することになります。その他のモードについては順次説明します。これらのモードを切り

                                                   
59 インストールしたディレクトリ（デフォルトでは、"C:/Program Files/SPMSimulator"）

の中にあるmkatmstruct.exeがモデリングツールの本体です。 
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替えるには、ツールバーの対応するアイコンをクリックして下さい。これら 5 つのボタン

は排他的なトグルボタンであり、いずれか一つのみ選択できます。 

 

また、ショートカットキー [Ctrl+E] によりこれらのモードを順番に切り替えることもで

きます。 

 

【描画方法の設定】 

分子の描画方法を切り替えます。コンテキストメニューから “View Option” を選択し、 

“Auto”, “Dot”, “Ball”, “Ball&Stick”, “Cartoon” のいずれかを選択します。 “Auto” はモデルの

データから適切な描画法を自動判定します。なお、これらの表示はファイル形式によって

表示できないものがあります。 “Ball&Stick” は原子間結合情報が必要で、 “Cartoon” は

PDBファイルのみに対応しています。 

 

“Dot” 

 

“Ball” 

 

“Ball&Stick” 

 

“Cartoon” 

 

 

【視点の変更】 

コンテキストメニューから “Top”, “Front”, “Side” を選択すると視点が変更でき、それぞ

れ真上(Top)、正面(Front)、真横(Side)から見たモデルが描画されます。“Perspective” を選

択すると遠近感のある描画になります。マウスホイールを回転させると表示の拡大・縮小

ができます。 

“View Mode” のときは、“Main View” 上をマウスでドラッグすることにより、以下のよう

に視点を変更することができます。 

View Mode 

 

視点を回転する 
ドラッグ 

Link Mode 

Edit Mode 

View Mode Angle Mode 

Distance Mode 



 176 

 

視点を平行移動する 

 
拡大・縮小 

 

 

キーボード操作により視点を変えることもできます。 

キーボード操作 動作  

[上, 下, 左, 右] 視点の平行移動  

[Shift]＋[上, 下] 

[Shift]＋[左, 右] 

[Shift]＋[PageUp, PageDown] 

視点の回転 

（右図参照） 

 

[Ctrl]＋[上, 下] 

[PageUp], [PageDown] 

拡大・縮小  

 

【Zoom All】 

ツールバーにある虫眼鏡アイコンをクリックすると、現在の視点の向きをそのままに、

モデルの中心を眺めるように視点を平行移動させ、かつモデルが画面のほぼ全体に収まる

ように視点を拡大／縮小させることができます。 

 

キー＋ ドラッグ Shift 

ホイール回転   

キー＋ ドラッグ Ctrl 

Zoom All 
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ただし、モデルが 2原子以上から成り、Perspectiveがオフのときのみ有効です。 

 

【コンパス】 

視点を回転させたときに現在の視点がどのような向きになっているかを、3次元のコンパ

スによって表示できます。モデルを描画すると、下図のようにモデル描画画面の右下に 3

つの矢印と X, Y, Zの文字が表示されます。それらはモデルの 3次元座標軸 x, y, z軸の正の

向きを示しています。 

 

 

右クリックメニューから “Show Compass” をクリックすることで、コンパスの表示／非

表示を切り替えられます。 

 

【モデル範囲の表示】 

ツールバーにある直方体のアイコンをクリックすると、表示されているモデルの範囲を

表す平行六面体が表示されます。もう一度クリックすると非表示になります。 

Show compass 

Not show compass 

On 

Off 
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“New Slab”タブから結晶の情報を利用してモデルを作成した場合は、格子ベクトルを考慮に

入れた平行六面体の超格子が表示されます。一方、格子ベクトル情報を含まないモデルフ

ァイルを読み込んだ場合は、モデル中の原子すべてをぴったり含むような直方体が表示さ

れます。 

 

 

薄膜モデルの作成事例 

薄膜モデルを作成するために必要な情報は、作成し

たい物質の結晶データ（空間群・格子定数・既約原子

位置）、およびミラー指数とスーパーセルの単位胞数

です。これらの情報は、論文やウェブ上で公開されて

いるもの等から得ることができます。 

 

【シリコン（００１）表面の作成方法】 

 ここでは、シリコン(001)表面を摸した薄膜模型を

新規に作成する方法を説明します。新規で作成する場

合は、初期画面から [a new slab] ボタンをクリック

して “New Slab” タブを開きます。直接 “New Slab” 

タブをクリックしてもかまいません。このタブに結晶

データを入力します。まず入力部最上段の “Title” フ

ォームには、ご希望のタイトルを入力してください。ただし省略することが可能で、その

場合は指定した空間群の名称が自動的に代入されます。ここでは例として “Si001” としま

Without supercell information With supercell information 

Not show supercell Show supercell 
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す。全てのフォームへの入力は半角英数字の使用を推奨します。 

  二番目のフォームでは空間群の指定を行います。 [Spg. No.] のボタンをクリックする

と、 “Space group" という名前のポップアップウィンドウが立ち上がり空間群のリストが

表示されます。適切な空間群を選択してクリックしてください。あるいは空間群の番号を

直接タイプすることでも入力可能です。ここでは、シリコンの面心立方構造を想定してい

ますので、227とタイプします。OKをクリックすると本ウィンドウは閉じ、空間群の入力

が完了します。 

 三番目のフォームでは、格子定数を入力します。それぞれÅと度の単位で直接タイプし

て入力してください。シリコンの場合は、5.4, 5.4, 5.4, 90.0, 90.0, 90.0 となりますが、対

称性から格子定数 aのみを入力するように制限がかかります。 

 次にブラベー格子内の原子種とその既約な座標を入力します。まず原子種を指定します。 

[Spec] ボタンをクリックすると次のような “PeriodicTable” ダイアログが立ち上がります。 

 

元素の周期律表の順番にボタンが並んでいます。適切な原子種、ここでは原子番号 14 の

Si をクリックしてください60。ダイアログが閉じ、原子名フォームに元素記号 Si が入力さ

れます。続いて既約座標、ここでは(0.0, 0.0, 0.0)を入力し、その右の [Add] ボタンを押し

てリストに追加します。シリコンの場合はこれで完了ですが、物質によっては以下、必要

な情報の量だけ同じ作業を繰り返します。入力に失敗した場合、その行を指定し、 [Modify] 

で訂正、 [Delete] で削除することができます。また [Clear all] でリストの全ての情報を削

除することができます。 

 以上で、結晶としての情報を入力することができました。薄膜モデルを作成するために

は、さらに、表面に現れる面の情報と薄膜のサイズの入力が必要となります。表面に現れ

る面の指定はミラー指数によって行われます。ご希望の面を表すミラー指数を “Miller 

index” フォームにタイプして下さい。隣の “Number of cells” フォームでは、薄膜モデルの

サイズの指定を行います。それぞれ x, y, z方向へ指定した数だけ結晶情報から得られる単

位胞を並べてスーパーセルを作成します。ここでは、Si(001)表面ですので、ミラー指数に

                                                   
60 原子番号を直接入力して Okボタンを押すことでも、原子を選択できます。 
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は 0, 0, 1を入力します。スーパーセルのサイズは、1から 3のあたりで入力されると、DFTB

の計算コストに似合うモデルが作成できます。ここでは、例として 3, 3, 1と入力します（下

左図）。 

 最後に [Make Surface] ボタンをクリックしてください。正常に処理されますと、 “Main 

View” にシリコン表面を表す薄膜モデルの原子構造が表示されます。また “Log View” には、

この薄膜モデルにおける並進ベクトルが表示されます（下右図）。ここで表示される並進ベ

クトルは、結晶模型についての並進ベクトルであり、薄膜モデルのものではありません。

詳細は後述の「SPMシミュレータでの利用に関する注意点」を参照してください。 

 原子模型が表示されると、 “Structure Controller” は “Structure” タブをハイライトします。

ここには、表示中のモデルに含まれるすべての原子について、原子種や座標などの情報や

組成式が示されます。このタブを操作して、個々の原子を編集することができます。詳細

は後述の「個々の原子座標の編集」を参照してください。作成したモデルを保存するには

後述の「モデルの保存」を参照してください。 

 

 

【シリコン（１１１）表面の作成方法】 

 シリコン(111)の薄膜モデルを作成する方法を説明します。先ほどと同じシリコンですの

で、結晶を表す情報はすべて同じです。同様の作業を繰り返して下さい。ただし “Title” を 

“Si111” とします。結晶の情報の入力が終了したら、次にミラー指数を変更します。 “Miller 

index” フォームに 1, 1, 1を直接入力します。最後に [Make Surface] ボタンをクリックし

ます。 “Main View” で最終確認をします。また、 “Log View” にこの結晶モデルにおける

並進ベクトルが表示されますので、必要に応じて確認します。 

 

【グラファイト（０００１）表面の作成方法】 
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 グラファイトの結晶の情報は、以下の通りです。 

 

格子定数 2.464  2.464  6.711  90.0  90.0  120.0 

空間群 194 (P 63/m m c) 

既約原子座標 C1  0.00000  0.00000  0.25000 

C2  0.33333  0.66667  0.25000 

 

 ここでひとつ注意点ですが、二つ目の炭素の正確な既約原子座標は、ｘ座標が 1/3でｙ座

標が 2/3です。1/3のように少数で正確に表せない場合は、少数点以下第 4位の範囲内で原

子の同一性を判断しています。そのため入力値として少数点以下第 5 位まで入力する必要

があります。 

 次にミラー指数について述べます。ミラー指数の表示は、六方晶・三方晶の場合、3つで

はなく 4 つの整数によって表されることが多いのですが、後者の場合独立な数字は 3 つで

すので、ここでは 3つの整数によって指定して頂くようにしています。(0001)表面の場合は、

(001)を入力してください。基本的には、3 番目の数字が省略されています。あとはシリコ

ンと同様に処理してください。 

 

 

モデルの保存 

【データファイルとして保存】 

表示されているモデルをデータとして保存することができます。メニューバーの “File”

から “Save as” を選択し、続いて “in XYZ format” (DFTB形式)、 “in Tinker format” (CG/MD

形式)、または “in Modeling Project” を選択してください。ファイル保存ダイアログが現れ

ますので、適切なファイル名を入力して保存してください。 
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“in Tinker format” として保存する前に必ず原子種 ID を決めて下さい（後述）。原子種 ID

は SPMシミュレータで CG/MDソルバーを利用する場合に必要となります。 

“in Modeling Project” として保存するためには、 “New Slab” タブに内容を適切に入力し

ている必要がありますのでご注意ください。 

 

【画像ファイルとして保存】 

“Main View” に表示されている画面を画像として保存することができます。メニューバ

ーの “File” から “Export Image” を選択すると “Save Capture” ダイアログが現れます。任

意のファイル名を入力し、ファイルの種類を PNG (*.png), Bitmap (*.bmp), JPEG (*.jpg)か

ら選んで保存します。 

“Main View” を右クリックし、コンテキストメニューから “Export Image” を選択しても

同じ操作が行えます。 

 

 

既存モデルの読み込み 

 既存のデータを読み込んで画面に表示することができます。メニューバーの “File” から 

“Open” を選択し、 “Open File” ダイアログを開きます。 
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読み込むことのできるファイル形式は xyz (*.xyz), tinker (*.txyz), PDB (*.pdb), Modeling 

project (*.mpro), CIF (*.cif)です。ダイアログから読み込みたいファイルを選択してください。

ファイルのアイコンをモデリングツールへドラッグ&ドロップすることでも、既存のデータ

を読み込むことができます。 

 

ファイル形式のうち xyz, txyz, pdbファイルには原子種や原子のデカルト座標などが与え

られており、これらのファイルを読み込むと “Strucuture” タブにモデルの座標などのデー

タが表示され、 “Main View” にモデルが 3Dで可視化されます。txyz, pdbファイルに含ま

れる原子間結合の情報も反映されます。 

一方、mpro や cif ファイルには結晶構造の情報（格子定数や既約原子サイトの情報）が

含まれており、これらのファイルを読み込むと “New Slab” タブに結晶構造の情報が自動的

に入力されます。【薄膜モデルの作成事例】では結晶構造の情報を手作業で入力しましたが、

その作業を自動的に行うことができます（下図参照）。 
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CIFの場合、一つのファイルに複数の結晶構造情報が含まれる場合があります。そのよう

な場合、CIFを開いたときに次のようなダイアログが表示され、どのデータブロックを利用

するかを選択することができます。 

 

 

 

最近使用したファイルを開くこともできます。メニューバーの “File” から “Recent Files”
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を選択し、表示される一覧から開きたいファイルを指定します。最近の 10 件までが履歴

に残ります。 

 

 

既存モデルのインポート 

表示中のモデルに対し、新たに既存のデータを取り込み、それらを同時に表示させるこ

とができます。まずあらかじめ原子構造を作成または読み込んでおきます。次にメニュー

バーの “File” から “Import” を選択します。ファイル選択ダイアログから取り込みたいファ

イルを選択します。これにより新たにデータが取り込まれ、先に表示されていたモデルと

同時に表示されます。 

読み込んだ原子モデルは、すでに表示されていたモデルに対して z 軸正の方向に配置さ

れ、お互いに重ならないような距離が空けられます。インポートできるファイルの形式は

xyz (*.xyz), tinker (*.txyz)に限られます。 

なお、ファイルのアイコンをモデリングツールへ、[Ctrl]キーを押しながらドラッグ&ドロ

ップすることでも、既存のデータをインポートすることができます。 

 

モデリングツールの終了 

 メニューバーの “File” から “Quit” を選択するか、タイトルバーの右にある×ボタンをク

リックすると、モデリングツールが終了します。 

 

その際、編集中のモデルデータが保存されていない場合は、保存を促すメッセージが表示

されます。 

 

[Save] をクリックするとモデルデータを保存するダイアログが開き、保存が完了した後で
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ツールが終了します。[Discard] をクリックすると、現在のモデルデータを破棄してツール

が終了します。[Cancel] をクリックするとツールは続行します。 

キーボードの [Shift] キーを押しながらモデリングツールの終了操作を行うと、モデルの

保存を行わずに強制終了することができます。 

 

 

モデルの編集 

“Structure” タブを利用すると、作成したモデルに

対して原子を追加、編集、あるいは削除することが

できます。編集が終了し画面での確認がとれました

ら、ファイルへ保存してください。 

 

【原子を追加】 

原子を追加したい場合は [Duplex ボタンを使い

ます。まず座標の基準となる原子をリストの列から

選択します61。次に原子を追加したい座標を、基準

原子からの相対座標で入力します。そして [Duplex] 

ボタンをクリックすると新しい原子が描画されま

す。デフォルトでは同じ原子種が追加されますが、 

[Spec] ボタンを押して別の原子種を選んで追加することもできます。 

 なお、原子が全く存在しないときに [Duplex] ボタンを押した場合、入力した x, y, z値が

絶対座標として扱われ、指定した種類の原子が一つだけ配置されます。 

 

【原子を編集】 

 原子を編集したい場合は [Change] ボタンを使います。まず編集したい原子をリストの

列から選択します。相対座標を入力して [Change] ボタンをクリックすると選択した原子

が移動します。移動先に原子が存在するときは変更できません。あるいは原子選択後に 

[Spec] ボタンを押して原子種を選択し、 [Change] ボタンをクリックすると原子種が変更

されます。 

 

【原子を削除】 

原子を削除したい場合は [Delete] ボタンを使います。削除したい原子をリストの列から

選択します。そこで [Delete] ボタンをクリックすると選択した原子が削除されます。キー

                                                   
61 リストの列を Ctrl+クリックすると複数選択できます。リストの列を Shift+クリックするとリ

スト内を範囲選択できます。Ctrl+Aキーを押すとすべての原子を選択できます。 “Main View” 

から選択することもできます（後述）。 
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ボードの [Delete] キーでも同じように削除できます。 

 

 

【原子の選択／非選択】 

原子を編集したいときに “Structure” タブのリストから原子を選択する方法をすでに紹

介しましたが、マウスを使って選択することもできます。“Main View” 画面のモデルを見な

がら選択したい原子をマウスで直接指定できます。 “View Mode” と “Edit Mode” のそれぞ

れについて、以下のような原子選択機能があります。 

 

View Mode 

空白（原子や結合が何もないところ）をクリック すべての原子が非選択になる。 

原子をダブルクリック 選択／非選択が反転する。 

 

Edit Mode 

空白（原子や結合が何もないところ）をクリック すべての原子が非選択になる。 

原子をクリック 選択／非選択が反転する。 

空白を始点としてドラッグ 範囲内にあるすべての原子が追加

的に選択される。 

空白を始点として Shift+ドラッグ 範囲内にあるすべての原子が非選

択になる。 

空白を始点として Ctrl+ドラッグ 範囲内にあるすべての原子の選

択・非選択が反転する。 

 

このようにして一つあるいは複数の原子を選択状態にすると、“Structure” タブのリスト

中の対応する項目もまた選択された状態になります。すると先に述べた方法で編集や削除

などを行うことができます。 
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【原子の移動・回転】 

“Edit Mode” で一つまたは複数の原子が選択されているとき、マウスのドラッグ操作に

より原子の移動や回転を行うことができます。“Structure” タブのリスト中の原子座標はリ

アルタイムで更新されます。 

 

Edit Mode、原子選択時 

選択した原子群を始点としてドラッグ マウスの動きに応じてその原子群

が平行移動する。 

選択した原子群を始点として Shift + ドラッグ マウスの動きに応じてその原子群

が一まとまりとなって回転する。 

 

 

結合情報の編集 

“Structure” タブでは原子間の結合を生成したり、水素原子を付加したり、結合の種類を

特定したりもできます。 

 

【結合の生成】 

“Bond” ボタンをクリックすると原子間結合情報が更新されます。 “View Option” として 

“Ball&Stick” を選択するとこの結合が可視化できます。原子数が多いときは計算に時間がか

かるのでご注意ください。また、“Link Mode” を利用すると原子間結合を自由に編集できま

す（後述）。 
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【結合の消去】 

[Bond clear] ボタンをクリックすると原子間結合情報が破棄されます。原子数が多いと

きに結合情報を保ったまま編集作業をすると、処理に時間がかかることがあります。その

ような場合に一時的に結合情報を破棄すると良いでしょう。編集作業が終わったら “Bond” 

ボタンを利用して結合情報を更新してください。 

 

【水素付加】 

[Hydrogenate] ボタンをクリックすると、結合数の不完全な原子に水素原子を付加し結

合数を正常に保ちます。 

 

【原子種 IDの決定】 

[Bond/MM3] ボタンをクリックすると、原子ごとの原子種 IDを自動的に決定します。こ

れは SPMシミュレータで CG/MDソルバーを利用する場合に必要となります。使用例の手

順としては、(1) xyz形式のファイルをモデリングツールで読み込む。(2) 原子種 IDを決定

する。(3) Tinker 形式で保存する。(4) それを CG/MD ソルバーの計算に利用する、という

方法があります。 

 

 

Link Mode 

 “Link Mode” を利用すると原子間結合を自由に編集できます。ツールバーの“Link Mode”

アイコン  をクリックして“Link Mode”に切り替えられます。 

原子 Aと原子 Bの間に結合を作りたい場合、まず原子 Aを画面上でクリックし、続いて

原子 Bをクリックします。二つの原子のどちらを先にクリックしても構いません。引き続

き原子を順番にクリックすることで、結合を連続して生成することができます。 
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結合の生成を中止するためには、画面上の原子以外の空白領域をクリックします。それに

より原子の選択状態が解除されます。 

 

逆に原子 Aと原子 Bの間の結合を消去したい場合、まず原子 Aを画面上でクリックし、

続いてキーボードの[Shift]キーを押しながら原子 Bをクリックします。二つの原子のどち

らを先にクリックしても構いません。引き続き[Shift]キーを押しながら原子を順番にクリッ

クすることで、結合を連続して消去することができます。 

 

また、Viewモードと同じように、マウスのドラッグ操作によって視点の操作（回転、移

動、ズーム）ができます。 

 

 

Distance Mode 

“Distance Mode” を利用すると原子間距離を測ることができます。ツールバーの 

“Distance Mode” アイコン  をクリックして “Distance Mode” に切り替えられます。 

Shift key pressed Shift key pressed 
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原子 Aと原子 Bの距離を測る場合、まず原子 Aを画面上でクリックし、続いて原子 Bを

クリックします。二つの原子のどちらを先にクリックしても構いません。選択した二つの

原子間に点線が引かれ、計算した距離は出力ログに表示されます。 

 

距離の測定を中止するためには、画面上の原子以外の空白領域をクリックします。それに

より原子の選択状態が解除されます。 

また、Viewモードと同じように、マウスのドラッグ操作によって視点の操作（回転、移

動、ズーム）ができます。 

 

 

Angle Mode 

“Angle Mode” を利用すると 3つの原子が成す結合角を測ることができます。ツールバー

の “Angle Mode” アイコン  をクリックして “Angle Mode” に切り替えられます。 

原子 A、B、Cが成す角度∠ABCを測る場合、画面上で原子 A、原子 B、原子 Cの順番に

クリックします。A-B-Cを結ぶ点線および円弧が引かれ、計算した角度は出力ログに表示さ

れます。 

A 

B 

Distance Mode 
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角度の測定を中止するためには、画面上の原子以外の空白領域をクリックします。それに

より原子の選択状態が解除されます。 

また、Viewモードと同じように、マウスのドラッグ操作によって視点の操作（回転、移

動、ズーム）ができます。 

 

 

編集操作の undo, redo 

様々な編集操作を元に戻したり(undo)、逆にやり直したり(redo)することができます。

Undoは編集操作を行う前のモデルのデータ（原子の数、原子種、原子座標、結合情報、編

集状態）を復元します。これらの機能は、メニューバーから操作することもできますし、

また便利なショートカットキーも割り当てられています。 

機能 メニューによる操作 キーボードショートカット 

元に戻す(undo) メニューバー “Edit”  “undo” Ctrl+Z 

やり直す(redo) メニューバー “Edit”  “redo” Ctrl+Y 

Undoを実行すると redoが使えるようになります。 

 

undo, redo可能な編集操作の一覧を示します。 

1 現在のモデルに別のモデルをインポートしたとき。 

A 

B C 

Angle Mode 
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2 [Duplex] 操作で原子を複製したとき。 

3 [Delete] 操作で原子を削除したとき。 

4 [Change] 操作で原子を編集したとき。 

5 [Bond] 操作で結合情報を生成したとき。 

6 [Bond clear] 操作で結合情報を破棄したとき。 

7 [Hydrogenate] 操作で水素原子の付加を行ったとき。 

8 [Bond/MM3] 操作で原子種 IDを決定したとき。 

9 Editモード時にマウス操作で原子を移動／回転したとき。 

10 “New Slab” タブから [Make Surface] ボタンによりモデルを作成したとき。 

11 “Make CNT” タブから [Make CNT] ボタンによりモデルを作成したとき。 

12 [File][Open] により、編集中のモデルを破棄し、既存のモデルを読み込んだとき。 

13 [File][Import] により、編集中のモデルに既存のモデルを追加したとき。 

14 [File][Recent Files] から最近開いたファイルを読み込んだとき。 

元に戻せる編集操作の履歴は最大で 30件です。 

 

また、次の操作を行ったときに undo, redoの履歴がクリアされます。 

1 GUIを起動したとき。 

2 “File”  “New” を選択したとき。 

3 GUIを終了するとき。 

 

次のタイミングでクリーンインデックスが設定されます。 

1 “File”  “Open” により、編集中のモデルを破棄し、既存のモデルを読み込んだとき。 

2 “File”  “Recent Files” から最近開いたファイルを読み込んだとき。 

3 “File”  “Save as”  “in XYZ Format” により、モデルを XYZ形式で保存したとき。 

4 “File”  “Save as”  “in Tinker Format” により、モデルをTXYZ形式で保存したとき。 

5 “New Slab” タブから [Make Surface] ボタンによりモデルを作成したとき。 

6 “Make CNT” タブから [Make CNT] ボタンによりモデルを作成したとき。 

いずれの場合も、保存済みのファイルを開いたときやモデルをファイルに保存したとき

にクリーンインデックスが設定されます。 

表示中のモデルを編集するとタイトルバーに表示されるファイル名にアスタリスク [*] 

が付き、これは現在のモデルが非保存状態であることを意味します。このときに GUI を終

了しようとすると、データの保存を促すメッセージが表示されます。 

一方、データを保存するなどしてクリーンインデックスが設定されると、タイトルバー

のファイル名からアスタリスクが消えます。このときは、GUI を終了する際にモデルデー

タの保存を促すメッセージが表示されません。 
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ツールバー 

 画面上部にツールバーがあります。ツールバーに用意されたアイコンをクリックするこ

とで、GUI に搭載されているいろいろな機能を利用できます。利用できる機能は次の通り

です。 

 

 

 機能 別の操作方法 

① モデルの新規作成開始。スタートメニューに戻り、すべ

ての設定をリセットする。 

“File”  “New” 

② モデルの読み込み。既存のモデルを新しく開く。 “File”  “Open” 

③ モデルを保存。 “File”  “Save as” 

④ “Main View” を画像ファイルとして保存。 “File”  “Export Image” 

⑤ 元に戻す (undo)。 “Edit”  “undo” 

⑥ やり直す (redo)。 “Edit”  “redo” 

⑦ “View Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑧ “Edit Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑨ “Link Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑩ “Distance Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑪ “Angle Mode”に切り替える。トグル可能。 [Ctrl+E] 

⑫ 現在の視点を保ったまま、モデルサイズを画面にフィッ

トさせる (Zoom All)。 

 

⑬ コンパスの表示／非表示を切り替える。トグル可能。 “Main View” を右クリッ

ク “Show Compass” 

⑭ 分子の描画方法を切り替える。 “Main View” を右クリッ

ク “View Option” 

⑮ モデル範囲の表示／非表示を切り替える。トグル可能。  

 

 

カーボンナノチューブ作成 

カーボンナノチューブ(CNT)モデル作成プログラムを呼び出し、カーボンナノチューブ

やその誘導体を作成して画面に表示できます。 

 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 
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【操作手順】 

1. “Make CNT” タブを開く。 

2. オプションを設定する。 

3. [Make CNT] ボタンを押す。 

4. 出力結果が “Structure” タブや “Main View” に表示される。 

 

 

【CNTモデル作成プログラムの引数】 

<mode>: type of CNT: 

CNTの種類を次の 4つから選択します。 

1. swcnt: シングルウォールカーボンナノチューブ 

2. sheet: グラフェンシート 

3. fuller: フラーレン族 

4. capped: キャップ付き CNT 

 

<Chx>, <Chy>: x, y-component of chiral vector: 

CNTのカイラル指数(n,m) = (<Chx>, <Chy>)を指定します。 

これは CNTの巻き方や大きさを表します。 

n, mは整数で、0≦|m|≦nとします。 

“sheet”, “fuller”, “capped”の場合、n, mは 5の倍数のみ利用できます。 

 

<Ncell>: number of unit cell: 

CNTの単位胞の数です。 

カイラルベクトルで生成される CNTを１として、これをいくつ並べるか指定しま

す。 

 

[output file]: output file name:（編集不可） 

出力ファイル名。指定がない場合は標準出力。 

1 

3 

4 2 
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【実行例】 

<mode>  = swcnt 

<Chx>   = 10 

<Chy>   = 5 

<Ncell> = 2 

<mode>  = sheet 

<Chx>   = 20 

<Chy>   = 20 

<Ncell> = 1 

<mode>  = fuller 

<Chx>   = 5 

<Chy>   = 5 

<Ncell> = 1 

<mode>  = capped 

<Chx>   = 5 

<Chy>   = 5 

<Ncell> = 5 

    

 

 

グラフェンシート作成 

単層のグラフェンシートを作成できます。 

 

【操作手順】 

1. “Make CNT” タブを開く。 

2. グラフェンシート作成用のオプションを設定する。 

3. [Make Graphene] ボタンを押す。 

4. 出力結果が “Structure” タブや “Main View” に表示される。 

 

 

 

【グラフェンシート作成用のオプション】 

C-C nearest distance [ang]:（編集不可） 

1 

3 4 2 
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C-C原子間の最隣接距離。1.412 Åに固定されている。 

 

x-length of graphene [ang]: 

グラフェンシートの横幅。デフォルトは 20 Å。 

 

y-length of graphene [ang]: 

グラフェンシートの縦幅。デフォルトは 20 Å。 

 

入力する値に応じて任意のサイズのグラフェンシートを作成できます。 

 

必要に応じて水素原子の付加 [Hydrogenate] や原子種 ID の決定 [Bond/MM3] を実行し、

モデルを保存して下さい。 

 

 

SPMシミュレータでの利用に関する注意点 

 モデリングツールで出力する原子構造ファイルは、SPMシミュレータの DFTBソルバー

および、CG/MDソルバーで使用することができます（マクロ系ソルバーでは、原子構造の

データの中から高さ情報のみを抽出して利用します）。 保存したファイルは、直接 SPM

シミュレータでロードすることができます。ただし以下の点についてご注意ください。 

 各原子は、時として非常に接近した位置に生成される場合があります。このような原

子構造ファイルを SPMシミュレータで使用するとエラーを返すか、あるいは正常なシ

ミュレーション結果が得られません。適当な原子をクリックしてハイライトしたとき、

通常ですとその原子は、原子球の全体が黄色に変化します。しかし、ハイライトされ

た原子の一部しか変化しない場合、接近した位置に原子が生成された恐れがあります。

その場合は、結晶データの相対原子位置などに誤りがないか確認をしてください。 

 “Log View” に出力される並進ベクトルは、結晶データから生成されるもので、薄膜モ

デルのものではありません。薄膜モデルに利用する場合は、並進ベクトルの z 成分を

無視してください。SPMシミュレータで利用するときは、ｚ成分を 100.0などの大き

20 x 20 Å 12 x 30 Å 50 x 18 Å 
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い数字を入力することを推奨します。将来的には、並進ベクトルの情報は、原子構造

ファイルを通して SPMシミュレータへ自動的に渡されるよう変更する計画です。 

 CG/MD用の出力ファイルには、電子状態を摸した原子種情報が含まれています。たと

えば、同じ炭素原子でも sp3状態なのか、sp2状態なのかを区別する必要があります。

モデリングツールでは、シリコン・炭素・水素に限り、これを自動的に処理します。

ただし、原子の削除や追加に伴う変更は、現バージョンでは考慮しておりません。こ

の場合、お手数ですが、テキストエディタを用いて “mm3.prm” 中から適切な値（正数

値ひとつで表されています）を出力ファイル中の適切な位置へ記載して下さい。 

 探針用のモデルを作成するときは、結晶単位胞の角を利用すると簡単に作成できます。

その場合、表面を全て水素原子で終端することで、安定な探針構造になります。ただ

し探針先端部の水素原子については適宜削除してください。 

 CIFファイルを読み込む際の注意事項。 

CIFに記載される原子サイトの占有率 occupancyについて、以下のことにご注意く

ださい。モデリングツールで結晶構造情報から作成したモデルにおいては、すべての

原子の占有率は 1.0（指定のサイトに原子が必ず存在する）として扱われます。CIFフ

ァイルによっては、特定の原子サイトに欠陥があるなどの場合に 1.0未満の占有率が与

えられることがありますが、その場合は CIFの読み込み時に出力ログへ注意を促すメ

ッセージが表示されます。 

<<< Load a file "C:\sample\sample.cif" >>> 
Now loading ...  
Warning: incomplete occupancy 0.3333 for Ow at 0.736 0.368 0.491 
Completed to load. 

このとき、 “New Slab” タブの原子サイト情報は次のように表示されます。 

 

出力ログには原子サイトの fractional座標も示しており、この場合はリストの下から

2番目の O原子のサイトが占有率 0.3333であることがわかります。[Make Surface]ボ

タンを押し、読み込んだ情報に基づいて原子モデルを作成すると、下図のように不自

然なモデルが描画されます。 
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黄色の円で囲んだ部分を見ると、3つの酸素原子が非常に近接した位置に存在しま

す。占有率 0.3333を踏まえると、その 3つの酸素原子のうちいずれか一つの位置に酸

素原子が存在することが示唆されます。例えば多数のユニットセルを用意したときに、

3つの位置のいずれかがランダムに現れるということが考えられます。 

モデリングツールでは、1.0 未満の占有率を正しく考慮したモデルを作成すること

はできません。占有率について警告が与えられた場合、作成されたモデルには何らか

の問題があることに注意してください。 

 

本ツールは開発途上のものです。仕様の変更は極力避けるよう努めますが、やむを得ず変

更される可能性があります。予めご理解ご了承ください。 
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2 分子モデリング 

 

はじめに 

 

ここでは、SPM シミュレータの初期構造を作成するためのツールとして、フリーソフト

ChemSketchと OpenBabelの使用方法を紹介いたします。このツールで作成した初期構造

データは、原子・分子・ナノ材料 AFMシミュレータで利用可能です。 

原子・分子・ナノ材料 AFMシミュレータでは、AFM像のシミュレーションを行うために、

Allingerによって開発された MM3という古典力場パラメータを用いています。MM3が対応

している元素を下図に示します。 

 

 

 

パラメータは元素だけではなく、その元素がどのような化学的な環境にあるかによっても

区別して設定され、その区別のことを原子種(atom type)といいます(例えば、炭素元素に対

して、アルキル基の炭素とベンゼン環の炭素とは区別されるため、異なる原子種です)。つ

まり、原子種、およびそれらの組み合わせによって、vdW 相互作用や二原子間の共有結合

の相互作用等のパラメータが設定されることになります。考えうる原子種の組み合わせは

非常に多いため、分子構造によってはパラメータが用意されておらず、その場合は分子内

の構造変化の計算を行うことができません。 

ChemSketch のダウンロード 

 

MM3 力場対応元素 

２ 分子モデリング 
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ACD/ChemSketch は Advanced Chemistry Development社の提供するフリーソフトです。

こちらのソフトウェアのダウンロードにはユーザー登録が必要であり、また、ライセンス

条項に同意の上でインストールを行っていただく必要があります。以下に、

ACD/ChemSketchのダウンロードを行う流れの一例をご紹介いたします。 

 

①URL: http://www.acdlabs.com/resources/freeware/chemsketch/ 

の ACD/ChemSketchのダウンロードページを表示します。 

②ページの下部にあるダウンロードのアイコンをクリックします。 

③ログインページが表示されるので、Create an Account をクリックします。 

④下図が表示されるので*の印がついている項目を入力し、Registerをクリックします。 

 

 

 

 

性別 

下の名前 苗字 

確認のため同じ E-Mail 

アドレスを再度入力 

確認のため同じ 

パスワードを再度入力 

郵便番号 

会社名 

国籍 

http://www.acdlabs.com/resources/freeware/chemsketch/
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⑤記入した E-Mailアドレス宛に、メールが届いたら 

Before you can login you need to activate your account: 

To automatically activate your account, click here 

とメール本文に記載されているので、青く反転した hereをクリックします。 

これでアカウントの作成は終了です。 

⑥再度 URL: http://www.acdlabs.com/resources/freeware/chemsketch/ 

の webページを表示します。 

⑦ページの下のほうにあるダウンロードのアイコンをクリックします。 

⑧ログインページが表示されるので、手順④で入力した E-Mail アドレスとパスワードを入

力し Loginアイコンをクリックします。 

⑨下図が表示されたら実行をクリックします。 

 

 

 

⑩Next > をクリック 

http://www.acdlabs.com/account/activateaccount.php?email=s_takagi@aas-ri.co.jp&code=0e74c0e25a005ea1573786d38fd05896
http://www.acdlabs.com/account/activateaccount.php?email=s_takagi@aas-ri.co.jp&code=0e74c0e25a005ea1573786d38fd05896
http://www.acdlabs.com/resources/freeware/chemsketch/
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⑪ライセンス条項を確認したうえで、 I accept the terms in the License Agreement を選択

し、Next >をクリック。 
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⑫Next >をクリック。 

 

⑬Next >をクリック。 
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⑭Next >をクリック。 

 

⑮Installをクリック。 
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⑯Finishをクリック。 

 

 

⑰ChemSketchをクリック。 
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⑱OKをクリック。 

 

 

⑲Select All をクリックし、Yesをクリック。 

 

⑳OKをクリック。 
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以上でダウンロードと初期設定は終了です。 

 

 

OpenBabel のダウンロード 

 

OpenBabelは GPLライセンスのもとで配布されているフリーソフトであり、化学情報のフ

ァイル形式の変換に用いられます。使用には、こちらのソフトウェアのライセンス条項に

同意の上でインストールを行っていただく必要があります。以下に、OpenBabel のダウン

ロードを行う流れの一例をご紹介いたします。 

 

① URL:http://openbabel.org/wiki/Main_Page  

の web ページを表示します。 

② Download をクリック。 

 

 

③ Windows版の Download v2.3.2 Installer をクリック。 

http://openbabel.org/wiki/Main_Page
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④ 実行をクリック。 

 

 

⑤ 実行するをクリック。 
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⑥ Next >をクリック。 

 

 

⑦ ライセンス条項を確認したうえで、I Agree をクリック。 
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⑧ Next > をクリック。 

 

 

⑨ Install をクリック。 
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⑩ Finish をクリック。 

 

 

以上でダウンロードは終了です。 

 

 

ChemSketchを用いたオクタン分子の作成 

 

炭素数８のアルカンである、オクタン(分子式 C8H18)を作成します。 

 

1. “ChemSketch” を起動します。 

2. 炭素鎖を作成します。 

① “Structure” を選択します。 

② 左のツールから C(炭素原子)を選択します。 

③ 上のツールから “Draw Normal” を選択します。 

 

④ 空白の画面をクリックすると、炭素原子 1 つから成る CH4が生成します。以下の

1 

3 

2 
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作業で操作を戻したい場合は、Ctrl+Z (undo)および Ctrl+Y (redo)を使うと便利です。 

 

⑤ CH4にカーソルを合わせてクリックすると、H原子の一つが CH3に置換され、エ

タン分子になります。 

 

⑥ 以下、片方の端の CH3にカーソルを合わせてクリック、を炭素数が 8になるまで

繰り返します。 

 

⑦ これでオクタン分子の骨格が完成しました。 

 

3. 3次元最適化。”3D Optimization”ボタンをクリックすると、水素原子が付加されて三次

元構造になります。 

 

4. モデルの保存。 

① メニューバーから[File][Save As]を選択し、データを保存するためのダイアログ

を開きます。 

② ファイルの種類を “MDL Molfiles [V2000] (*.mol)” に設定し、ファイル名を入力し

て保存します。 

  

・・・ 
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③ 保存したファイルはフリーソフト OpenBabel を利用して*.txyz 形式に変換できま

す。（後述） 

 

もっと簡単な方法もあります。上部のツールから “Draw Chains” アイコンをクリックし

ます。画面上で Shiftキーを押しながら、任意の点から右へドラッグします。炭素の数が “C 

8” のように表示されたらマウスボタンをリリースします。以上でオクタン分子が出来上が

ります。 

 

 

ChemSketchを用いたキニーネ分子の作成 

分子式 C20H24N2O2のアルカロイドである、(-)-キニーネを作成します。次のような構造を

持つ分子であり、これを一から作り上げます。 

 

1. “ChemSketch” を起動します。 

2. 分子の骨格を作成します。 

① “Structure” を選択します。 

② 右のツールからベンゼン環を選択します。 
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③ 空白の画面をクリックしてベンゼン環を生成します。以下の作業で操作を戻した

い場合は、Ctrl+Z (undo)および Ctrl+Y (redo)を使うと便利です。 

④ 続いて、配置されたベンゼン環の右の結合部分にカーソルを合わせ、クリックす

ることでナフタレン構造を作ります。ヘテロ原子への置換は後で行います。 

 

⑤ 左のツールから C（炭素原子）を選択します。上のツールから “Draw Normal” を

選択します。 

 

⑥ 炭素原子鎖の骨格を作ります。鎖を伸ばしたい炭素原子を始点とし、付加する炭

素原子の位置を終点とするようにドラッグします。ヘテロ原子への置換は後で行

います。 

1 

2 

  3   4 

 

 

 5 
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⑦ メトキシ基(-O-CH3)側の骨格も同様にして作ります。 

 

3. 原子の置換、官能基の付加、修飾をします。 

① 原子を置換します。左のツールから N（窒素原子）を選択します。置換したい原子

上にカーソルを合わせ、クリックすると N原子に置換できます。 
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② 同様に O（酸素原子）への置換も行います。左のツールから O（酸素原子）を選

択し、置換したい原子上にカーソルを合わせ、クリックすると O 原子に置換でき

ます。 

 

③ ヒドロキシ基を付加します。左のツールから O（酸素原子）を選択し、炭素骨格

を作ったときと同様にして操作します。ヒドロキシ基を付加させる炭素原子を始

点とし、酸素原子を配置したい位置を終点とするようにドラッグします。 

 

④ 二重結合を作ります。左のツールから C（炭素原子）を選択。上のツールから “Draw 

Normal” を選択します。結合部分にカーソルを合わせ、クリックすると二重結合

に変わります。 

（クリックするたびに二重結合、三重結合、単結合と繰り返されます。） 

⑤ 立体構造を指定します。上のツールから “Up Stereo Bonds” を選択します。 

結合部分にカーソルを合わせてクリックすると、紙面上方へ向かうような立体を

表現する結合に変わります。 
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（クリックするたびにくさび形の向きが変わります。上のツールから隣の “Down 

Stereo Bonds” を使うと紙面下方に向かう結合を表現できます。） 

⑥ 下のような構造ができあがりました。 

 

4. 3次元最適化。 

① “3D Optimization” ボタンをクリックすると、水素原子が付加されて三次元構造に

なります。 

 

② 警告のダイアログが出ます。立体結合は残すので、 “No” を選択します。 

③ 次のような構造が得られます。 

 

④ 左上のツールから “3D Rotation” をクリックし、画面上をドラッグすると、3次元

回転させることができます。 

 

5. モデルの保存。 

① メニューバーから[File][Save As]を選択し、データを保存するためのダイアログ
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を開きます。 

② ファイルの種類を “MDL Molfiles [V2000] (*.mol)” に設定し、ファイル名を入力し

て保存します。 

③ 保存したファイルはフリーソフト OpenBabel を利用して*.txyz 形式に変換できま

す。（後述） 

 

 

Open Babelを用いたファイル形式の変換 

 

“Open Babel”を用いて、“ChemSketch”で作成したファイル(mol形式)を、シミュレータで使

用可能な形式(txyz形式)のファイルに変換します 

 

１． “Open Babel GUI”を起動 

２． mol形式から txyz形式ファイルへの変換 

１）”INPUT FORMAT”から、”mol – MDL MOL format”を選択します 

 

 

２）”OUTPUT FORMAT”から、”txyz – Tinker MM2 format”を選択します。 
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３）①”Input below”チェックボックスのチェックをはずし、②ChemSketchで作成した

mol ファイルを指定します。(注)指定する mol ファイルのパスには、日本語文字を含め

ないようにしてください。 

 

 

４）①”Input below”チェックボックスにチェックを入れます。②”Output below only”チ

ェックボックスのチェックをはずし、③出力する場所を指定し、ファイル名を入力しま

す。(注)指定するmolファイルのパス、及びファイル名には、日本語文字を含めないよ

うにしてください。 

① 

② 
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５）”CONVERT”ボタンをクリックします。 

 

 

６）４)－③で指定した場所に、molファイルを変換した txyzファイルが生成されます。 

 

 

① 

② 

③ 
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第 6章 

トラブルシューティング 
 

 

 SPMシミュレータの利用時に起こり得るトラブル事例とその解決方法を紹介します。 

 

 

シミュレータの実行に伴うトラブル 

 

 

シミュレータが正常に起動しない 

シミュレータが正常に起動しない場合、ig4dev32.dll（通常は C:¥WINDOWS¥system32

にあります）のバージョンが合っていない可能性があります。このファイル名を別名（例

えば、ig4dev32.dll_bak）に変更後、再度 GUIを起動してみてください。 

なお、他のアプリケーションで不都合が出た場合は、お手数ですが元にお戻しください。 

 

設定したパラメータが計算に反映されない 

 

読み込み中のプロジェクトファイルのあるフォルダに対して、ログインしているユーザ

アカウントが書き込み権限を持っていないことが原因と考えられます。 

SPM シミュレータはデフォルトでは "C:¥Program Files" 以下のフォルダにインストー

ルされますが、管理者権限を持たないユーザアカウントはこのフォルダ以下の内容を書き

変えることができません。Windows Vista以降の OSの場合、"C:¥Program Files" 以下のプ

ロジェクトファイルや出力ファイルを書き変えようとすると、VirtualStore という仕組みが

作動します。すると、Windows側が保存先を自動的に切り替えてしまい、"C:¥Program Files" 

以下のファイルを直接書き換えず、別の場所にファイルのコピーを作り、そのファイルを

編集するようになってしまいます。SPM シミュレータは始めに選択したフォルダにある出

力ファイルを読み込むため、結果として別の場所にある出力ファイルの変化を見出すこと

はできません。 

 

この問題を解決するための 2通りの方法を紹介します。 

 まず一つ目は、一時的に管理者権限を付けてシミュレータを起動する方法です。SPM シ

ミュレータを起動する際に、シミュレータのアイコンを右クリックし「管理者として実行」

を選択して下さい。 

シミュレータの実行に伴うトラブル 
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二つ目は、サンプルプロジェクトのコピーを作る方法です。SPM シミュレータのアイコ

ンをダブルクリックし、通常の方法で起動します。サンプルプロジェクトを "C:¥Program 

Files¥SpmSimulator¥SampleProject" 以下から読み込みます。ここで、今開いているプロジ

ェクトのコピーを作るために、メニューバーの  [File] -> [save as] を選択して "Save 

project" ダイアログを開きます。プロジェクト名は初期値のままで構いませんが、保存先の

ディレクトリは、必ず書き込み権限のあるフォルダ（例えば "C:¥Users¥ユーザー名" 以下）

を選択してください。プロジェクトの保存ができましたら問題は解決となります。計算の

設定を更新して保存したり、計算を実行したりしたときに、選択されたフォルダ以下に結

果が反映されるようになります。 

 

 

 

 

インストールに伴うトラブル 

 

インストーラ実行時に発生し得るエラーコード、ならびに対処方法を示します。 

 

インストールエラー (エラーコード:0003) 

 

ネットワークへの接続情報の取得に失敗している可能性があります。SPM シミュレータ

をインストールするにはインターネットへの接続が必要です。具体的にはWindowsに付属

するアプリケーション ipconfig.exeを使用してネットワーク情報を取得する際に、正常な接

続の情報が得られないことが原因となります。 

まずインターネットへの接続を確認して下さい。正常に接続でき、なおかつ当該エラー

コードが発生する場合は以下の手順を確認して下さい。 

 

Windowsの環境変数のPATHに ipconfig.exe へのパスが設定されていない場合に当該エ

ラーコードが発生することがあります。以下の手順に従って環境変数を編集して下さい。 

 

まず“システムのプロパティ”を表示するウィンドウを開きます。 

【Windows XPをお使いの場合】 

インストールに伴うトラブル 
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デスクトップまたは画面左下のスタートメニューから、マイコンピュータを右クリックし、

プロパティをクリックします。 

【Windows 7をお使いの場合】 

Windows7の画面左下のスタートボタンを押します。 

表示されるメニューの “コンピュータ” を右クリックし、プロパティをクリックします。 

システムを表示するウィンドウが開きましたら、左側の “システムの詳細設定”をクリッ

クします。 

“詳細設定”のタブをクリックします。 

“環境変数”ボタンを押し、環境変数を設定するためのウィンドウを開きます。 

ここからは間違えないようにご注意下さい。 

システム環境変数のリストから “Path” を探して選択し、“編集” ボタンを押します。（ユ

ーザー環境変数のリストではありません。） 

“変数値”に次のようにして値を追加します。 

変数値の文字列の一番最後にカーソルを合わせます。それに引き続き、以下の内容を

セミコロン『;』を含めてすべてコピー＆ペーストします。 

 

;%SystemRoot%;%SystemRoot%¥System32;%SystemRoot%¥System32¥Wbem 

 

“OK”ボタンを押してシステム変数の編集を終えます。 

“OK”ボタンを押して “環境変数” の編集を反映させます。 

“OK”ボタンを押して “システムのプロパティ” の編集を終えます。 

 

以上で環境変数の設定は完了です。改めてインストーラを起動して下さい。 
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①  

②  

③  

株式会社 アドバンストアルゴリズム＆システムズ 

〒150-0013 東京都渋谷区恵比寿１-１３-６ 恵比寿 IS ビル７F 

TEL 03-3447-5501（代） FAX 03-3447-4100 
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